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This chapter includes the following sections:

• About Toon Boom Studio, on page 12
• About The Art Curriculum, on page 13
• Lesson Breakdown, on page 14
• Will There Be Homework?, on page 17
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About Toon Boom Studio
Toon Boom Animation has many years of experience developing tools for animators. 
Vector technology, a deep understanding of the animation process, and a commitment 
to the needs of animators are the backbone of our products.

Toon Boom Studio represents the culmination of years of research and development to 
create a desktop tool that animators can learn and use with ease to produce broadcast 
quality animation. 

Toon Boom Studio embodies the workflow of the animation studio and provides tools 
that parallel those used in a traditional environment. Students of animation trained on 
Toon Boom Studio will feel perfectly confident in transitioning to either a traditional or 
digital studio environment.

Below is a screen shot of the Toon Boom Studio interface. This is the Default Workspace, 
where you will animate, draw, set your timing, create effects, do your compositing and 
paint.
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About The Art Curriculum 
The Toon Boom Studio Art Curriculum is an outline of a basic animation course. It 
includes lessons with notes and activities. The notes included in the lessons are 
introductory. 

Although it is not a professional animation training course, at the end of this course you 
will:

• Have gained enough experience in the animation process and with animation 
techniques to know if animation is an area that you wish to explore further.

• Be ready to move into a traditional or digital animation environment.

This course guides you through the basics of animation using Toon Boom Studio. It is not 
meant to teach you how to use the software in complete detail. For detailed instruction 
on how to use Toon Boom Studio, we highly recommend that you consult the User 
Guide, Online Help and our other assorted tutorials, all of which are available on our 
website at toonboom.com.
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Lesson Breakdown
“Our work must have a foundation of fact in order to have sincerity. The most hilarious 
comedy is always based on things actual.” 

—Walt Disney, The Illusion of Life

Animation is all about the analysis and breaking down, or deconstruction, of movement. 
All of the concepts discussed in these lessons have evolved from the analysis of 
movement that started in the early days of animation and continues to this day.

Each lesson builds on the previous one to provide greater insight into the nature of 
movement and how it can be captured in animation.

What is in Each Lesson?
Each Student lesson includes the following sections:

• Lesson Objectives
With this list of objectives, you will understand the goal of each lesson, as well as 
key points that you will want to focus on throughout. Review the list of 
objectives again once you have completed the lesson, using it as a checklist to   
ensure that you have absorbed the key ideas. 

• Lecture Notes
We have provided key facts about animation for you to keep in mind, ones that 
relate directly to the lesson you are following. These concepts are well-known 
within the world of animation arts and are well-documented in numerous texts, 
therefore we have gathered them here for you to review in one easy-to-access 
spot. 
 Further Reading 

At the end of each section, we recommend relevant chapters from various 
animation books, from which you will learn more about the concepts 
introduced in that section.

 Further Viewing 
If you have access to animation movies at home, or a cartoon specialty 
channel,   we recommend you watch them with an analytical eye to see how 
each film uses the concepts outlined in your course material. In some lessons, 
we have suggested notable examples that are easy to acquire, rent or borrow 
from a library.

• Activities 
No lesson is complete without a chance for you to apply the new concepts    you 
have just been introduced to. It is always best to learn by doing in order to gain 
a good grasp of any new idea or technique. With that in mind, we have included 
projects in Toon Boom Studio for you to practice on.
 Material Provided for this Lesson 

Look for the Toon Boom Studio projects, packaged specifically for use with 
some of your lessons.
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What are the Lessons About?
The Toon Boom Studio Art Curriculum includes the following lessons:

Lesson 1. History of Animation, on page 19

A brief overview of the history and development of animation.
Lesson 2. Lesson Objectives, on page 30

Explores various forms of animation, from the popular Traditional and Stop-
Motion techniques, to others that are less-widely practiced, but just as 
fascinating.    

Lesson 3. Animation Workflow, on page 39

Lists and describes the jobs of the production staff in a typical animation studio, 
as well as the various types of workflow a studio might follow, pending the style 
of animation they are working with.

Lesson 4. Animating Basic Shapes, on page 63 

Instruction on drawing and deforming basic shapes.
Lesson 5. Timing, on page 97

An introduction to the importance of timing in animation, including how 
manipulating exposure time can change the timing and feel of an animation.

Lesson 6. Squash and Stretch (The Bouncing Ball), on page 115

An introduction to basic principles of animation.
Lesson 7. Anticipation, Drag and Overlapping Action, on page 123

Learn how to help your audience understand what a character is about to do 
before it acts, through the use of exaggerated body language.

Lesson 8. Character Design and Construction Sheet, on page 131

Examine the basics of character construction and breakdown.
Lesson 9. Animating a Jumping Character, on page 151

Make a character jump using all of the concepts covered so far and get warmed 
up for more complex animation techniques.

Lesson 10. Animating a Walk Cycle, on page 161

The title says it all. In this lesson, you will learn how to make your characters 
walk.

Lesson 11. Breaking Down a Character and Animating It, on page 173

Learn to break a character down into several pieces in order to rig and animate 
it.

Lesson 12. Bone Animation, on page 185

Building on the previous lesson, you will now use Bone Animation to rig and 
animate a character. 
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Lesson 13. Stop-Motion Animation, on page 205

Here you will gather your favourite toys and figurines to animate them frame-
by-frame, using a webcam or camera to break down the movement of your 
objects.

Lesson 14. Basic Multiplaning and Sceneplanning, on page 217

Here you will explore the Multiplane space, where you can create a background 
in several layers, spread the layers out along the Z-axis, then move the camera 
through the scene to create an illusion of depth perspective.

Lesson 15. The Take, on page 233

In this lesson, you will look at the important role acting plays in revealing the 
unique personality of your animated characters. 

Lesson 16. Visual Break-Down and Lip-sync, on page 247

Learn the basics of breaking down sentences, as well as how to assign a 
different mouth position to each syllable your character speaks. 

Lesson 17. Storyboard and Staging, on page 261

This lesson describes how to set up and plan your shots and scenes in a 
storyboard.

What Are the Required Tools?
In order to participate in the course, you must have access to a copy of Toon Boom 
Studio, as well as the accompanying sample material package. Most of your exercises 
can be completed using a mouse, but for the drawing exercises it is recommended that 
you use a pen tablet.

Where Can I Find More Information?
If you want to learn more about the animation concepts and techniques presented in the 
notes, we suggest that you consult one of the many books and websites on the topic. 
To get you started in that regard, we have recommended a number of resources in the 
Useful References, on page 288 of this workbook.

We have also included an Appendix 1: Glossary and References, on page 271.The 
appendix includes a bibliography of the books and animation mentioned in each lesson, 
so that you can find the reference material with ease.

You can also find other useful material, such as Templates, Tutorials and Tips and Tricks 
in the Resources section of the Toon Boom Studio page. 
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Will There Be Homework?
Animation requires practice, lots and lots of practice! Although not every lesson comes 
accompanied by follow-up activities, we highly recommend that you dedicate as much 
time as possible to the take-home activities assigned by your instructor. This will help you 
to feel at ease with all the new techniques encountered during class time, as well as give 
you time to explore, make mistakes and ultimately, improve your technique.
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Lesson 1: History of Animation 

This lesson includes the following sections:

• Lesson Objectives, on page 20

• Lecture Notes, on page 21

• Activity: Build Your Own Thaumatrope, on page 26
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Lesson Objectives

Total Lesson Time: One class
This lesson introduces the history of animation.

At the end of this lesson, you should be able to:

• Demonstrate your understanding of the Persistence of Vision concept by the 
creation of your own thaumatrope.

Activity: Build Your Own Thaumatrope
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Lecture Notes

History of Animation
 The history of animation is rich with innovation, beginning in the nineteenth century and 
continuing right through to the present day. The earliest animation techniques 
employed optical toys, followed by the creation of animated films. The great cinematic 
achievements that we know today are the result of ongoing artistic and technological 
experimentation and discovery.

In the Beginning

Many of the nineteenth century inventions designed to animate images were initially 
created as amusements for children. Most of these were optical toys that in time grew 
more sophisticated, resulting in a form of entertainment that proved popular with 
everyone. These toys are:

• The Zoetrope

• The Thaumatrope

• The Flip Book

• The Praxinoscope

What is an Optical Toy?

An optical toy is an item that uses persistence of vision to fool the eye into perceiving a 
series of still images, one shown quickly after the other, as a continuous moving image.

What is Persistence of Vision?

Persistence of vision is when your eye's retina retains an image for a fraction of a second, 
before replacing it with a new image. If the images before you are moving fast enough, 
you will have the impression that you are seeing both images at the same time.

This persistence of vision allows us to “fill in” movement from one image to the next 
when viewing media on screen, which is usually filmed at 24 frames per second. In 
animation, it is also typical for an animator to use 24 images for one second of screen 
time. 

We recommend that you, as a beginning animator, use 12 frames per second when you 
are working on the activities that we have provided.
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The Zoetrope

The zoetrope creates the illusion of a moving picture. The first zoetrope was created in 
China, while the modern zoetrope, essentially a cylinder with vertical openings around 
the circumference, was invented in 1834 by Englishman William George Horner. Affixed 
to the inside edge of the circumference are a series of pictures that, when viewed 
through the openings of the spinning cylinder, appear to form a seamless moving image.

The Thaumatrope

This optical toy was invented by the English physician John A. Paris in 1825. The 
thaumatrope is a simple disc with two different pictures on each side. Strings are 
attached to each side of the disc and when pulled, the disc spins and the images appear 
to merge, creating a single illustration. 
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The Flip Book

The first flip book was invented in 1868 by John Barnes Linnet. This was another device 
that relied upon the illusion of movement to suggest a seamless moving image. A flip 
book is a set of printed or drawn pictures, featured in sequence on the pages of a book. 
When the pages of the book are flipped at high speed, it creates an illusion of 
movement.

The Praxinoscope

The praxinoscope was invented by French photographer Emile Reynaud in 1831. This 
device was a more advanced version of the zoetrope, also relying on a spinning cylinder, 
now fixed with a series of mirrors. Reynaud also developed a larger version of the 
praxinoscope so that he could project the moving pictures onto a screen.

The Movie Camera

The movie camera was invented in the early 1900s. The camera was equipped with a 
hand-crank to transport the unexposed film frame-by-frame through the camera. This 
mechanism allowed the user to start and stop filming as necessary. People quickly 
discovered that the frame-by-frame technique would allow them to animate images 
drawn on paper. One of the first to experiment with this form of animation was Emile 
Cohl.
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Winsor McCay and Gertie the Dinosaur

In February 1914, Winsor McCay created an animated film of a dinosaur he called Gertie. 
It was the first time that an animated character exhibited personality. Gertie the 
Dinosaur would hide behind rocks, drink water, dance and even cry!

Winsor McCay brought Gertie to life through thousands of hand-drawn images on 
paper. He would carefully flip through the drawings to ensure that the animation 
appeared smooth and fluid.

The Peg Bar

Around 1915, French Canadian Painter Raoul Barré created the standard perforations on 
the drawing paper and the peg bar that are still in use today. The holes in the paper 
serve to perfectly align each drawing on the peg bar, preventing any jerkiness in the 
animation once filmed.

The Rotoscope

Around 1915, Max Fleischer invented the rotoscope. This machine allowed the user to 
transfer a live-action film into frame-by-frame drawings to create animation.
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The Many Innovations of the Walt Disney Studios 

Walt Disney was a pioneer in what was to become the standard methods of production 
in an animation studio. The Walt Disney Studios introduced the storyboard, a visual 
script that helps animators keep track of what is transpiring in a film whilst it is being 
created. 

Many of the animated short movies created by the Walt Disney Studios have made 
history. In 1928, Steamboat Willie was the first cartoon to use synchronized sound. In this 
film, Mickey Mouse whistles a tune, the boat’s whistles toot, while birds and animals 
squawk, all of them synchronized with the music and sound effects accompanying the 
film. In 1932, the film Flowers and Trees was the first animation to introduce the 
Technicolor process technology.

 In 1933, the former Walt Disney Studios animator Ub Iwerks invented the multiplane 
camera. This special camera is used to move through a number of different layers in a 
scene to create a perception of depth. The multiplane camera, which was set up 
vertically much like a photographic enlarger, would shoot down through as many as five 
planes. The planes were attached to vertical posts that allowed four of the planes to 
move independently of one another. The first two planes were used for animation, the 
next two were for backgrounds, and the fifth was fixed and used for sky backgrounds. 
The finished result produced a depth of perspective which had not previously been seen 
in animated film.
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Activity: Build Your Own Thaumatrope
In this activity, you will create your very own optical toy.

You will need:

• A cardboard circle of 100mm (approximately four inches) in diameter

• A paper punch

• Two pieces of 150mm (approximately six inches) of string

• Coloured pencils

How to make a Thaumatrope
1. With the paper punch, make two holes, one on each side of the cardboard circle.

2. Using your coloured pencils, draw a little bird on one side of the cardboard. Make 
sure the bird is in the middle of the circle.
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3. Now draw a bird cage on the other side of the cardboard. Make sure the cage is 
also in the middle of the circle.

4. Attach the strings to each side of the circle, drawing the string through the holes 
you punched at the beginning of the exercise.

5. Grasping the ends of each string, hold the thaumatrope taughtly in front of you. 
Start twisting the strings in between your fingers. As you pull and twist the ends of 
the stings, the cardboard disc will begin to spin quickly. 

6.  What do you see the bird and the cage doing?
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Lesson 2: Animation Techniques

This module is divided into the following topics:

• Lesson Objectives, on page 30

• Lecture Notes, on page 31

• Activity: Research a New Animation Technique, on page 38
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Lesson Objectives

Total Lesson Time: One class
This lesson introduces some different animation techniques.

At the end of this lesson, you should be able to:

• List some existing animation techniques, as well as some of their subcategories.

Activity: Research a New Animation Technique
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Lecture Notes

Animation Techniques
There are many different animation techniques that an animator can use to bring his 
ideas to life.

Animation can be created using very simple tools such as a pencil and paper, advanced 
computer systems, or with many options in between.

Here is an introduction to the various techniques available when it comes to creating an 
animated movie.

• Traditional Animation, on page 31

• Digital Animation, on page 33

• Stop-Motion Animation, on page 34

• Sand Animation, on page 37

Traditional Animation

Traditional animation usually refers to animation hand-drawn on paper. It was the 
process used for most of the productions throughout the 20th Century. 

An animator would first draw characters, layout and backgrounds on paper. Each 
drawing in the animation would be slightly different from the one before it and the one 
following it, creating the illusion of movement when everything is put onto film.

Once all the animation has been drawn on paper, it would then be photocopied or 
retraced onto transparent acetate sheets, called cels. After the line art is transferred 
onto the cels, paint would be applied to the images, using a colour chart that was pre-
determined for each character or element of the movie. Cels were essential to drawn 
animation since it freed up the animator from having to draw every element in the film 
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on one single layer of paper. Instead, by using cels, each element had its own layer and 
could be animated separately.

With today's technology, this traditional animation technique of using cels to colour 
animation drawings is outdated. It is now possible to hand-draw animation, then scan 
the drawings to colour them digitally using computer software such as Toon Boom’s. So, 
contemporary animation has become a mix of traditional and digital techniques.

Traditional animation can be divided into three groups: 

• Full Animation

• Limited Animation

• Rotoscoping

Full Animation

Animators will refer to full animation when they are working on a high-quality animated 
film. Often they will work with a high level of detail in the design and will try to animate 
characters and elements so that they are believable and life-like. 

This type of animation often requires a huge number of drawings to make it appear fluid 
and realistic.

Limited Animation

Limited animation applies to animated films that require fewer details. It is typically a 
very stylized and expressive type of animation and rarely realistic. Limited animation was 
introduced by the artists of the American studio United Productions of America (often 
called UPA). 

The method was primarily invented as a cost-effective way to create animated series for 
television, but it soon became a style of its own with its funky characters and background 
designs and its original use of colour.

Rotoscoping

This particular technique is used by animators when they want to trace live action 
sequence movements and turn them into drawings. They will often use the action 
sequence as a basis and as an inspiration for character animation. 
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Digital Animation
Digital animation encompasses all the animation techniques that are done exclusively 
with the use of computers. With digital animation, it is possible to do both 2D (two-
dimensional) and 3D (three-dimensional) animation. 

Following are some of the digital animation techniques:

• Digital Cut-out Animation

• Paperless Animation

• 3D Animation

• Motion Capture

Digital Cut-out Animation

Digital cut-out animation is done using cut-out puppets for character animation. In this 
type of animation, characters are created by using a separate drawing for each part of 
its body (head, neck, torso, arms, legs, etc) which are then rigged together, via the 
computer software, like a traditional puppet. Once the puppet is created, it can be 
added to the scene to be animated frame-by-frame.

Paperless Animation

With paperless animation, the animator will often need to hand-draw characters, frames, 
background and layout directly on the computer using an electronic pressure-sensitive 
drawing tablet. This technique is very similar to traditional animation in its process, the 
main difference being that it is all done on the computer.
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3D Animation

Three-dimensional animation requires that, before animating it, a character must be built 
and modeled in the 3D animation software. They are then rigged with a virtual skeleton. 
From there, a character can be integrated into a scene and animated like a digital 
puppet, frame-by-frame.

Motion Capture

The motion capture technique consists of recording the movement of a person, often 
the performance of an actor, and using the recorded information to animate a digital 2D 
or 3D character.

Stop-Motion Animation
Stop-motion animation is made by moving, then photographing real-world objects 
frame-by-frame to create the illusion of movement on the screen. We can divide stop-
motion animation into four categories. They are:

• Puppet Animation

• Claymation

• Cut-out and Silhouette Animation

• Object Animation



Lesson 2:  Animation Techniques

35

Puppet Animation

Puppet animation is a type of stop-motion animation involving puppet figures that are 
animated frame-by-frame. Usually, the animators will create a physical three-dimensional 
scene, similar to a small theatre, where the action will take place. The puppets will 
generally have an armature (flexible skeleton) inside of them to allow them to be 
positioned and animated smoothly. This also prevents the puppet from moving and 
allows it to stay steady when the animator has to photograph a frame of the scene.

Claymation

Clay animation is sometimes similar to puppet animation. The figures and characters are 
made of clay, but they can also have an armature or a wire frame inside of them to help 
maintain their pose while shooting a scene. However, when animating with clay, it is also 
possible that the figure be made entirely of clay, without an inner armature. This allows 
the animator the freedom to animate the figure smoothly, manipulating it from one 
shape to the next, without the slightly jerky movement typically associated with puppet 
animation.



36 

Toon Boom Studio Art Curriculum - Student Guide

Cut-out and Silhouette Animation

Cut-out animation refers to animation made from two-dimensional pieces of material. 
More often than not, it is paper that is cut into different shapes, but fabric can also be 
used for the same purpose. The characters will usually be divided into different parts 
(head, neck, arm, leg, torso, etc) and moved piece by piece to create the animation. 
Silhouette animation uses the very same technique, except that characters and items in 
the scene will be completely black and only the background will contain colour, so that 
it looks like a scene in silhouette. The silhouette technique was invented by German 
animator Lotte Reiniger.

Object Animation

Object animation is a type of animation that utilizes regular inanimate objects as props, 
characters and layout elements.
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Sand Animation
Unique and intriguing, sand animation is typically done with the use of a light box. In a 
darkened room, the light box is turned on and sand is poured over it to completely block 
the light. Then, using a brush or a stick, the animator will trace a drawing in the sand, 
allowing the light to shine through, thereby creating one frame of animation. A picture 
is taken, and then the animator will move the sand around a little bit to create the next 
frame, followed by another picture, and on and on, thus creating movement.
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Activity: Research a New Animation Technique

In this chapter, we have covered the most common animation techniques, but there are 
many more yet to discover. Alone or in a group, conduct a little research on a new 
animation technique and present it to your classmates. Present photos to provide visual 
examples of that technique or better yet, bring the material you need and do a 
demonstration.
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Lesson 3: Animation Workflow

Studios follow a meticulous workflow to get their movie from script to screen. A studio’s 
workflow represents all the steps a production has to follow in order to get the script to 
the final film stage. Each step must be done at a particular moment in the production in 
order for it to come to completion. In this lesson, you will be introduced to all of the 
required staff, as well as the different types of workflow, or system, studios follow while 
in production.

This module is divided into the following topics:

• Lesson Objectives, on page 40

• Workflows, on page 50

• Cut-out Workflow, on page 55

• Tradigital Workflow, on page 59
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Lesson Objectives

Total Lesson Time: One class
This lesson introduces the functions of various jobs found in an animation studio, as well 
as the different workflow that exist for studios using one animation technique or another. 

At the end of this lesson, you should be able to:

• Understand and identify the different positions that exist in an animation studio

• Outline the studio workflow used for different animation techniques
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Production Staff and Outsourcing 

Someone making a short animated film at home might be able to create their film from 
start to finish, but on a big movie or TV production, it is a much bigger process! In the 
following section, you will see a list of all the staff required to take a full animated movie 
production from concept to completion.

Production Staff - Descriptions

Animatic Editor

This person takes storyboard elements and assembles them against the recorded sound 
track. The animatic editor works with the director to edit the images, pacing and voice 
audio to a certain length. Once that has been achieved, the animatic is considered final 
and no more changes will be made.

Animation Director

The animation team is supervised by the animation director, whose job it is to break 
down the storyboard into sequences for distribution to various animators, known as 
handout. The next step is to check the animation before sending it forward for director 
approval. The animation director helps with any animation-related issues, and will co-
ordinate the revision and retake process with the animators.

Animation Supervisor

Once the animators have completed their animation, the animation supervisor will 
review the animation and provide comments before forwarding the animation to the 
animation director.
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Animator: Cut-out

Cut-out animation is a vast subject. There are many techniques employed by different 
studios and animators. Basically, the animator moves the parts frame-by-frame to 
animate the puppet. The animator may even start their own pre-compositing, camera 
moves and trajectories. This depends on the type of workflow being followed. Once the 
animation is completed and approved, the scene goes to the final compositing and 
effects stage.

Animator: Tradigital

In tradigital animation, all of the drawings are created digitally, using a pen tablet to 
optimize work and drawing ability. Other than the digital aspect, the animation 
principles are not very different from classical animation. The animator will use the same 
animation styles and methods as would be used on paper. Only the medium is changed. 
When all of the animation is done and the drawing timing is completed through the 
exposure sheet or the timeline view, the scene can be forwarded for the animation clean-
up process.

Art Director

The Aart director has a key role in production, and is responsible for setting the look of 
the show. The art director is often a highly skilled location/layout designer and a skilled 
background painter. In the development process that takes place at the very beginning 
of the production, this person works with the director and design supervisor to develop 
the visual and colour style of the show, and will ensure the consistency of that look 
throughout the production.

Assistant Director

As the name implies, this person assists the director in all aspects of production. The 
assistant director’s duties vary, depending on the way the director likes to work, but they 
are aware of all of the creative requirements and will make decisions when the director 
is unavailable.

Background Layout and Posing Artist

The layout and posing process links the storyboard artist and the animator. The layout 
artist uses the storyboard and prepares an organized folder for the animator. This folder 
contains a field guide that shows the proper camera movement and the right size of the 
scene. It also includes the character’s main poses from the storyboard, following the 
official design, effects, backgrounds and all the other information necessary to the 
animator.

The backgrounds are done directly from the storyboard and the location design. A 
background is a section, or an angle, of a location.

The background artist refers to the storyboard, then draws the background for each 
scene. Once the background is complete, it will be added to the layout folder. In a cut-
out or tradigital process, this step can be done digitally or traditionally. This will depend 
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on the user’s preferences. This step is mainly applied to larger productions. An individual 
user can move directly from the storyboard to the animation.

Background Painting

Once the background layouts are complete, they can be painted. The background 
painter will take the final layout and paint it using the palettes created by the colour 
stylists. Once the backgrounds are painted, they will be sent to the scene set-up team 
or the compositing team.

Casting Director

The casting director arranges the casting call-out to the performing industry for 
auditions and schedules the location and time. The director usually attends and is 
provided copies of the casting recording by the casting director. Once the director has 
made a decision, this person will work with the Line Producer to facilitate the contract 
negotiations with the actors. The casting director has a strong grasp of performance 
rights and royalty requirements and can advise the line producer.

Voice Director

The voice director controls the voice recording session, works with the actors and relays 
the director's information about what is wanted from the actor’s performance. Voice 
directors are very astute and readily pick out any problems in the way that a line is 
phrased or spoken by the actor.

Character, Prop and Location Designer

Once the script is completed, the designer can start work. Before any animation, 
background or colouring can be done, the design must be addressed. The artist has to 
decide on the production style, the character’s look, the locations’ complexity, etc. Once 
these designs are done and approved, the “model pack” is produced, containing the 
models for all these aspects. The designs and models will be used by the colour stylist 
and layout artist, and finally by the animator.

Character and Prop Breakdown Artist

The breakdown step is very important to the cut-out workflow. The person doing the 
breakdown has to take the final model and begin building the puppet. This means 
deciding which parts will be separated and preparing all of the joints and views for the 
animators. Once the parts are broken down, the character or prop must be rigged. This 
means attaching the parts and assigning the appropriate pivot points. This step must be 
done with care, because these puppets will be distributed amongst all the animators 
later. You do not want to duplicate mistakes throughout the project! When the character 
and prop rigs are ready, the breakdown artist will store them in the library as templates 
to be shared with the rest of the team.
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Clean-Up Artist: Tradigital Animation

The animation clean-up consists of transforming the rough tradigital animation into 
cleaned and inked drawings. On a new layer, the clean-up artist will trace the animation 
following the official model pack. This step must be accurate. When the clean-up is over, 
the scene can be passed to the colourist for the ink and paint step.

Colour Editor

This person assembles the colour frames and works with the director to cut the show to 
length. They will render the show and send it on to the post facility for the final picture/
audio mix. Copies of the film’s final version prior to on-line editing, known as a picture 
lock, will be sent, accompanied by running timecode, to the music composer and sound 
editors so they can begin the creation and assembly of those elements.

Colour Stylist

Once the black and white designs are done, they are sent to colour styling. The colour 
stylist will choose the colours and ambiance for the production and will balance the 
characters, props and effects with the locations’ palettes. This contributes a sense of 
harmony or contrast, as necessary, to the show. When the colours are approved, colour 
models are produced and backgrounds are painted. Colour models will often be added 
to the model pack. The colour models will be used by the colourists and the coloured 
background will be sent for compositing.

Colourist: Ink and Paint

Once the colour models are ready and the drawings are scanned and properly exposed, 
the ink and paint artist will clean them, specifically removing dirt or dust that could have 
appeared during the scan process. They will then colour them in. Once the drawings are 
cleaned, inked and painted, they are ready for compositing.

Compositor

The compositor imports the coloured background, the animatic reference and the sound 
as required. Referring to the exposure sheet, the animatic and the animation, the 
compositor assembles all of these elements and creates the camera moves and other 
necessary motions. Finally, the compositor adds any digital effects required by the 
scene. These can include tones, highlights and shadows. When the compositing is 
complete, the final step is the rendering.

Director

The director is the creative head of the production who makes all of the main creative 
decisions determining the style and look of the show. Keeping the schedule and budget 
in mind, a director has approval over all aspects of the production from development, 
right through to the final picture.
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Editing Co-ordinator

Functioning like the production co-ordinator, this person maintains the scheduling and 
organization within the editing department. In smaller studios with very few productions, 
this role can be handled by the production co-ordinator, but is probably necessary in a 
busy studio with multiple productions.

Editing Department Manager

This person functions like a line producer for the Editing department. Looking at all the 
allocated budgets for editing for each production, they maintain the organization and 
scheduling for all productions through editing. In a large studio with in-house editing 
facilities, this is an important role, but if the pre and post-editing are contracted to an 
outside facility, then this role will be filled by someone there.

Effects Designer: Computer Generated

To maintain a consistent look for any effect throughout an entire show, the effects 
designer will create effect templates that the compositor will use to composite the 
scenes. The effects designer will create the look of the effects for the entire project.

Effects Designer: Hand-drawn

Once a scene’s animation is complete, it will be sent to the effects department where 
the effect designer/animator will add the effects, such as smoke or splashes. He will 
often hand-draw the effects. Once the effects are complete, they will be sent to the 
compositing department.

Information Technology (IT) Professional

The IT professional has a series of responsibilities, from installing applications to building 
complex computer networks and information databases. The IT professional also takes 
care of the data management, networking, engineering computer hardware, database 
and software design, as well as the management and administration of entire systems. 
Of course, different studios will have different task definitions for their IT department.

Library Manager

The library is a central element of a digital cut-out production. It contains all of the assets 
for the animation and the scene set up. The library is a central location where all these 
templates are stored, organized and made available to the animators and the scene set-
up team. The library should be structured so that everyone using it can easily find the 
assets they require. Someone should be assigned to manage the library so that it 
remains well organized. This person is often the breakdown artist, but this depends on 
each studio’s structure. When the library is built, the scene set-up person and the 
animators will begin using its assets.set-up
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Line Producer

This person fills a major organizational role in the production. At the start, they usually 
create the schedules based on the budget allocated for the series and the contracted 
delivery dates to broadcasters. During the course of the production, they monitor the 
production flow making schedule adjustments as needed, always bearing in mind 
budget limitations and final delivery dates. They are aware of the costs of performance 
rights and will negotiate the deals with the voice actors. They also control the staffing of 
the project, contract negotiations with second unit Productions, outside production 
facilities (record studios and post-production facilities), outsourced processes like 
storyboard, casting directors, and they provide production and cost reports to the 
studio.

Music Director

This person is very knowledgeable about music, and maintains contacts with industry 
music writers. At the beginning of a production, the music director helps audition writers 
willing to write the musical score and also helps the line producer to negotiate contracts 
with them. He also co-ordinates the recording and deliveries of the music for 
productions. In large studios, the music director works for the studio, in smaller studios 
this role can be outsourced or handled by the line producer.

Music Editor

This person will take the recorded musical score and, using the timecode markers 
provided by the composer, assemble the new music against the picture, making any 
necessary adjustments. They will also add music cues from a music library where needed.

Production Assistant

This is another person who helps with the organization at the production level. They 
generally create and distribute preliminary design lists for the design department. They 
will track the progress of designs through to completion.

Note: In much larger productions, like feature films, each department has a production 
assistant to control the tracking and organization of the work for that department.

Production Co-ordinator

This is the line producer's assistant who helps with the scheduling and arranging of 
duties during production. They will book times with the recording studios and post- 
production facilities based on the delivery schedule, and keep track of the deliveries of 
things like scripts, storyboards and other production materials. They will track time-
sheets for the crew and deliver them to the line producer for signing. The production co-
ordinator is highly organized, detail oriented, and is critical in helping to maintain the 
organizational structure within the production.
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Scene Organization Manager

At the start of a project, the scene organization manager will create all the scene files in 
the production software and organize the structure to maintain control of the project, 
while ensuring that everything is properly organized.

Render Operator

Once the compositing is complete, the only step left is to render the scene as a movie 
or an image sequence. Generally, the compositor will be the same person doing the 
rendering.

Scan Operator

The cleaned-up drawings are scanned and imported into the software in a simple step 
that serves to incorporate all the drawings in the scene. Once all the drawings are 
scanned, they can be inked and painted.

Scene Set-up Artist

The scene setup consists of preparing the scenes for the animators, and is similar to 
traditional layout and posing. Following the storyboard and the animatic, the person 
working on the scene setup will import the assets needed for the scene animation, as 
well as import the animatic reference and often position the camera. When the scene 
set-up is completed, the scene can be passed to the animator who is free to begin 
animating without having to mount the scene.

Sound Editor

The sound editor adds the sound effects and ambient noises for the entire production.

Supervisor

This person manages the design team responsible for creating the character, location, 
prop and sometimes the effects designs in the production. Usually, this person is a very 
strong character designer with superior drawing skills.

Storyboard Artist

In TV productions, this role is usually outsourced to a freelance storyboard artist. They 
are responsible for providing the visual blocking and staging for the show based on the 
director's handout.

Storyboard Revision and Clean-Up

Usually a staff position, this individual will make any visual changes requested by the 
director, while preparing the storyboard for the animatic (also called Leica or story reel). 
Once the animatic is done, they also conform the storyboard using the new timing 
available in the locked animatic.
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Story Editor

This person will supervise all of the writers in the creation of the premises, outlines and 
script drafts. The story editor is responsible for maintaining storytelling style and 
characterization of action and dialogue. This person is brought in very early in the 
production process and begins developing ideas that are submitted as story 
suggestions, ones that may eventually be made into scripts. Some writers are hired 
through agents and may negotiate royalties for the works they create.

Technical Director

The technical director has many responsibilities in the production. First, he or she builds 
scenes from the EDL (edit decision list) provided by editing. They trouble shoot any 
technical issues relating to software, individual work stations and technical problems 
with scenes. The technical director also ensures that all scenes are rendered and the final 
frames delivered to Editing at final colour. Working with the information technology (IT) 
department regarding network issues, they will work with production engineering 
programmers to resolve digital production assets management issues that may arise 
during production.

Xsheet Technician

The Xsheet controls the timing of the animation. The traditional animator creates a 
paper exposure sheet in order to create the timing, while the person in charge of the 
digital exposure sheet refers to the paper version and recreates it in the animation 
software. Once the drawings are in place on the exposure sheet, the scene is ready for 
scanning.

Production Outsourcing Duties

The Recording Studio

This is the specialized facility where voice and live music will be recorded. They will 
provide the recording engineer and equipment for the recording, and will deliver copies 
of the recorded audio and take sheets to the production.

Post-production Facility

Small studios cannot afford to equip and maintain an industry standard post-production 
facility, so post-production duties are typically contracted out for the completion of the 
production. The facility takes on a number of important responsibilities, among them 
combining the final audio and final picture to create a final mix of the show. The picture 
will be quality checked for colour balance and to ensure that it meets broadcast signal 
standards. The facility will provide digital masters of the completed show and versioning, 
that is, various versions of the final film for different markets. It may also provide closed 
captioning for the final picture if needed.
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Second Unit Production

Any studio or facility that is sub-contracted to perform any part of the art or animation 
production duties is a second unit. They are doing service work for the producer and 
delivering the final elements. If doing animation, the studio or facility will have a similar 
crew structure as described here.
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Workflows

In this section you will learn about the three most common workflows found in animation 
studios.

• Traditional Workflow

• Cut-out Workflow

• Tradigital Workflow
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Traditional Workflow
The traditional workflow is a very straight-forward pipeline. Many of the steps cannot be 
done simultaneously, meaning they must be completed before continuing on to the next 
step in the process.

In the following graphic, all the purple steps are done via a software (like recording), or 
on paper (character designs, animation, backgrounds, etc). The storyboard would 
typically be done on paper, but scanned in using either a specific software, or an 
animation software. Everything in yellow and gray is done in the animation software.
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Starting the Project

The Script

All projects start with a script. It is the foundation of the whole project. This comes from 
either the studio itself or the client requesting the project. 

By closely following the script, the design team will begin the character, props and 
locations and design. The storyboard artist will start working on the storyboard.

Pre-Production

Designs

The design team will take the character, prop and location in charge as soon as the script 
is locked.

For a traditional project, the designs will be done on paper. They will be cleaned up, 
added to the model pack and sent to colour styling.

Dialogue and Nat Pause

The dialogue is also recorded from the script. The voices are often recorded outside of 
the studio. If there is dialogue involved in the project, the final version will have to be 
recorded soon enough to import it into the project before the animation. This allows the 
animator to do the sound breakdown and animate the mouth and expressions, as well 
as the storyboard is required. 

Nat pause is a generic audio read-through used by the storyboard artist to hear what the 
characters are saying and how it is said. In this way, they can draw the correct facial and 
physical expressions to coincide with the dialogue. It is important to minimize the 
revision to the visuals during the animation process.

Storyboard

The storyboard is the illustrated script of the film. It can be started in parallel with the 
design and the audio recording, but some studios may wait until the designs and the 
audio recording are locked.

Animatic

The animatic is created from the storyboard. Each scene is timed along with sounds, 
dialogue and music. Before the animatic can be created the storyboard has to be 
completed, approved and locked. Only one person is in charge of the animatic 
production, this ensures consistency throughout the whole production.

If the storyboard is done on paper, a person will have to be added to the team to scan 
the storyboard and prepare it for the animatic. 
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Colour Styling

Colour styling can be done before or after the animation. It doesn’t really have an impact 
on the pipeline. It can be done on paper, or directly in an animation software. 

If the backgrounds are painted in an external software, it is recommended that you do 
the locations (key backgrounds) colour styling in that same external software.

Production

Background Layout and Posing

For the traditional production, the layout and posing step is very important to 
communicate the storyboard information very clearly to the animators. The layout will 
contain all the information needed to do the animation in the scene: background, 
overlay, underlay, and key poses (usually referenced from the model pack) that will guide 
the animator to what is going on.

In both small and medium studios, background layout and posing will be handled by the 
same person. The background layouts will be done by one person or team and the 
posing by another one. For the small studio with a limited amount of resources, the 
storyboard artist or the animator will create the layout and posing.

Background Colouring

Backgrounds can be painted using the animation software or in an external software. On 
a small team, one person can handle the background painting and on a medium-sized 
team, there will probably be two people painting the backgrounds.

Animation and Line-test

In a traditional animation, the animation and the clean up are done on paper, assisted 
by the layout and posing. The animation is one of the longest steps in a production. So 
the main part of the team should be composed of animators and clean up artists.

Line-test

During the animation process, the scenes are regularly passed through the line-testing 
process, which consists of quickly testing the rough key poses of an animation to see if 
the animation is going in the right direction.

Scan

The scan step is the gateway between traditional and digital animation. To import the 
animation drawings into the project, a person is assigned to the scan task.

The scan is done prior to the exposure sheet. Once the drawings are scanned in, the 
person in charge of the exposure sheet will see the timing.
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Exposure Sheet

The exposure sheet person will reproduce the animator’s paper Xsheet either from 
scanned drawings or for the drawings to be scanned in. It is a straight forward task 
generally handled by one person on a small team. Often, it will be the scan person who 
will handle the digital exposure sheet. 

Ink and Paint and Compositing

The ink and paint process is probably the longest digital step. It requires cleaning all of 
the drawings, inking lines and filling all of the colours on all drawings. The length of time 
this procedure takes is dependent on the complexity of the drawings; if there are a lot 
of details and lines to be inked, the colour step will be longer.

The compositor on the other hand will verify that a scene as been animated and 
coloured, and then will apply camera moves, peg moves, effect and final touch up to the 
scene.

Post-Production
When all the scenes are rendered out, the user will assemble them in an external 
application and add the sound to the project. The final effects and filter will be added. 
The final step will be to render out to the master and distribute it, unless there is dubbing 
to be done. Very often, the final transfer will be done by an external post-production 
company.
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Cut-out Workflow
Other than scripting, and recording, every other step in the cut-out workflow should be 
done in the animation software. It is also a type a workflow were multiple assignments 
can be done simultaneously, especially during design and development stage. 

Since the storyboard does not need to follow model sheets, it is possible for a team to 
do both the storyboard and designs at the same time, as compared to a traditional 
workflow where the storyboard artist will need to have all the models ready before 
starting.
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A cut-out production reuses a lot of assets, saves time, keeps a maximum amount of 
work in the same studio and reduces the amount of resources and budget needed. We 
eliminated as many traditional and hand-drawn steps as possible and keep all of the 
steps in an integrated pipeline.

Other than the script writing, audio recording, and post-production, all of the tasks are 
accomplished within software.

Starting the Project

The Script

All projects start with a script. It is the foundation of the whole project. This comes from 
either the studio itself or the client requesting the project. 

Following the script, the design team will design the character, props and locations and 
the storyboard artist will build the storyboard. 

Pre-Production Variants

Designs

Designs for the characters, props, and locations are done directly in the software as they 
will be broken down and rigged in it. This way, whatever the breakdown technique 
chosen, the lines will be the same style, the palette will already be created and it will be 
less work to break-down and rig. It is also possible to design them on paper and scan 
them in, but this is less efficient in the use of paper resources and time.

Dialogue and Nat Pause

The dialogue is also recorded from the script. The voices are often recorded outside of 
the studio. If there is dialogue involved in the project, the final version will have to be 
recorded soon enough to import it into the project before the animation. This allows the 
animator to do the sound breakdown and animate the mouth and expressions, as well 
as the storyboard is required. 

Nat pause is a generic audio read-through used by the storyboard artist to hear what the 
characters are saying and how it is said. In this way, they can draw the correct facial and 
physical expressions to coincide with the dialogue. It is important to minimize the 
revision to the visuals during the animation process.

Storyboard
The storyboard is the illustrated script of the film. It can be started in tandem with the 
design and the audio recording, but some studios wait until the designs and the audio 
recording are finalized.
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Animatic Reel

The animatic reel, also known as “leica,” is made from the storyboard. Each scene is 
timed along with sounds, dialogue and music. The storyboard must be completed, 
approved and locked before the animatic is done. The person in charge of the animatic 
must ensure consistency over the entire production.

Colour Styling

The colour styling must be done before the animation and character breakdown. If the 
backgrounds are painted in an external software, then the locations (key backgrounds) 
colour styling should be done in that same external software.

Production

Background Layout

From the storyboard, we normally go to the layout and posing process. For a cut-out 
project, the storyboard does not need to be on model as the characters and props used 
for the animation are puppets, which always remain on model. 

Background Painting

The backgrounds can be painted within the animation software, or in an external 
software. 

Character and Prop Breakdown

The character and prop breakdown can be done in many ways. It is important to do this 
step correctly, as these puppets will be duplicated over and over throughout the whole 
project. The artist will study the designs made during pre-production, and will then cut 
it all into pieces to build puppets out of it. 

Library Management

The library is typically managed by the breakdown artist. It is important to keep the 
library organized, as it is a central piece in the animator’s project. The artist will create 
folders and organize each pertinent file so that neither the scene set-up artist, nor the 
animator will be required to search randomly when looking for particular pieces of 
material. It is essential that this job be done correctly in order for the team to remain 
efficient throughout production.

Scene Set-up

The production starts with the scene set-up, which is the equivalent of traditional posing. 
The scene set-up team is a central point in a cut-out production, because they ease the 
workload of the animators, maintain a consistency over the project, reduce the amount 
of retakes and increase the animation quality and speed. Scene set-up artists place 
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puppets, props and camera in a cut-out animation scene so that it is ready for the 
animator.

Animation

The animation technique has to conform with the rigging technique. The studio has to 
establish its profile in order to determine which direction to take.

Here are the choices for the type of animation:

• Open Rig technique with Motion Keyframe animation

• Open Rig or Mixed Rig technique with Stop-Motion or Motion Keyframe 
animation

• Complete hierarchy rigging technique with Motion Keyframe animation or Open 
Rig technique with a mix of Stop-Motion and Motion Keyframe animation

• Complete Hierarchy rigging technique with Motion Keyframe animation or Open 
Rig with Stop-Motion Keyframe animation

In certain situations, tradigital animation features can help increase the quality of your 
cut-out animation

In a small team, the animators will animate their own effects, whereas a bigger team can 
have one effect animator to help the cut-out animators

Compositing

Compositing is generally a bit more advanced and complex for a cut-out production 
than for a traditional or tradigital one. The compositor will verify that a scene has been 
animated and coloured, and then will apply camera moves, peg moves, effect and final 
touch up to the scene.

On a small team, the animators will probably do their own compositing. In a medium-
size studio, there will be two or three compositors.

The rendering step is generally handled by the compositor.

Post-Production
When all the scenes are rendered out, the user will:

1. Assemble the scenes using an external application.

2. Add the sound to the project. 

3. Add final effects and filters. 

4. Render out to the master.

5. Distribute the scene, unless there is dubbing to be done.
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Tradigital Workflow
The tradigital workflow is a mix between traditional animation and digital animation 
workflow. While some steps can all be done in the animation software and 
simultaneously, some other steps, like animation, animation clean-up and ink and paint, 
require that the previous steps be done completely before moving to the next.

A tradigital production is meant to use a very small amount of paper, or to eliminate it 
altogether. In this workflow example, we tried to eliminate a maximum number of 
Traditional steps and keep all of the steps in an integrated pipeline.

Other than the script, audio recording and post-production, all of the tasks are 
accomplished within the animation software.
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Starting the Project

The Script

All projects start with a script; it is the foundation of the whole project. The script comes 
from either the studio itself, or the client requesting the project. 

Following the script, the design team will start designing the character, props and 
locations and the storyboard artist will start building the storyboard. Again, this process 
is similar to any other workflow.

Pre-Production Variants

Designs

We recommend that you design the characters, props and locations directly within the 
animation software to keep everything digital and save time. You can also design them 
on paper and scan them in, but this requires a bit more work and handling.

Dialogue and Nat Pause

The dialogue is also recorded from the script. The voices are often recorded outside of 
the studio. If there is dialogue involved in the project, the final version will have to be 
recorded soon enough to import it into the project before the animation. This allows the 
animator to do the sound breakdown and animate the mouth and expressions, as well 
as the storyboard is required. 

Nat pause is a generic audio read-through used by the storyboard artist to hear what the 
characters are saying and how it is said. In this way, they can draw the correct facial and 
physical expressions to coincide with the dialogue. It is important to minimize the 
revision to the visuals during the animation process.

Storyboard 

The storyboard is the illustrated script of the film. It can be started in tandem with the 
design and the audio recording, but some studios will wait until the designs and the 
audio recording are finalized.

Animatic

The animatic is created from the storyboard. Each scene is timed along with sounds, 
dialogue and music. The storyboard must be completed, approved and locked for the 
animatic to be created. There will be a person in charge of the animatic in order to 
maintain consistency over the whole production.

Note that if the storyboard is done on paper, someone will have to scan the storyboard 
and prepare it for the animatic. In a small team, the animatic person can take care of the 
scan.
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Colour Styling

The colour styling can be done before or after the animation. It does not really have an 
impact on the pipeline. This step can be done on paper, directly in the animation 
software or in external software.

If the backgrounds are painted in an external software, the colour styling of the locations 
(key backgrounds) should also be done in this same external software.

Production
The production part of tradigital animation can be completely done within the animation 
software. This includes the animation, the clean up, the inking and painting, the 
background painting, compositing, etc.

Background Layout and Posing

For the tradigital production, the layout and posing step is very important as it helps to 
clearly communicate the storyboard information to the animators. The layout will contain 
all the information necessary for the animator to complete the animation in the scene: 
background, overlay, underlay, and key poses (which are usually referenced from the 
model pack).

Background Painting

The backgrounds can be painted in the animation software or in an external software.

Animation and Dialogue

In a tradigital animation production, the animation and clean up are digitally assisted by 
the layout and posing. The animation is one of the longest steps in a production. The 
core of the team should be composed of animators and clean up artists.

If there are dialogues to be animated, the animator will import the sound files in the 
project and use the sound scrubbing or the automated lip sync detection features to 
breakdown the sound and establish which mouths to use and animate.

There is no need to do a traditional sound-break down.

Inking, Painting and Compositing

The ink and paint process is probably the longest digital step. It requires you to clean all 
of the drawings, ink the lines and fill all of the colours on all drawings. If there are a lot 
of details and lines to be inked, the colour step will take longer.

The compositor on the other hand will verify that a scene as been animated and 
coloured, and then will apply camera moves, peg moves, effect and final touch up to the 
scene.
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Post-Production
When all of the scenes are rendered out, the user will assemble them in an external 
application and add the sound to the project. The final effects and filter will be added. 
The final step is to render out to the master and distribute it, unless there is dubbing to 
be done.

A single person is sufficient for the final editing. Very often, the final transfer will be done 
by an external post-production company.
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Lesson 4: Animating Basic Shapes

This lesson includes the following sections:

• Lesson Objectives, on page 64

• Lecture Notes, on page 66

• Activity: Drawing and Manipulating Basic Shapes, on page 96
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Lesson Objectives

Total Lesson Time: Two classes
This lesson introduces you to basic shapes and their manipulation.

At the end of this lesson, you should be able to:

• Create and open a new project from the Welcome Screen.

• Have a working knowledge of the interface along with it’s main components and 
views, as well as how to navigate it.

• Draw, edit, arrange and deform basic three-dimensional shapes, using basic 
tools and taking into consideration the volume and the material of the object.

Activity: Drawing and Manipulating Basic Shapes

User Guide References
• Chapter 2 Starting Your Project

 Launching Toon Boom Studio, on page 18
 Welcome Screen, on page 19
 Creating and Opening a Project, on page 20

• Chapter 3 Discovering the Interface

 Interface Components, on page 44
 Interface Highlights, on page 47
 Interface Navigation, on page 60

• Chapter 4 Drawing and Designing

 Drawing Basics, on page 66
 Drawing in the Drawing or Camera View, on page 67
 Drawing Using the Brush or Pencil Tool, on page 68
 Sketching, on page 72
 Tracing, on page 74
 Erasing Part of a Drawing, on page 76
 Selecting Drawing Objects, on page 77
 Pen View, on page 79
 More Drawing Tools, on page 87
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Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 2- User Interface

 Drawing Windows: 0:02:04
 Workspaces: 0:02:31

• 3- Creating Content:

 Drawing inside Studio: 0:04:50
 Eraser Tool: 0:00:58
 Different Line Sizes: 0:01:32
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Lecture Notes
In this section, you will learn:

• Launching Toon Boom Studio, on page 66

• Welcome Screen, on page 67

• Discovering the Interface, on page 70

• Interface Highlights, on page 74

• Managing Views, on page 81

• Managing Toolbars, on page 85

• Interface Navigation, on page 86

• Drawing Basic Shapes, on page 87

• Further Reading, on page 95

Launching Toon Boom Studio
To use Toon Boom Studio you have to start it; this is called launching the application. To 
do so, just follow the steps below. And remember, you can use Toon Boom Studio on 
Mac OS X or Windows operating systems.

To launch Toon Boom Studio, do one of the following:

• Mac OS X: Double-click on the Toon Boom Studio  icon or select 
Applications > Toon Boom Studio 6.0.

• Windows: Double-click on the Toon Boom Studio  icon or select 
Start > Programs/All Programs > Toon Boom Animation > Toon Boom Studio 
6.0 > Toon Boom Studio 6.0. 

Toon Boom Studio opens, displaying the Welcome Screen.
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Welcome Screen 
When Toon Boom Studio launches, the Welcome Screen appears. This screen is also 
accessible once you are inside a project. To display the Welcome Screen from within the 
application you need to close the current project by selecting File > Close. You can also 
use the default keyboard shortcut [Ctrl]+[W] (Windows) or []+[W]. 

NOTE: this command closes the scene which is currently open.

The Welcome Screen allows you to:

• Create scenes

• Choose the scene resolution

• Open scenes by browsing

• Open recent scenes from a list

• Access the How To and the Forum

Creating a New Project from the Welcome Screen 
To create a project from the Welcome Screen:

1. In the Name field, type the name for your new project. Make sure to give it a name 
which easily identifies the project, such as JumpingFrog. That way when you have 
several projects you can locate specific ones more easily. 
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2. In the Format drop-down menu, select the format in which you want to produce 
your project. 

You can choose from a wide variety of presets such as Web, iPod and DV. By default, 
the option selected is Most Recent. This means that it will use the last settings you 
chose when creating your last project. 

When you create a project for the first time, it will use the settings marked in the 
Frame Rate and Camera Size field. By selecting any of the presets, the Frame Rate 
and Camera Size fields will be automatically populated with the corresponding 
values.

3. If you prefer to use your own settings, you can type the Frame Rate and the Camera 
Size directly in the fields.

 

4. Once the information is in place, click on the Create button to make your project.

The new project opens.

Now that you have created a new project, the next step is to save it to the correct 
location. 

It is a good idea to follow a structure when saving your work so that your files are 
not scattered all over your computer.

To save your project for the first time:

1. Select File > Save As. The default keyboard shortcut is [Ctrl]+[Shift]+[S] (Windows) 
or []+[Shift]+[S] (Mac OS X).

The Save As dialog box opens.

2. In the Save As window, browse to the location where you want to save your project. 
If need be, rename it in the File Name field. Remember to give the project a name 
you can identify easily.

3. Click on the Save button to complete the operation.

Opening a Project from the Welcome Screen 

When you already have a project, you may find that you want to reopen it to work on it 
further, or to make adjustments. You can do this via the Welcome Screen.
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To open a project from the Welcome Screen:

1. In the Open Recent section, click on the Browse option.

The Open browser opens.

2. Browse and select the file for the project you want to open.

•  *.tbp (Toon Boom Project) (Windows) 

• OR 

• *.tbpd (Toon Boom Studio Document) (Mac OS® X)

NOTE: This is why it is important to give each project a name you can identify it by. 
If you have several projects called project1.tbp, project2.tbp and project3.tbp it 
would be difficult to remember what was in each. 

3. Click on the Open button to open the project.

If your project is already open and you want to work on a specific scene in that 
project you can also do that from the Welcome Screen.

To open a recent scene from the Welcome Screen:

1. In the Open Recent section, select a scene from the list.

2. Click on the scene name to open the scene.
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Discovering the Interface

This section is divided as follows:

• Interface Components, on page 71

• Interface Highlights, on page 74

• Managing Views, on page 81

• Managing Toolbars, on page 85

• Interface Navigation, on page 86
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Interface Components 

Toon Boom Studio’s user interface has three main components that you will use all the 
time while creating your animation:

• Menus, on page 71

• Toolbars, on page 73

• Views, on page 73

Menus 

Toon Boom Studio has two kinds of menus:

• Top Menu, on page 71

• Quick Access Menu, on page 72

Top Menu 

The top menu is always located at the top left corner of the interface. On Windows, it is 
part of the user interface and on Mac OS X, it is located at the very top of the screen.

Menu

Toolbars

Toolbars

Views
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In the top menu, you will find most of the commands you will use throughout your whole 
project.

Quick Access Menu 

The Quick Access Menu is a contextual menu containing only the commands relative to 
the view and area in which you are working. Instead of going all the way to the top menu, 
just right-click (Windows) or [Ctrl]+click (Mac OS X) in the view in which you are working 
to display it.

You will find a series of Quick Access menus throughout the interface. Here is a list of the 
main ones:

• Camera View

• Drawing View

• Timeline Layers (Timeline’s Left Side)

• Timeline Frame (Timeline’s Right Side)

• Xsheet Column Header

• Xsheet Column Cells

• Colour Palette View

• Library Folders (Library’s Left Side)

• Library Templates (Library’s Right Side)
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Toolbars 

Instead of selecting a command in a menu, you can click on the buttons in the toolbars. 
You will mainly find toolbars at the top and left side of the interface, but also within 
certain views such as the Timeline view.

It may be more visual and easier to find a feature if you browse through the different 
toolbars.

The main toolbars you will encounter in the software are:

• Main Toolbar

• Drawing Tools Toolbar

• Sceneplanning Tools Toolbar

• Interactive Playback Toolbar

• Grid Control Toolbar

• Onion Skin Toolbar

• Peg Toolbar

• Scene View Toolbar

• Workspace Toolbar

• Exposure Sheet Toolbar

• Timeline View Toolbar

Views 

Toon Boom Studio’s interface is composed of several different views that you will use to 
perform different actions. The main view you will use for your project is the Camera view 
assisted by the Timeline view.

Each view specializes in one or two aspects of the production. For example, the Camera 
view is used for motion path animation and scene setup. The Drawing view is used for 
drawing and the Timeline view for setting timing and creating simple effects.
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Here are the different views available in the software:

• Camera View

• Cell View

• Colour Palette View

• Drawing View

• Exposure Sheet View

• Function View

• Library View

• Pen View

• Properties View

• Scene Manager View

• Side View

• Text View

• Timeline View

• Top View

Interface Highlights 
In Toon Boom Studio, you will find several different views and toolbars. In this section, 
you will learn about the main ones that you will use frequently. All others are described 
in context in other chapters.

In this topic, you will learn about the followings:

• Camera View, on page 75

• Drawing Tools Toolbar, on page 77

• Sceneplanning Tools Toolbar, on page 77

• Timeline View, on page 78

• Interactive Playback Toolbar and Play Menu, on page 79
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Camera View 

The Camera view is the main view you will use to create your artwork and animate it. In 
the Camera view, you will find the camera frame in which you have to position your 
elements if you want them to be part of your final movie. Anything outside the camera 
frame will not appear in your final export.

In the Camera view, you will also find two toolbars:

• View Navigation Toolbar, on page 75

• Switch View Toolbar, on page 76

View Navigation Toolbar 

In the View Navigation Toolbar, you will find five buttons allowing you to zoom, pan and 
rotate the Camera view.

•  Switch Between Two Views

• Click on this button to toggle between the two last zoom levels you used. For 
example, if you zoom in very close on a drawing and then zoom out to a global 

Switch View Toolbar

View Navigation Toolbar

Camera Frame
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view, clicking on this button will toggle between the close up and the global 
zoom levels.

• The default keyboard shortcut is [B].

•  Reset Zooming and Panning

• Click on this button to reset any zoom, rotation and pan action you did while 
navigating in the Camera view working area. The camera frame will be 
re-centred in the Camera view. Note that it does not reset the positioning you 
may have done on your drawings and images.

• The default keyboard shortcut is [Shift]+[V].

•  Recentre the Active View

• Click on this button to centre the camera frame in the Camera view. Any rotation 
or zoom action will remain the same.

• The default keyboard shortcut is [Shift]+[Space].

•  Reset the Rotation of the Window

• Click on this button to reset any rotation you did on the Camera view working 
area. The pan and zoom levels will remain the same. Note that it does not reset 
the positioning you may have done on your drawings and images.

• The default keyboard shortcut is [Shift]+[C].

•  Reset the Zoom Level of the Window

• Click on this button to reset any zoom action you did on the Camera view 
working area. The pan and rotation will remain the same. Note that it does not 
reset the positioning you may have done on your drawings and images.

• The default keyboard shortcut is [Shift]+[Z].

Switch View Toolbar 

In the Switch View Toolbar, you will find four buttons allowing you to toggle between the 
following views:

•  Drawing View

•  Camera View

•  Side View

•  Top View

This toolbar is useful when switching between these views to save room in your 
workspace. You can also have these views separately by selecting them in the top 
Window menu.
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Drawing Tools Toolbar 

The Drawing Tools toolbar contains all of the different tools, including the Brush Tool, 
that you will need to draw and design your artwork. Some extra commands can be found 
in the top Tools menu.

Some of the buttons in the toolbar have a black drop-down arrow, this lets you open a 
menu with extra drawing tools.

Sceneplanning Tools Toolbar 

The Sceneplanning Tools toolbar contains all of the different tools you will need to 
position and animate your layers. Extra commands can be found in the top Element 
menu.

Some of the buttons in the toolbar have a black drop-down arrow, which lets you open 
a menu with extra sceneplanning tools.
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Timeline View 

The Timeline view is the main view used to create layers, set your timing and create 
simple effects.

The Timeline view is divided in three sections:

Timeline View Toolbar

Layers Section

Timing Section

Timeline View Toolbar

The Timeline View toolbar is composed of nine different buttons allowing you to add, 
enable and disable layers as well as switching between the different scenes of a same 
project.

•  Show/Hide All

• Click on this button to show or hide all the layers in your timeline. This button 
will toggle between the two states.

•  Solo Mode

• Click on this button to toggle between the Solo Mode On  and Off  states. 
The Solo mode allows you to see only the currently selected layer as well as the 

Timeline View Toolbar

Layers Timing
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layer that was selected when you enabled the Solo Mode to use it as a reference 
without having to disable all the other layers.

•  Add New Elements

• Click on this button to add a new element (layer) to your timeline. When you 
click on this button, the New Element dialog box opens and lets you choose 
which type of element you want, how many and how you want to name it.

•  Delete Element

• Click on this button to delete the selected layers in your timeline. Note that if 
you delete a layer with other layers connected to it, all the layers connected will 
be deleted at the same time. Also, if you only have one layer in your timeline, 
you will not be able to delete it. The Toon Boom Studio Timeline view must 
always have at least one drawing layer in it.

•  Add Drawing Element

• Click on this button to add a drawing layer in your timeline without having to go 
through the Add New Element dialog box. Simply click on the button and a new 
drawing layer will appear in the Timeline view. You can then double-click on the 
new layer to rename it.

•  Add Peg Element

• Click on this button to add a peg layer in your timeline without having to go 
through the Add New Element dialog box. Simply click on the button and a new 
peg layer will appear in the Timeline view. You can then double-click on the new 
layer to rename it.

•  Add Parent Peg

• Click on this button to add a peg layer in your timeline and connect it to any 
selected layer without having to go through the Add New Element dialog box. 
Simply click on the button and a new peg layer will appear in the Timeline view 
and the selected layer will be connected to it. You can then double-click on the 
new layer to rename it.

•  Scene Menu

• Click on this button to travel between the different scenes in your project.

•  Timeline View Contextual Menu

• Click on this button to display a drop-down menu containing commands related 
only to the Timeline view.

Interactive Playback Toolbar and Play Menu

Use the Interactive Playback toolbar and the Play menu to play back your animation and 
sound.
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Interactive Playback Toolbar

• Click on the Play  and Stop  buttons to play and stop the animation. You 
can also do this from the top menu by selecting Play > Play or Stop. The default 
keyboard shortcut is [P].

• Click on the Loop  button to repeat your playback indefinitely. Or do this 
from the top menu by selecting Play > Loop. 

• Click on the Previous Frame  button to go to the previous frame of your 
animation. Or do this from the top menu by selecting Play > Previous Frame.

• Click on the Next Frame  button to go to the next frame of your animation. 
Or do this from the top menu by selecting Play > Next Frame. 

• Click on the First Frame  button to go to the first frame of your animation. Or 
do this from the top menu by selecting Play > First Frame. 

• Click on the Last Frame  button to go to the last frame of your animation. Or 
do this from the top menu by selecting Play > Last Frame. 

Play Menu 

Select any of the following from the top menu Play heading:

Frame Rate: to choose the playback speed of your animation. By default, the option is 
set to use the same playback speed you set in your Animation Properties when you 
created the project. In the drop-down menu, you can change it to 1, 2, 12, 24 or 30 frame 
per second.

Force Frame Rate: to force Toon Boom Studio to play the right playback speed. If a 
scene is too heavy to be played back in real time, Toon Boom Studio will drop images 
rather than playing back all images at a slower pace.

Playback Range: to specify the range of frames to be played back. By default, the option 
is set to Automatic Fit allowing you to play the full scene length. If you set the option to 
Free, black markers appear in the Timeline view. 
You can drag these markers to the first and last frames you want to be played back. 

You can also select the Change the Playback Start Frame option to type the 
number of the first frame of the playback range.
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You can also select the Change the Playback End Frame option to type the number 
of the last frame of the playback range.

• Preview Movie: to export a QuickTime movie of the entire animation project 
including all its scenes.

• Preview Scene: to export a QuickTime movie of your current scene, ignoring the 
other scenes in the project.

• Preview Exposure Sheet: to export a QuickTime movie of the drawings in the 
exposure sheet of the current scene only. This type of render ignores all the 
motion path and scene planning done in the Camera view.

• Preview Exposure Sheet Selection: to export a QuickTime movie of the 
selected drawings in the exposure sheet of the current scene only. This type of 
render ignores all the motion path and scene planning done in the Camera view.

• Turn Off/On Sound Playback: to enable or disable the sound while playing back 
the scene.

• Turn Off/On Sound Scrubbing: to enable or disable the sound scrubbing effect 
while changing frames in the Timeline view. The sound scrubbing option is 
mainly used to do lip-sync decoding.

• Quick Preview: to export a Flash SWF movie of your current scene ignoring the 
other scenes in the project.

Managing Views 
The Toon Boom Studio user interface is composed of different views, each one designed 
for a specific purpose. 

This section explains how you can modify the location and accessibility of the views by 
adding a new view as a tab or as a window, you can also swap the view locations around.

This section covers the following topics:

• Adding a New View, on page 82

• Closing a View, on page 82

• Swapping Views, on page 85

• Managing Toolbars, on page 85
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Adding a New View 

To add a view:

• Select the view you want to add from Window > The desired view.

• If your view appears as a floating window and you want to dock it to your 
workspace, drag the window’s tab onto one of the workspace’s views. 

• To insert your view into an existing area, wait until the zone is highlighted before 
dropping it.

• To insert your window between existing views, drag your window to the border 
of an existing view and wait for a new space to slide open before dropping it.

Closing a View 

To close a view:

1. Click on the Close View button.

Undocking and Docking Windows and Views 

In Studio you can rapidly dock, undock or move windows and views around the interface 
and your desktop. This will make it easy for you to organise your workspace and obtain 
the maximum use from the available desktop real estate. 
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In fact, if you have a dual monitor setup, you can drag it away from the Studio interface 
and place it on the second monitor’s desktop.

Note: By default, all windows and views are docked into the interface. You can change 
this default to floating, by choosing Floating Windows from the drop-down menu 
options in Edit > Preferences > Interface tab > Workspace Mode (Windows) or Studio 
> Preferences > Interface tab > Workspace Mode (Mac OS X).

Undocking 

To undock a window or view from the Studio interface, do the following:

1. Double-click on the window or view’s name tab. 

p

Click on the name tab here. 
In this case we are going to 
undock the Colour Palette 
from the interface.
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The window will automatically detach from its docked position and appear floating 
in the interface.

1. Once you have detached the window, you can resize it to fit your work needs.

Docking 

To return the floating window to its docked location, do the following:

1. Double-click on the floating window’s title bar. The window will automatically return 
to the docked location.

Note: Next time you double click on that window’s name tab, it will undock and return 
to its last location on your desktop.

The Colour Palette 
window is now detached 
from the interface, it is 
floating.

Double-click on the title 
bar, the window will 
return to its docked 
location.
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Moving the Floating Window Around the Desktop 

After the window is undocked you can move it around and position it anywhere on your 
desktop. 

1. Click on the window’s title bar, hold the mouse button down and drag the window 
to the new location. 

Note: Next time you double click on that window’s name tab, it will undock and return 
to the location where you last had that floating window on your desktop.

Swapping Views 

To swap views around:

1. Select the view tab and drag it onto one of the view’s separators, top area or onto 
another view.

2. When a darker zone appears showing an available location for the view, release the 
mouse button and drop the view into position. 

Managing Toolbars 
The Toon Boom Studio user interface contains toolbars which, by default, are located at 
the top or side of the interface. You can reposition the toolbars to suit your work style 
or hide unused ones.

This section covers the following topics:

• Showing or Hiding Toolbars, on page 85

• Moving Toolbars, on page 86

Showing or Hiding Toolbars 

To show or hide a toolbar:

1. Select Window > Toolbar > the desired toolbar.

Click here and drag it 
anywhere on your 
desktop.
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Moving Toolbars 

To move a toolbar:

1. Select the toolbar you want to move by clicking on its anchor point  and dragging 
it to another position in the top or side interface toolbar area.

2. When a rectangle outline appears showing an available location for the toolbar, 
release the mouse button and drop the toolbar into position.

Interface Navigation 
Toon Boom Studio supports Zoom In, Zoom Out, Rotate, Pan and Reset View Position 
for easy interface navigation.

• Zoom In: Zooms into the view. Use the keyboard shortcut [X] or from the top 
menu, select View > Zoom In.

• Zoom Out: Zooms out of the view. Use the keyboard shortcut [Z] or from the top 
menu, select View > Zoom Out. 

• To Pan the view: Hold down the keyboard shortcut [Spacebar] and drag your 
mouse in the direction you want to pan the view. 

• To Rotate Clockwise: Use the keyboard shortcut [V] or for the top menu select 
View > Rotate Clockwise. 

• To Rotate Counter Clockwise: Use the keyboard shortcut [C] or for the top 
menu select View > Rotate Counter Clockwise. 

• To Re-centre the view: Click on the keyboard shortcut [Shift] + [Spacebar] or 
from the top menu, select View > Recentre. 

• Reset View: Resets the view to its default position. Use the keyboard shortcut 
[Shift]+[V] or from the top menu, select View > Reset View.

• Reset Rotation: Resets the view’s rotation to its default position. Use the 
keyboard shortcut [Shift]+[C] or from the top menu, select View > Reset 
Rotation. 

• Reset Zoom: Resets the view’s zoom to its default position. Use the keyboard 
shortcut [Shift]+[Z] or from the top menu, select View > Reset Zoom. 

• Turn On/Off Full Screen: Enlarges the selected view to full screen, keeping the 
side panel. Use the keyboard shortcut [Ctrl]+[F] (Windows) or []+[F] (Mac OS X) 
or from the top menu, select View > Turn On/Off Full Screen.
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Drawing Basic Shapes

The prospect of designing a character can be daunting. Instead of adding a bunch of 
bells and whistles (or in this case ray-guns and jet-packs), start with basic shapes to 
create characters and objects. Details can always be added after. Some of the best and 
most effective character designs are comprised of nothing more than a few simple 
shapes. In addition, it is easier to animate simple characters as opposed to characters 
with many tiny details.

Basic shapes include circles, squares, rectangles, and ellipses. These shapes can then be 
expanded to create objects with volume, such as cylinders, cubes and spheres.

Some important things to keep in mind while you draw your character:

• The quality of the line (use of thicks and thins)

• Drawing with your entire arm (not just by moving your wrist)

• Using truncated shapes (half spheres and quarter cylinders)

In this section, you will learn about: 

• Drawing Basics, on page 87

• Drawing in the Drawing or Camera View, on page 88

• Drawing Using the Brush or Pencil Tool, on page 89

• Sketching, Tracing and Erasing, on page 90

Drawing Basics 

As soon as Studio is launched, you can immediately start drawing using the drawing 
layer which is already available. 

How to Draw:

1. Click on the Drawing View  button to switch to the Drawing view. You’ll find it in 
the top right corner of the main window.
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2. In the Drawing Tools toolbar, select the Brush  tool. You can also press the [@] 
default keyboard shortcut.

3. In the Timeline or Xsheet view, select the first cell in the drawing layer.

In the Drawing view, start drawing.

Drawing in the Drawing or Camera View

In Toon Boom Studio, you can either draw in the Drawing view or the Camera view. 
Although the views look similar, there are some differences when it comes to drawing.

 Drawing View 

By default, only the selected cell drawing is displayed in the Drawing view. You can use 

tools such as the Light Table , which will display the current frame drawing of all the 
visible layers of your scene in washed out colours, or the Onion Skin  option which 
displays the previous and next drawing of the currently selected drawing layer.

To switch to the Drawing view:

• Click on the Drawing View  button on the top right corner of the main window 
to switch to the Drawing view.

 Camera View

By default, all the visible layers drawing of the selected frame will be displayed in the 
Camera view. The selected drawing will automatically be displayed on top when you are 
using a Drawing tool to facilitate the edition of the drawing. You can also use the Onion 

Skin  option to display previous and next drawings of the selected drawing layer.

To switch to the Camera view:

• Press on the Camera View  button to switch to the Drawing view. You’ll find it 
in the top right corner of the main window.

To hide and show layers in the Timeline view:

1. In the Timeline view, click in the checkbox corresponding to the layer you want to 
hide.

•  An enabled checkbox means that the layer is visible

•  A disabled checkbox means that the layer is hidden.
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To show or hide all layers at once in the Timeline view:

1. In the Timeline view, click on the Show/Hide All  button.

Drawing Using the Brush or Pencil Tool 

The Brush  and Pencil  tools are used to draw and sketch with.

 Brush Tool 

The Brush tool takes account of pressure sensitivity, allowing you to create lines with 
variable thicknesses when using a pen tablet, creating a contour vector shape.

You can set different parameters, such as the size and smoothness of the Brush tool in 
the Pen view.

To select the Brush tool: 

• In the Drawing Tools toolbar, select the Brush  tool.

• In the top menu, select Tools > Drawing Tools > Brush.

• Press [@], the default keyboard shortcut.

 Pencil Tool 

The Pencil , Polyline  and Shape  tools create a central vector line of 
uniform thickness. 

You can set different parameters, such as the size and smoothness of the Pencil tool in 
the Pen view.

To select the Pencil tool:

• In the Drawing Tools toolbar, select the Pencil  tool.

• In the top menu, select Tools > Drawing Tools > Pencil.

• Press the keyboard shortcut [2], to cycle through tools.

Central

Contour

Pencil tool

Brush tool
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Sketching, Tracing and Erasing

In this section, you will learn about: 

• Sketching, on page 90

• Tracing, on page 92

• Erasing Part of a Drawing, on page 94

Sketching 

A sketch is a rough version of your design. When you sketch a rough of a new design for 
a character you can produce whatever you imagine without being concerned about the 
final look of your lines. Making a rough version of your character helps you build a solid 
base shape and come up with some new design ideas. Studio has many tools available 
for sketching.

To make a sketch:

1. In the Drawing Tools toolbar, select the Brush  tool. You can also press the [@] 
default keyboard shortcut.

2. In the Pen view, set the look of your Brush:

• Click on the Brush Preview area and select the brush shape you want.

• Use the sliders to set the Minimum and Maximum brush sizes.
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As you set your brush size, the Brush Preview area will display the Minimum size of your 
brush in black and the Maximum size in dark grey.

• You can also set the Smoothness value of the Brush tool. Use this option to 
smooth out the brush stroke after you trace it. The higher the value, the more 
smoothness will be applied to your line.

3. In the Colour view, click on a default colour swatch you want to draw with to change 

the colour of the Brush  tool. 

4. In the Timeline or Xsheet view, select the first cell of the drawing layer.

5. In the Drawing view, sketch your character.
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Tracing 

Once you have sketched a rough version of your design, the next step is to trace it. 
Tracing lets you determine the final look and line style of your drawing. Studio has many 
tools available for you to trace and perfect your drawing line.

To trace a drawing: 

1. Open the scene containing your sketch drawing to be traced,.(this may already be 
open).

2. In the Drawing Tools toolbar, select the Brush  tool. You can also press the [@],   
default keyboard shortcut.

3. In the Pen view, set the look of your Brush:

• Click on the Brush Preview area and select the brush shape you want.

• Use the sliders to set the Minimum and Maximum brush sizes. As you set your 
brush size, the Brush Preview area will display the Minimum size of your brush in 
black and the Maximum size in dark grey.

• You can also set the Smoothness value of the Brush tool. This option will smooth 
your brush stroke after you traced it. The higher the value, the more smoothness 
will be applied to your line.
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4. In the Colour view, click on a default colour swatch you want to draw with. This will 

change the colour of the Brush  tool.

5. In the Timeline or Xsheet view, click on the Add Drawing Element  button to add 
a new drawing layer.

6. In the Timeline or Xsheet view, select the cell of the new drawing layer 
corresponding to the frame your sketch is in.

7. In the Onion Skin toolbar, click on the Auto Light Table  button to enable the 
Light Table. You can also select View > Turn Auto Light Table On from the top 
menu. The default keyboard shortcut is [L].

Your sketch drawing layer will appear washed-out in the Drawing view.

8. Sometimes it helps to hide elements, specially when having many drawing layers. 
You can hide elements in the Drawing View, using the Exposure Sheet view, so that 
you can focus on a specific layer.

9. In the Exposure Sheet view, select the column containing the drawing you want to 
hide and select  
Element > Display > Exposure Sheet > Hide from the top menu.

10.To hide all the drawing columns except the currently selected ones, select  
Element > Display > Exposure Sheet > Hide All Others from the top menu.

11.To show again the hidden columns, select  
Element > Display > Exposure Sheet > Show All Exposure Sheet Elements from 
the top menu.
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12.In the Drawing view, trace your character.

13.You can use the Rotary Table to rotate your workspace in the same way as you 
would rotate a sheet of paper you were tracing on: 

Press and hold [Ctrl]+[Alt] (Windows) or [Ctrl]+[] (Mac OS X) to display the rotary 
table and then click and drag inside the drawing view to rotate the workspace. 

• Select View > Reset Rotation or press [Shift]+[C], the default keyboard shortcut, 
to reset the rotation of the view.

Once you are comfortable using the Drawing tools, you can improve your line art 
using the Contour Editor tool.

Erasing Part of a Drawing 

The Eraser  tool is pressure sensitive, just like the Brush tool. Pressure sensitivity 
provides more precision if you have to erase parts of a drawing. Its parameters can be 
set in the Pen view, such as size, smoothness and eraser shape. 

To erase with the Eraser tool: 

1. In the Drawing Tools toolbar, select the Eraser  tool.  
You can also select Tools > Drawing Tools > Eraser from the top menu. 

• The default keyboard shortcut is [$].
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2. In the Drawing or Camera view, erase parts of the drawing.

 You can also delete drawing objects by selecting them with the Select  tool and 
pressing [Delete].

Further Reading
• The Animation Book: Chapter 1: Basic Skills
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Activity: Drawing and Manipulating Basic Shapes
Draw the basic construction of a few volumetric shapes and then deform them.

• Resist the urge to create scratchy lines; simple confident strokes are the most 
important to develop.

• Visualize, then analyze how a shape may change. See it in action.

Create a new project in Toon Boom Studio and complete the exercise. You should take 
this opportunity to review some of the elements in the interface, such as the Drawing 
Tools and Drawing view.

Material Provided for this Lesson
The Lesson 4 sample material contains drawings of the basic shapes that have been 
squashed, stretched, bent, and tied.

Exercise: Drawing Basic Shapes
1. Beginning with a blank canvas in your Drawing View and using the Drawing Tools 

toolbar, use the Brush  tool to draw the basic shapes: circles, boxes, and 
rectangles. 

You will only develop drawing skills through practice of the basics, so do not cheat 
by using the Rectangle  and Ellipse  tools. These tools are a subset of your 
Brush tool and should only be used once you are comfortable drawing with the 
Brush tool. You might want to experiment with different settings for the variable-

width thickness of the Brush  tool.

2. Give your basic shapes a third dimension: draw cylinders, cubes, spheres.
3. Squish, stretch, bend, and twist your 3D shapes! Do this manually—do not use the 

automated tools in Toon Boom Studio. It is important to do this manually to develop 
an understanding of how volume and material affect how shapes change.
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Lesson 5: Timing

This lesson includes the following sections:

• Lesson Objectives, on page 98

• Lecture Notes, on page 99

• Activity 1: Experimenting with Space and Time, on page 103

• Activity 2: Drawing the Pendulum, on page 106

• Extra Activity 1: Animating the Playground, on page 111

• Extra Activity 2: Observation and Timing, on page 112
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Lesson Objectives

Total Lesson Time: One class
This lesson describes the basics of timing.

At the end of this lesson, you should be able to:

• Understand the concept of frames-per-second

• Understand arc and path of action

• Understand the affect of gravity on the action of an animated object

• Know the difference between ease-in and ease-out

• Know how changes in the exposure of a drawing affects the timing of an element

Activity 1: Experimenting with Space and Time 

Activity 2: Drawing the Pendulum

Extra Activity 1: Animating the Playground

Extra Activity 2: Observation and Timing

User Guide References
• Chapter 7 Layers and Timing

 Understanding the Timeline and Exposure Sheet Views, on page 174
 Layers and Columns, on page 180
 Navigating Between Frames and Columns, on page 202
 Managing Drawings, on page 204

• Chapter 8 Traditional Digital Animation

 Traditional Animation Tools, on page 210
 Animating Traditionally, on page 216

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 5 - Traditional Animation

 Light Table: 0:02:25
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Lecture Notes

In this lesson, you will find out about:

• The Importance of Timing in Animation, on page 99

• Arcs and Path of Action, on page 100

• Laws of Motion and Easing, on page 101

• Keyframes, In-betweens and Timing, on page 101

• Onion Skin, on page 102

• Further Reading, on page 102

• Further Viewing, on page 102

The Importance of Timing in Animation
• Timing is essential to the development of animation. Story development, gags, 

reactions and character development all depend on a clear sense of timing in 
order to be effective.

• Analyzing and establishing timing are a big part of the animation process. When 
you are developing the action of a character within a scene, you must determine 
how the character will move. For example, the difference in the way a character 
walks will be reflected by whether or not they are feeling dopey, hurried, 
energetic or lethargic. The timing will be used to influence the speed and rhythm 
of the movement.

• The physics of motion determines how objects move in the physical world. It will 
be hard to convince viewers to believe in your story and characters if your 
animation does not follow these basic laws of motion. Of course, exaggeration is 
essential in the animated world, but even exaggerated animated action must still 
follow the basic laws of physics.

• In North America (NTSC format), the frame rate of animated film is 24 frames/
second (fps). For animation mixed with live action, the fps is 30. In Europe it is 25 
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fps (PAL format). That means that at 24 fps, it takes 1,440 frames to create one 
minute of action.

• Note: For the purposes of this exercise, you will work at 12 fps, which is the 
minimum required for the persistence of vision to take effect.

 

Arcs and Path of Action
• The motion of living things does not usually progress in straight lines. Most 

action follows the shape of an arc; for example, throwing a ball, swinging a bat, 
or nodding the head all result in arc-shaped motions.

• The path of action is the direction that an action will follow. Think of a ball falling 
off a table and bouncing until it comes to a stop. The path of action helps map 
out the position of each drawing at each frame.
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Laws of Motion and Easing

• Newton‘s laws of motion apply in the animated world. Basically stated, objects 
do not move unless acted on by a force large enough to overcome their inertia. 
And when they are acted upon by a bigger force, they move or react in an equal 
and opposite manner.

• Acceleration due to gravity is constant. This causes falling objects to gain speed 
until they are acted upon.

• At the top of its arc, a pendulum’s velocity is slow, at the bottom it is high. This 
kind of speed change is referred to as ease-in and ease-out in animation. Ease-in 
means that the object is gradually picking up speed; ease-out means that the 
object is gradually slowing down.

Keyframes, In-betweens and Timing
• Keyframes are significant poses in a character’s action, such as the first and last 

positions in a jump.

Ease-in Ease-out

Acceleration

Keys

ABCDE
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• In-betweens are all of the drawings between the keyframes; they progress the 
action from one keyframe to another.

• The more drawings there are between keyframes, the slower the action will 
appear to take. This is because more drawings means that there is more time to 
complete the same action.

• In animation, space = time. The more space there is between drawings, the 
faster the action will appear to progress; the less space there is between 
drawings, the slower the action will appear. Basically, when two drawings are far 
apart, the time it takes to go between them appears shorter than the time taken 
to go between two drawings placed close together.

Onion Skin
The Onion Skin is used to preview the previous and next drawings. This feature is handy 
because it allows you to see the flow of a movement and lays it out in visible steps. By 
default, the previous drawings will appear with a shade of red and the next drawings will 
be displayed with a shade of green, but you can change the display options in the 
Preferences panel. 

Further Reading
The Illusion of Life: Disney Animation: Chapter 3: Principles of Animation

The Animation Book: Chapter 14: Line and Cel Animation

Further Viewing
Looney Tunes. Available on the Golden Collection Volume 1 and Volume 2, or via your 
local cartoon specialty TV channel. While watching the various films, play close attention 
to the use of comic timing and how it contributes to the momentum of the story.

Walt Disney’s Fantasia (1940). Here again, take note of the use of comic and dramatic 
timing in each segment. 

Slow Slow

Fast
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Activity 1: Experimenting with Space and Time
This exercise allows you to experiment with the effect of spacing on the timing of an 
animation.

Open Lesson 5a of the sample material in Toon Boom Studio and complete the exercise. 

Material Provided for this Lesson
The Lesson 5a sample material contains drawings of a ball as it rolls. Each layer displays 
drawings at different positions on the path of action to illustrate the effect that spacing 
has on timing. Only the “mechanical” layer is displayed by default. 

In the “mechanical” layer, each position of the ball is displayed over 21 frames. Use the 
drawings in this layer to experiment with spacing. 

The other layers show the different timing setups, so you should not look at them until 
you have finished your experiments.

Exercise: Experiment with Space and Time

,

1. In the Lesson 5a sample material, in the Playback toolbar, press the Play  button 
to look at the ball rolling. You will notice that it rolls at a constant speed.

2. In the Onion Skin toolbar, click on the Show Onion Skin  button. You can also 
enable the Onion Skin Feature from your top menu by selecting View > Onion Skin 

> Turn On Onion Skin. Next, set the Previous Drawings to 3  and the Next 

Drawings to 3  as well.

You will notice that all the ball drawings are distributed equally with the same 
amount of space between each of them.

3. In the Timeline view, duplicate the mechanical layer by right-clicking on the layer 
and selecting Duplicate Element. Rename the new layer Experiment01.
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4. In the Timeline view, select all the exposed drawings (green rectangles) of the 
Experiment01 layer and press the [Delete] key.

Note that all the drawings are still stored within the layer, they are just removed 
from the exposure.

5. You should disable the mechanical layer, or else it will be displayed in the Camera 
view.

6. In the Exposure sheet, double-click in the first cell of the Experiment01 column to 
make the cursor appear in the cell. Type in the number 1 to bring Drawing 1 into 
frame 1. Chose a random cell further down the column, right-click in it and from the 
pop-up menu, select Extend Exposure.

7.  Double-click in the cell that directly follows the cell that you selected in the 
previous step. Enter the number 21 to bring up Drawing 21. Choose a random cell 
further down the column, right-click in it and from the pop-up menu select Extend 
Exposure.

8. Return to the Timeline view, select the Experiment01 layer. 

9. Disable the Onion Skin option.  
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10.Then click the Play  button on the Interactive Playback toolbar to watch how the 
ball moves.

11.Clear the Experiment01 layer and duplicate the layer 3 times. Rename your layers so 
that you have Experiment01, Experiment02, Experiment03, 
Experiment04.

12.Try filling up the following exposures:

• Experiment01 (Choppy):

 

• Experiment02 (Ease-in/Acceleration):

 

• Experiment03 (Ease-out/Deceleration):

 

• Experiment04 (Anticipation):

 
13.After you have completed these experiments, show the rest of the elements in the 

scene and see how they resemble your experiments.

1 11 21

1 2 3 4 5 7 9 14 21

1 6 10 13 15 17 18 19 20 21

4 2 1 6 9 11 12 13 14 15 16 17 18 19 20 21
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Activity 2: Drawing the Pendulum

This exercise demonstrates the effects of gravity on the swing of a ball, as well as the 
spacing of the drawings in the action. Using the arcs, path of action and ease-in and 
ease-out concepts you learned about, create a new animation project in Toon Boom 

Studio.You should create your animation from scratch, using the Ellipse  tool to draw 
your circles. When you are done, compare your creation with the project in Lesson 5b.

Material Provided for this Lesson
The Lesson 5b animation set contains several elements required for the development of 
the pendulum. 

• Key: the keyframes in the pendulum’s action.

• Path-timing chart: the path of action for the pendulum.

• Pendulum: the final pendulum.
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Exercise: Drawing the Pendulum
In the Timeline view, rename the Drawing layer Path. 

1. From the Drawing Tools toolbar, select the Brush  tool and select a grey colour 
from the Colour Palette.

 In the Camera view, draw the path of action of a swinging pendulum.

 Draw a red stroke for each of the 3 key poses of the pendulum on the path of 
action. The mark should be positioned where you think the centre of pendulum’s 
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circle will be. 

 Place 8 more black strokes along the path of action, positioning the 8  
inbetween drawings of the animation. 

Map out the frame marks for the action, taking into consideration that there will 
be fewer drawings at the bottom of the pendulum’s swing and more at the top.
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2. To use your path drawing as a guide while drawing the animation, you will need to 
extend its exposure.  
To extend the exposure of a drawing in the Timeline view: 
 In the Timeline view, select the empty cell that is located at the point that you 

would like your drawing extended to.

 Right-click on that empty cell and from the pop-up menu, select Extend 
Exposure. 

 In the Timeline view, create a new drawing layer  and name it KeyPoses.

In the Camera view, draw the 3 pendulum keyposes in red on the same drawing, 
using the Path layer as a reference. Try to keep your circles the same size 
throughout the drawings or else the pendulum will look jiggly.

3. In the Timeline view, create a new drawing layer  and call it 
PendulumAnimation.

4. Animate the swinging pendulum in black in this layer. You can use the Auto Light 

Table  to see your Path and KeyPoses guide layers. Use the Onion Skin  to try 
to keep the proportion of your pendulum from drawings 1 to 11.

5. Once you are done, disable the KeyPoses and Path drawing layers, and playback 

 your animation!
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6.  Click on the Loop  button to make the pendulum swing back and forth 
continuously.

7. Do not forget to Save  your project.
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Extra Activity 1: Animating the Playground

Now that you have animated a swinging pendulum from scratch, how about taking it to 
the next level? Take the knowledge and skills you gained in the previous exercise and 
apply it to something else you know. What does it remind you of? How about a kid on a 
swing?

Using Toon Boom Studio, try animating a child on a swing.

• Use the Pendulum scene you created. 

• Add a new layer called Swing. 

• Disable the PendulumAnimation layer and use the Path layer to guide your 
animation. 

• Instead of a pendulum, draw a boy or a girl on a swing.

Don’t forget these key concepts!

• Path of action

• Key pose

• Ease-in

• Ease-out

• Keep proportion
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Extra Activity 2: Observation and Timing

Observation is key to good animation timing. Observe the people and things around 
you, noticing how they move. Practicing your sense of observation and visualization will 
improve your sense of timing enormously.

While observing moving things and people, try to look for these concepts:

• Ease-in

• Ease-out

• Anticipation
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With a teammate, use a stop-watch to observe and time the following actions:

• Jump in place:                                         

• A long jump:                                          

• One walking step:                                         

• Four running steps:                                          

• The first bounce of a dropped basketball:                                          

• The first bounce of a dropped tennis ball:                                          

• Making a complete circle with your arm:                                          

• Standing up on a chair:                                          

• Sitting on a chair:                                          

•  Choose your own action________________________:                                          

•  And another action ________________________:                                          

•  And another action ________________________:                                          
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Lesson 6: Squash and Stretch 
(The Bouncing Ball)

This lesson includes the following sections:

• Lesson Objectives, on page 116

• Lecture Notes, on page 117

• Squash and Stretch, on page 117

• Pose-to-pose vs. Straight-ahead Animation, on page 117

• Further Reading, on page 118

• Further Viewing, on page 118

• Activity: Animating a Bouncing Basketball and Bowling Ball, on page 119
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Lesson Objectives

Total Lesson Time: One class
Continuing our analysis of animated motion, we will now look at the concept of squash 
and stretch, then draw a bouncing ball.

At the end of this lesson, you should be able to:

• Understand how the material of an object can affect how it changes as it moves

• Know the difference between pose-to-pose and straight-ahead animation

• Draw a ball showing, discovering how it changes in shape as it falls, hits the 
ground and bounces back up

• Draw bouncing shapes with different material properties

Activity: Animating a Bouncing Basketball and Bowling Ball

User Guide References
• Chapter 8 Traditional Digital Animation

 Traditional Animation Tools, on page 210
 Animating Traditionally, on page 216

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 5 - Traditional Animation

 Light Table: 0:02:25
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Lecture Notes
In this lesson, you will learn about:

Squash and Stretch
Squash and stretch adds reality to the animated drawing, with more levels of action and 
emotion included in every action.

Consider these points:

• Living shapes are organic, therefor they do not progress from position to 
position rigidly. For example, smiling changes the shape of the cheeks, while 
bending an arm causes the muscles on either side of the elbow to change 
formation.

• Exaggeration: the more squash and stretch, the more cartoony the animation 
will feel.

• It is important to consider the composition of the object when squashing and 
stretching. 

• Volume must be conserved throughout the operation: you do not want your 
characters to gain weight every time they smile!

Pose-to-pose vs. Straight-ahead Animation
• Pose-to-pose animation is characterized by the process of first drawing your key 

poses at significant points in the action, refining the key drawings, and then 
doing the in-betweens. This process gives the creator more control and ensures 
the accuracy of the final result. This is how you worked when you created the 
pendulum animation. You started by creating your key poses!

• Straight-ahead animation is drawn from the first position to the last in a linear 
sequence. There is very little planning in this methodology, and where the 
character ends up and how it gets there can be a surprise for both the audience 
and the animator. While this approach is a lot more spontaneous and creative, it 
can create inaccurate results.

Normal Squashed Stretched
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Further Reading
The Illusion of Life: Disney Animation: Chapter 3: Principles of Animation

The Animation Book: Chapter 14: Line and Cel Animation

Further Viewing
Looney Tunes. Available on the Golden Collection DVD Volume 1 through Volume 5, or 
via your local cartoon specialty channel.
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Activity: Animating a Bouncing Basketball and 
Bowling Ball

The bouncing ball is the classic animation exercise, demonstrating not only squash and 
stretch, but also the effect of gravity and inertia on the spacing and timing of the 
animation.

In this exercise, you will experiment with basic squash and stretch and observe how the 
properties of objects affect how they move.

The ball moves fastest just before and after it hits the ground, and decelerates as it 
reaches the top of its arc.

The ball stretches as it gains speed, and then squashes on impact with the ground.

If the ball has the solid and rigid consistency of a bowling ball, the squash and stretch 
will be smaller. In reality, a bowling ball does not squash, but in animation, you need to 
add a little bit of squash and stretch in order to give a better illusion of movement and 
weight.

You should complete the exercise in a new project. When you are done, take a look at 
the material in the Lesson 6 sample material.

Material Provided for this Lesson
The Lesson 6 sample material includes a motion path and drawings for a bouncing 
basketball and bowling ball. A drawing of the motion path of a balloon is provided as an 
extra example for you to consider. 
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Exercise: Drawing a Bouncing Basketball and Bowling Ball
1. Take a moment to visualize the scene in your head:

• Visualize a basketball bouncing across the screen.

• Visualize how it bounces when it hits the ground.

• Visualize how many times it bounces and by how much the height of these 
bounces gradually decrease.

• Did you see the squash and stretch?

• Did you feel the ease-in and ease-out?

2. Create a new Toon Boom Studio project.

3. In the Timeline view, rename the Drawing layer as BasketPath.

4. From your Drawing Tools toolbar, select the Brush  tool and select a grey colour 
from your Colour Palette.

In the Camera view, draw the path of action of a falling and bouncing basketball. 
Draw a red stroke for each key pose. There should be one each time the ball hits the 
ground and one at the top of each bounce. The marks should be positioned at the 
center point of the ball at each position.

Place black strokes along the path of action, positioning the in-between drawings of 
the animation. Now is the time to determine the ease-in and ease-out.

5. In the Timeline view, extend the exposure of your path drawing in order to use it as 
a guide throughout the animation.

For a refresher on how to extend the exposure of your path drawing, refer to 
Timing > Activity 2: Drawing the Pendulum, on page 106.

6. In the Timeline view, create a new drawing layer  and name it BasketKey.

 In the Camera view, draw in red the key poses of your animation, using the 
BasketPath layer as a reference. Do not forget to apply the Squash and Stretch 
concept!

7. In the Timeline view, create a new drawing layer  and call it BasketAnimation.

8. Animate the bouncing basketball in black in this layer. Do not forget to use your 
BasketPath and BasketKey layers as guides and use the Onion Skin  tool located 
in your Onion Skin toolbar. Try to maintain the proportion of your basketball 
throughout the animation!

9. Once you are done, disable the BasketPath and BasketKey drawing layers, and 

playback  your animation. To disable a layer, in your Timeline view, click on the 
checkbox located to the left of your layer titles to uncheck it.
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10.Do not forget to Save  your project.

11.Repeat all the steps above for the bouncing bowling ball. A bowling ball will react 
very differently from a basketball due to its volume and weight.

The ball moves fastest just before and after it hits the ground, and decelerates as it 
reaches the top of its arc.

The ball stretches as it gains speed, and then squashes on impact with the ground.

If the ball has the solid and rigid consistency of a bowling ball, the squash and 
stretch will be smaller. In reality, the bowling ball does not squash, but in its 
animation, you need to add a little bit of squash and stretch to create a better sense 
of movement and the illusion of weight.
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Lesson 7: Anticipation, Drag and 
Overlapping Action

This lesson includes the following sections

• Lesson Objectives, on page 124

• Lecture Notes, on page 125

• Anticipation, on page 125

• Drag and Overlapping Action, on page 126

• Further Reading, on page 126

• Activity 1: Animating a Bouncing Ball with a Tail, on page 127

• Extra Activity: Waving a Flag, on page 130
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Lesson Objectives

Total Lesson Time: One class
In this lesson, you will start putting thought into a character’s actions, as well as continue 
on the analysis of motion, looking at how objects that are linked together, move 
together.

At the end of this lesson, you should be able to:

• Understand the notion and importance of anticipation in the planning and timing 
of an animation

• Understand how the motion of one object can affect the motion of objects to 
which it is linked

• Draw the motion of two objects, one linked to the other

Activity 1: Animating a Bouncing Ball with a Tail

Extra Activity: Waving a Flag

User Guide References
• Chapter 8: Traditional Digital Animation

 Traditional Animation Tools, on page 210
 Animating Traditionally, on page 216

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 5 - Traditional Animation

 Light Table: 0:02:25
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Lecture Notes

Anticipation, drag and overlapping actions help give a natural, realistic feel to your 
animation. Anticipation helps the viewer to understand what is coming next. Overlap 
and drag add fluidity to your work. Following is an introduction to these subjects.

Anticipation

• Actions in animation happen very fast. For example, throwing a ball can take 
only two or three drawings to complete, which is not enough time for the 
audience to see and grasp what is happening. However, if the character winds-
up and then pauses before the pitch, the events taking place become a lot 
clearer to the audience. Therefore, anticipation is an important element in the 
timing of any animation.

• Before a character takes any kind of action (unless completely surprised), the 
character must think and plan. A character that is about to jump might first 
crouch down low and then push off with its feet. Anticipation also gives insight 
into the thoughts of a character.

• Anticipation allows the audience to clearly see what a character is doing and 
understand what the character is planning, so that each action does not come as 
an abrupt surprise.

You might consider getting someone to demonstrate anticipation and resulting actions, 
or get into the habit of acting out, in front of a mirror, the action you want to draw.
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Drag and Overlapping Action

• Adding drag and overlapping action to your animations will go far in making 
them look less mechanical.

• When a fully developed character runs, not all of his body parts move with the 
same speed. The differing characteristics of various body parts or pieces of 
clothing, such as ears or a cape, might cause them to move behind the rest of 
the body. This is called “drag”. 

• When a character stops moving, not all of the body parts or the things your 
character is holding will stop at the same moment. The feet might stop first, with 
the ears and the cape continuing on until they reach the limit of their extension 
and then come to a stop. This is called “overlapping action”.

You can demonstrate this concept by thrusting out your arm with a light object in it, like 
a shirt or a piece of dangling fabric, and watch as it lags behind and then swings in front 
of your fist.

Further Reading
The Illusion of Life: Disney Animation: Chapter 3: Principles of Animation

The Animation Book: Chapter 14: Line and Cel Animation
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Activity 1: Animating a Bouncing Ball with a Tail
In this exercise, you will add life to a bouncing ball. Turn your ball into a character by 
adding an appendage that will drag and overlap during the course of the animation. It 
could be a tail, ears, a cape - you choose!

Material Provided for this Lesson
The Lesson 7 sample material contains two elements. 

• Path: the path of action. 

• Jumpball: a series of drawings animating the action of the ball-with-tail, 
anticipating the jump, jumping, landing, and with the tail behaving appropriately 
along the way.

Exercise: Drawing a Bouncing Ball with a Tail
1. Launch Toon Boom Studio.

2. In the Welcome Screen, name your project Ball_with_a_tail followed by your 
initials.

3. In the Timeline view, click the Add New Elements  button, then select Drawing in 
the drop-down menu. For a refresher on the Welcome Screen, refer to Animating 
Basic Shapes > Creating a New Project from the Welcome Screen, on page 67.

4. Rename both layers. The first layer should be named Ball, the second layer should 
be named Path.

5. Using the Brush  tool located in your Drawing Tools toolbar, draw the path of 
action for your character, including the timing in the Path element.

You now need to extend the exposure of the path drawing you just did.
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6. In the Timeline view, click on the drawing cell, then right-click and select Extend 
Exposure. 

The Extend Exposure window will appear.

7. In the Extend to Frame field, type 24. This is the number of frames you want to 
extend the cell to. 

8. Click on OK.

9. Using the Brush  tool located in the Drawing Tools toolbar, draw the keyposes for 
your character in the Ball element. Start by drawing the ball, then draw the tail.  
Remember, because of the overlapping action, the tail will be dragged along by the 
ball and should be animated to show this.

10.Activate the Show Onion Skin  option located in your Onion Skin toolbar.  
This will allow you to see the previous and next frames of your animation so that you 
can draw the in-betweens.

11.Play back the animation of the bouncing ball-with-tail with the Play  button 
located in the Interactive Playback toolbar and test/correct your work. You can also 

1 2

3 4
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activate the Loop  button to view your animation in loops while taking note of 
the corrections you would like to make. 

When you start an overlapping animation, remember that an element like a tail will 
not start moving before the ball has moved a couple of frames. 

When you reach the middle of the animation, the ball will reach the acme of its 
ascension, then start to slow down. As the ball begins to turn downwards again, you 
can exaggerate the speed it is about to pick up by pushing the volume of the tail to 
the end while keeping the same position on the guide.

At the end of the animation, the ball will stop moving, but the overlapping 
animation of the tail will continue until it drops to the floor.
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Extra Activity: Waving a Flag

Here is another exercise that requires overlapping movement and follow through: 
waving a flag!

• Try to animate this movement as a cycle.

• Remember that the flag is being pulled by the stick. The fabric is soft, so there 
will be a delay between the two elements.

• If you are unsure of how to do it, wave a real flag to use as reference, or have a 
classmate wave a flag and study how it moves.

• Always start with keyposes, then do in-betweens.

• Do you think you could animate a pattern on the flag?
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Lesson 8: Character Design and 
Construction Sheet

This lesson includes the following sections:

• Lesson Objectives, on page 132

• Lecture Notes, on page 133

• Activity 1: Drawing a Character Construction Sheet, on page 138

• Activity 2: Expanding the Design of the Character, on page 144

• Extra Activity: Deconstructing a Character, on page 150
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Lesson Objectives

Total Lesson Time: Three classes
In this lesson, you will build a character that you will use in the lessons that follow.

At the end of this lesson, you should be able to:

• Deconstruct a character into basic shapes

• Maintain the proportions of the character

• Create a character construction sheet

Activity 1: Drawing a Character Construction Sheet

Activity 2: Expanding the Design of the Character

Extra Activity: Deconstructing a Character

User Guide References
• Chapter 4 Drawing and Design

 Relative Sizes of Characters and Props, on page 70
 Sketching, on page 72
 Tracing, on page 74
 Pen View, on page 79
 Drawing Invisible Lines, on page 83
 More Drawing Tools, on page 87
 More Drawing Options, on page 94

• Chapter 5 Adding Colours

 How to Paint, on page 104
 Colours, on page 105
 Colour Display Modes, on page 118
 Using the Painting Tools, on page 119
 Closing Gaps, on page 123
 Selecting a Colour in a Drawing, on page 126
 Editing Gradients and Textures, on page 127
 Palettes, on page 130

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 3 - Creating Content

 Colour Palettes: 0:02:52
 Textures: 0:01:16
 Strokes features: 0:02:53
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Lecture Notes

Character construction is a huge topic to cover all at once. You might want to look at 
stills from animations as examples for you to deconstruct and use as a basis for your own 
character design.
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Character Design
When designing a character, make sure that you keep the following concepts in mind:

 

 

Consider the nature of your character and 
think about how his or her characteristics 
will be made visible in their shape. Think 
about outstanding characters in animation 
and how their physical form (Popeye’s big 
forearms, Superman’s big chest and strong 
jaw) played a role in the development of 
their character.

Head height: a character’s size is usually 
recorded in units of “heads”. Use these 
guidelines to keep the character in proportion:

• A short character is three heads high.

• A tall character is six heads high.

• This character is four heads high. His 
torso is proportionate to his legs, and 
his arms are slightly longer than his 
torso.

Be mindful of using proportion 
correctly. You can bend the rules 
of proportion only when you 
understand the basics of 
proportion correctly.
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These are the six basic steps in character design:

• Research

As part of your research, seek out pictures and references that will help you 
figure out how your character will look, based on the characteristics you have 
compiled. 

• Skeleton

Starting with the skeleton design helps you determine how your character 
should move, and if the main proportions of its body and limbs are in proportion. 
Using the skeleton, you will later be able to determine with ease the poses your 
character can assume, and quickly sketch them when planning an animation.

• Construction

The construction is the very basis of your character. It will ensure that the 
proportions and shape are strong!

• Sketching

A sketch is a rough version of your design. When you sketch a rough version of a 
new design for a character, you can produce whatever you imagine without 
being concerned about the final look of your lines. Making a rough version of 
your character helps you build a solid shape base and come up with new design 
ideas. 

• Tracing

Once you have sketched a rough version of your design, the next step is to trace 
it. Tracing lets you determine the final look and line style of your drawing, as well 
as refine its features.

• Adding Colours

Once your clean design is done, you can add colours to it. This step is both fun 
and interesting. You can conduct colour research, choose which colours best fit 
your character’s personality and play with the many possibilities!
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Character Model Sheets

Once a character is designed, model sheets are created for it. The character construction 
sheet will serve as your guide and your team’s guide, in the event you are working with 
other animators.

Character model sheets are the authoritative reference for a character. They show the 
character from all angles, in a variety of poses, and with a bunch of different expressions 
(happy, sad, surprised, shy, etc.). These expressions reveal a lot about your character’s 
personality.
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Relative Size of Characters and Props

Once your characters, accessories and props are designed, a “Line up” is created so that 
everyone on the team is aware of the difference in size between the various characters 
and objects. This ensures that the characters and props stay in proportion from scene to 
scene and that there is an interesting variety in the size and shape of the various 
elements in your animation.

Further Reading
The Animation Book: Chapter 14: Line and Cel Animation

The Illusion of Life: Disney Animation: Chapter 15: Character Development
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Activity 1: Drawing a Character Construction Sheet
You will now start the character design process. You will begin by designing a character 
with a minimal amount of detail; you should only work on the body shape using the basic 
shapes.

Material Provided for this Lesson
The Lesson 8 sample material contains three elements: 

• Construction drawing: drawings that break apart two characters, each into their 
basic shapes. 

• Full drawing: shows the characters with a bit more development. 

• Character design: shows the development of a character we will use to illustrate 
the rest of the exercises in the lesson.

Exercise: Designing a Character

Step 1: Imagine a Character

Take a few moments to imagine a character you could draw! Think of its personality, its 
physical attributes and even a situation in which it could be involved. 

If you want, take a piece of paper and quickly sketch some ideas. 

Be imaginative! 

Step 2: Drawing a Skeleton Foundation

In a new Toon Boom Studio project, begin by drawing the skeleton of your character. 
Think here about the proportions of your character.

Drawing the skeleton:

1. Create a new Toon Boom Studio project.

2. In the Drawing Tools toolbar, select the Brush  tool.
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3. In the Pen view, customize the Brush tool:

4. In the Colour Palette view:

a Using a Pen tablet, the Brush tool will 
work like a real paint brush on a paper 
and, depending on the pressure you 
apply to the tablet, produce thin or 
thick lines. Use the Minimum and 
Maximum fields to set this tapering 
effect. 

b You can automatically smooth your line 
as you draw it. Set the level of smooth-
ness you wish to apply. The higher the 
value, the smoother your lines will 
appear.

c The Brush tip preview menu allows you 
to choose from a variety of tip styles to 
produce different shaped lines.

A

B

C

a Click on a Colour to select it. 

b You can double-click on a colour to 
modify its tone or select a new colour 
entirely using the Colour Picker view.A

B



140 

Toon Boom Studio Art Curriculum - Student Guide

3. In the Camera view, sketch your character’s skeleton.

 If you need to, use the Eraser  tool. You can customize it using the Tools 

Properties view, just like you did with the Brush  tool.

4. Save  your project!

Step 3: Adding Basic Shapes and Volume

Once you have your skeleton ready, you need to add some flesh around the bones! You 
are now going to build the basic shape of your character.

Adding basic shapes and volume:

1. In the Timeline view, click on the Add Drawing Layer  button to add a new 
Drawing layer.

2. Double-click on the name field of your Skeleton layer to rename it Skeleton. Do 
the same for the new layer that you just created and name it Volume.

3. Right-click on the Skeleton layer and from the pop-up menu, select Lock > Lock. 
The name of the layer will turn red. Locking the layer will prevent any accidental 
changes from being made to it.

4. In the Timeline view, select the first cell of the Volume layer.
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5. Enable the Light Table  option located in your Onion Skin toolbar, then draw 
shapes and volumes around your skeleton.

 

6. You can use the Rotary Table to rotate your workspace in the same way that you 
would rotate a sheet of paper you were tracing on: 

 Press and hold [Ctrl]+[Alt] (Windows®) or [Ctrl]+[] (Mac OS® X) to display the 
rotary table and then click and drag inside the Drawing or Camera view to rotate 
the workspace. 

 Select View > Reset Rotation or press [Shift]+[C], the default keyboard shortcut.

7. Save  your project!

You will notice that the skeleton 
drawing will appear faded. In this way, 
you can use it as a guide, but it will not 
distract you from your new drawing.
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Step 4: Drawing Different Poses

Now that you have created the basis of your character, try giving it a little life! Imagine 
it in different situations and draw these poses.

1. Click on the Onion Skin  button located on your Onion Skin toolbar. This will 
enable the Onion Skin.

2. In the Drawing view, draw the skeleton in a new pose.

3. In the Timeline view, select the next cell of the Skeleton layer, and trace another 
skeleton pose in the Drawing view. Repeat this until you have at least five poses.

This will let you see your 
previous drawing in pale red. 
Use it as a guide to make sure 
you maintain your 
proportions.
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4. Once you have your five poses ready in the Skeleton layer, use the knowledge you 
have acquired in Step 3: Adding Basic Shapes and Volume, to draw the poses with 
volume in the Volumes layer.

5. Save  your project!
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Activity 2: Expanding the Design of the Character
Now that you have developed and experimented with the basic construction of your 
character, it is time to add the details of the character’s features. This is a fun activity to 
do, so go ahead and be inventive!

Step 1: Sketching the Character
The first step is to sketch the character’s features. It is important to start with a rough 
version, as it releases you from the constraint of trying to achieve the perfect line on the 
first stroke. 

Starting with a sketch produces better results at the final stage of the character design, 
allowing you to create more organic lines and volumes, with less stiffness.

Sketching your character:

1. In the Timeline view, add a new Drawing layer and call it Sketch.

2. In the Timeline view, you can hide the Skeleton layer if you want. Just click in its 
Enable/Disable Layer check box. 

3. Lock the Volume layer by right-clicking on it and selecting Lock > Lock.
4. In the Timeline view, select the first cell of the Sketch layer.

5. From your Drawing Tools toolbar, select the Brush  tool.



Lesson 8:  Character Design and Construction Sheet

145

6. In the Drawing view, sketch you character and its features using the volume drawing 
as a guide.

7. Save  your project!

Remember that you can use the Rotary Table to turn your 
workspace around!

Be careful to follow and respect your Volume layer!
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Step 2: Tracing the Character
Once you are satisfied with the sketch of your character, it is time to clean it up! During 
this step, the quality of the line is very important. You have to trace it carefully, as you 
want your character to be as clean as possible.

Tracing your character: 

1. In the Timeline view, add a new Drawing layer and call it Clean.

2. You should hide all the unnecessary layers and keep only the Sketch and Clean 
layers visible. Lock any layers that you deem necessary by right-clicking on them and 
selecting Lock > Lock.

3. In the Timeline view, select the first cell of the Clean layer.

4. In the Drawing Tools toolbar, select the Brush tool. 

5. In the Drawing view, start tracing the character.

 

Remember that you can use 
the Rotary Table to turn your 
workspace around.
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6. Once you are comfortable using the Drawing tools, you can improve your line art 

using the Contour Editor  tool! The Contour Editor tool is located in your 
Drawing Tools toolbar.

• In the Camera view, click on the line to reshape it.

• Select one or several points by clicking on, or circling around, them. 

• To modify the shape, you can:

 Pull on the Bézier handle. Both point’s handles will move as one. 
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 Hold [Alt] down and pull on one of the Bézier handles. The point’s handle will 
move independently from the other one. 

 Move the selected points to a new area. 

 Pull directly on the line in-between two points. No selection is necessary. 
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 If an anchor point has no visible Bézier, hold down the [Alt] key to access 
them.

7. Save  your project!
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Extra Activity: Deconstructing a Character

Character construction is a huge topic to cover all at once. In order to improve, you need 
to put in a lot of practice and observation time.

You might want to look at stills from animations as examples that you can deconstruct 
and use as a study for your own character design.

Find and deconstruct at least one character for each of these types:

• Animal and Human

• Man and Woman

• Elder and Kids

• Hero and Villains

• Big and Small

• Short and Tall
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Lesson 9: Animating a Jumping 
Character

This lesson includes the following sections:

• Lesson Objectives, on page 152

• Lecture Notes, on page 153

• Further Reading, on page 155

• Extra Activity: Jumping Around, on page 156

• Activity 1: Making the Character Jump, on page 157

• Activity 2: Animating a Four-legged Animal Jumping, on page 160
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Lesson Objectives

Total Lesson Time: Two classes
In this lesson, we will be reviewing many of the basic concepts previously covered. 
Prepare to do a lot of drawing!

At the end of this lesson, you should be able to:

• Draw key poses for the jump (squash, stretch, anticipation)

• Draw the in-betweens in a jump

• Draw clean-ups

Extra Activity: Jumping Around

Activity 1: Making the Character Jump

Activity 2: Animating a Four-legged Animal Jumping

User Guide References
• Chapter 8 Traditional Digital Animation

 Traditional Animation Tools, on page 210
 Animating Traditionally, on page 216

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 3 - Creating Content

 Full Screen Light Table: 0:01:23
 Colour Palettes: 0:02:52
 Textures: 0:01:16
 Strokes features: 0:02:53

• 5 - Traditional Animation

 Light Table: 0:02:25
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Lecture Notes
In this lesson, you will have the chance to further deconstruct the elements of motion as 
you draw your “character of basic shapes” jumping.

Throughout the lesson, you will have an opportunity to practice drawing your character 
in anticipation, and squash and stretch poses.

You may even consider jumping as a way to break down all of the elements involved in 
the jump, like the pre-jump crouch and the dragging arms. You can ask a friend to 
perform a jump for you, too, so you can observe all stages from beginning to end.

Deconstructing a Jump

The jump is another very common type of animation to do for a character. Just as we did 
with previous animations, we will take the time to review each key pose in the animated 
jump before you actually do the animation with one of your characters. Here is a break 
down of those poses:
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Anticipation

Push

 By now, you will have 
encountered anticipation in 
much of the animation you 
have seen. Before the 
character takes action, he will 
anticipate that action. This will 
be evident in the animation 
and you need to plan it out.

In the case of the jump, the 
character prepares himself with 
a good swing.

Anticipation

Push

The push is the opposite of the 
anticipation. Instead of 
crouching to take in the energy 
needed to jump, the character 
will now push it all toward its 
destination (in this case, he is 
jumping straight up).
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Stretch

Impact

Further Reading
The Human Figure in Motion features time-lapse photography images from the late 
1800s and early 1900s, depicting men and women performing various types of motions, 
such as walking, jumping, and turning.

The Illusion of Life: Disney Animation: Chapter 13: The Uses of Live Action in Drawing 
Humans and Animals

The stretch is that very 
moment where all the 
energy is released and the 
character is at its highest. 
Then, as the shown in the 
second image, gravity will 
begin to take effect, pulling 
your character downward.

Finally there is the moment of 
impact, when the character 
needs to squash again 
because of the weight of its 
body hitting the ground. 
Following the impact, he can 
get back up again.
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Extra Activity: Jumping Around

In this activity, you will act out a jump to gain awareness of all of the elements involved 
in the movements, such as crouching and arm and leg motion. Watch another classmate 
and observe how he jumps. Can you draw thumbnails of the keyposes of the jump 
animation after observing the jump? It will help you with the following activity.



Lesson 9:  Animating a Jumping Character

157

Activity 1: Making the Character Jump
This activity will be challenging and will take more time than the ones in previous lessons. 
It takes even the fastest animator with lots of experience a fair amount of time to 
animate a jump. You will probably spend most of your time looking at your own work, 
showing it to others and getting feedback.

Material Provided for this Lesson
The Lesson 9 sample material includes several elements that illustrate the process of 
developing a jumping character.

• Arc: the path of action of the jumping motion.

• Rough keys: the keyframes for the jump.

• Roughs: the entire jumping sequence, including the in-betweens.

• Clean: the final, cleaned-up drawings.

Exercise: Making Your Character Jump
1. First, you need to plan what type of jump the character will do. Is he running while 

jumping? Is he jumping over a rock? A fence? Or maybe he is jumping into 
something like a pool of water?

If need be, you might also plan the layout. Do you need any accessories for this 
scene? Or a background? 

2. Create a new project in Toon Boom Studio and name it Jump, followed by your 
initials.

3. In the Timeline view, click on the Add New Element  button to create a new 
drawing layer.
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4. For the jump, it is better to work with two layers: one for the character and one to 
create a guide. Rename one layer Character and one layer Guide.

Of course, if you determined that an accessory or a background was necessary, you 
also need drawing layers for each of these. Take the time to organize your scene.

5. To assist you in your animation, be sure to draw a guide that will tell you where your 
character needs to go.

You now need to extend the exposure of the guide cell drawing you just completed.

6. In the Timeline view, click on the drawing cell.

7. Right-click and select Extend Exposure. The Extend Exposure window will appear. 

8. Extend the cell to frame 24 and then click OK. 

Note that the number of frames needed will depend on the length of your 
animation. If you need more frames, you can further extend the exposure by using 
the same method.

9. Using the Brush  tool located in your Drawing Tools toolbar, start sketching the 
keyposes of the jump. 

Remember to draw with the basic figures of the character. Do not go into too much 
detail until you have sketched the entire animation. 
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Go with the following keyposes first:

• Anticipation.

• Push

• Stretch

• Impact

10.Activate the Show Onion Skin  option located in your Onion Skin toolbar. This 
will allow you to see the previous and next frames of your animation so that you can 
draw the in-betweens. 

11.Make sure to save the progress of your work by clicking the Save  button.The 
Save As window will appear. Name your project Jump, adding your initials.

12.Play back the animation of the jump with the Play  button located in your 
Interactive Playback toolbar and test/correct your work. You can also activate the 

Loop  button, in order to view your animation in loops while noting the 
corrections you will have to make.
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Activity 2: Animating a Four-legged Animal Jumping

This activity is a little trickier than the previous one. Instead of making a two-legged 
character jump, you will need to animate a four-legged animal. 

• A four-legged animal will have the same four key poses as a two-legged 
character:

 Anticipation
 Push
 Stretch
 Impact

• Study videos or pictures of animals jumping. Can you pinpoint the differences 
between how these animals jump and the way a human jumps?

• Remember to use a guide to plan out your animation.
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Lesson 10: Animating a Walk Cycle

This lesson includes the following sections:

• Lesson Objectives, on page 162

• Lecture Notes, on page 163

• Analyzing the Walk, on page 163

• Walk Cycles, on page 163

• Deconstructing a Walk Cycle, on page 164

• Further Reading, on page 166

• Further Viewing, on page 166

• Extra Activity 1: Walking Around, on page 167

• Activity: Making Your Character Walk, on page 168

• Extra Activity 2: How Do These Characters Walk?, on page 171
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Lesson Objectives

Total Lesson Time: Two classes
Movement analysis continues with the walk cycle.

At the end of this lesson, you should be able to:

• Analyze the walk of a character

• Design the walk of a character

• Draw a walk cycle

• Choose exposure times appropriate for the walk and the character

Extra Activity 1: Walking Around

Activity: Making Your Character Walk

Extra Activity 2: How Do These Characters Walk?

User Guide References
• Chapter 8 Traditional Digital Animation

 Traditional Animation Tools, on page 210
 Animating Traditionally, on page 216

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 3 - Creating Content

 Full Screen Light Table: 0:01:23
 Colour Palettes: 0:02:52
 Textures: 0:01:16
 Strokes features: 0:02:53

• 5 - Traditional Animation

 Light Table: 0:02:25
 Cycling Animation: 0:01:12
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Lecture Notes
In this lesson, you will find out about:

Analyzing the Walk

When animating anything, it is especially important to analyze the action before starting 
to draw. One way to do this is to act out different walks and study the details (e.g. arm, 
hand and head movement). 

• The walk-cycle is not just about the legs; the position of the rest of the body says 
a lot about the character, too. 

• Is the character bouncing, strutting, shuffling, or sneaking?

• What kind of mood is the character in? Hurried? Lazy? Happy-go-lucky? Furtive?

Walk Cycles

• Cycles are animation shortcuts that reduce the amount of required work. 

• A walk cycle usually consists of two steps that the animator reuses to create an 
extended walk. 

• During a walk cycle, the background is moved while the character essentially 
walks in place.
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Deconstructing a Walk Cycle
• At the contact positions, both feet are touching the ground — the heel of one 

foot and the toe of the other.

• At the opposite contact position (after one full stride), the legs swap positions. 
The feet of the first and second contact position should be the same distance 
apart.

• At the passing position, the two legs meet as they swap positions. The leg 
moving to the front is bent.

The right foot is in 
front. The heel and 
the toe are both 
touching the 
ground.

The left foot is in front. 
The heel and the toe 
are both touching the 
ground.

The left leg is bent as it 
passes the right foot.
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• Between the first contact position and the passing position, is the down 
position. In this position, the character is in the lowest position of the cycle, 
dropping down slightly from the previous and next drawings. In this position, the 
character’s hands are at their greatest distance apart.

• Between the passing position and the second contact position is the up position. 
The character appears extended here.

Both legs are bent, 
which makes the 
character appear 
slightly shorter.

The back leg is 
pushing up, so the 
character appears 
extended.
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Further Reading
The Human Figure in Motion features time-lapse photography images from the late 
1800s and early 1900s, depicting men and women performing various types of motions, 
such as walking, jumping, and turning. 

The Illusion of Life: Design Animation: Chapter 13: The Uses of Live Action in Drawing 
Humans and Animals

The Animation Book: Chapter 14: Line and Cel Animation

Further Viewing
Walking (a.k.a. En marchant), (1969). Ryan Larking's Academy Award® nominated short 
film produced by the National Film Board of Canada, features people walking, each in 
their individual way, from various angles. It makes use of the walk cycle and was not 
sketched over live-action footage to create the final animated sequence, the latter being 
a technique that can make the animation appear synthetic.
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Extra Activity 1: Walking Around

In this activity, you will team-up with a classmate to take turns walking around so that you 
can analyze each other’s walk. You should try different styles of walkings see how a 
character’s state of mind and their motivation will affect their manner of walking.

Share your observations and take note of them before starting your own walk-cycle 
animation.
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Activity: Making Your Character Walk

In this activity, you will draw the rough walk cycle of your character, followed by its clean 
up and colouring.

Material Provided for this Lesson
The Lesson 10 sample material includes three elements. 

• WalkAcross: the complete walk cycle, with the character moving across the 
stage.

• Clean: the character walking “in place.”

• Colour: the painted character.

Exercise: Making Your Character Walk
1. First, you need to plan your character’s walk. What is your character’s personality 

and how will it affect the way they walk and move? 

For example, a dancer would likely be light in their step and gait. However, a thief 
would be stealthy and may scurry furtively from one place to another. A hunchback 
would lurch to one side and walk in such a way that one foot would drag, or they 
would limp dramatically. 

2. Launch Toon Boom Studio by double-clicking on the icon.

3. In the Welcome Screen, name your project Walk_cycle, followed by your initials.

4. In the Timeline view, click the Add Element  button, then select Drawing in the  
drop-down menu.

5. For the walk-cycle, it is better to work with two drawing layers: one for the character 
and one for the measured distance between steps. Rename one layer Character 
and one layer Steps.
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6. To make a walk cycle where the character walks in place, you need to make a 
reference guide for the feet. This is so the feet do not look like they are jerking 
around, but rather gliding evenly from one position to the next. To do this:

a After drawing the first contact position, measure the distance between the 
character’s heel on the front foot and the toes of the back foot.

b Divide this distance by the total number of drawings between the first and sec-
ond contact positions.

c Mark these divisions on the Steps drawing element.

d Now you need to extend the exposure of the step cell drawing you just did. In 
the Timeline view, click on the drawing cell, then right-click and select Extend 
Exposure. The Extend Exposure window will appear.

e In the Extend to Frame field, type 24. This is the number of frames you want to 
extend the cell to, then click on OK.

Every time you draw a new position, no matter how the legs and knees are bent, 
one foot must incrementally move towards the front, while the other moves towards 
the back, one unit at a time. For one foot, you will be using the toes as a point of 
measure, while on the other foot, you will use the heel.

7. Using the Brush  Tool located in your Drawing Tools toolbar, start sketching the 
keyposes of the walk. Remember to draw with the basic figures of the character.  

Measure the distance between 
these two points.

Front footBack foot
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Do not go into too much detail until you have sketched the complete walk-cycle. 
Draw the following keyposes first:

• First and second contact position

• Passing position

• Down position

• Up position

8. Activate the Show Onion Skin  option located in your Onion Skin toolbar. This 
allows you to see the previous and next frames of your animation, so that you can 
draw the in-betweens. 

You can activate the Show Previous  and Show Next  options to include the 
frames you need in the onion skinning option.

9. Draw your characters next steps. Remember that the positions for the left and right 
legs will be switched in the second step.

A good trick is to modify the drawings from the first step to create the second step.

10.Make sure to save the progress of your work by periodically clicking on the Save 

 button. The Save As window will appear. Name your project Walk_cycle, 
followed by your initials.

11.Play back the animation of the walk-cycle with the Play  button located in your 
Interactive Playback toolbar and test/correct your work. You can also activate the 

Loop  button, to review your animation while noting the corrections you will 
have to make.
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Extra Activity 2: How Do These Characters Walk?

Now that you have animated a full walk-cycle, are you ready to tackle these fellows? With 
three other classmates, you will each choose one of these characters to work with. In 
what manner would your character walk? Act-out your character’s walk in front of the 
group. When you feel that you have analyzed the walk of your character long enough, 
animate it following the same steps outlined in the previous activity.

• Remember that you only need to do a walk-cycle.

• The walk should show the character’s personality. All four characters are very 
distinct, so be sure to evoke their unique qualities in the animation.

• Ask a classmate to act-out the walk you want to animate, so that you have a 
good references.

• Remember to start with the keyposes and then create the in-betweens.
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Lesson 11: Breaking Down a Character 
and Animating It

This lesson includes the following sections:

• Lesson Objectives, on page 174

• Lecture Notes, on page 175

• Further Reading, on page 176

• Further Viewing, on page 177

• Activity 1: Breaking Down a Character, on page 178

• Activity 2: Reattaching a Character’s Parts, on page 180

• Activity 3: Animating a Cut-out Character, on page 183
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Lesson Objectives

Total Lesson Time: One class
In this lesson, we are going to break a character down into several pieces, then rig it in 
order to animate it.

At the end of this lesson, you should be able to:

• Identify the main parts of a character to break it down

• Cut a character in pieces

• Attach a character’s limbs to the correct body part

• Create basic motions with a puppet

Activity 1: Breaking Down a Character

Activity 2: Reattaching a Character’s Parts

Activity 3: Animating a Cut-out Character

User Guide References
• Chapter 9 Creating a Cut-out Puppet

 About Building a Cut-out Puppet, on page 232
 Choosing Your Character, on page 233
 Cutting the Character into Pieces, on page 235
 Attaching the Pieces, on page 240
 Storing the Character in the Library, on page 247

• Chapter 11 Animating a Puppet

 Getting the Character From the Library, on page 280
 Understanding Keyframes and Drawings, on page 282
 Creating a Simple Cut-out Animation, on page 283

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 3 - Creating Content

 Full Screen Light Table: 0:01:23
 Colour Palettes: 0:02:52
 Textures: 0:01:16
 Cutter: 0:00:47
 Scissor and Lasso Tools: 0:01:07
 Strokes features: 0:02:53

• 8 - Cut-out Animation

 Using the Transform Tool: 0:01:56
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Lecture Notes

About Cut-out Puppets
The cut-out puppet principle is very similar to cutting up a character drawn on a sheet 
of paper and assembling it using little brass fasteners. You create a drawing for each of 
your character's body parts and then connect them in the Timeline view. Then, you can 
move the character at the joints and animate it by giving it a slightly different pose on 
each frame.

Character Selection
As you start building your puppet, the first thing you need to do is to select your 
character. If this is your first puppet, it is always best to choose a simple character. A 
simple character is a character with two legs, two arms, a head and a torso. To start with, 
avoid choosing a character with too much loose clothing, such as a cloak or baggy pants. 
Once you are used to constructing puppets, you will understand how to cut them apart 
and loose clothing not be as much of a challenge for you.
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About the Breakdown
 Before cutting your character into pieces, you must first decide which parts of the final 
character will need to move. 

If you are building your first puppet, start with a very simple breakdown. Most of the 
time, you will want to animate the arms, legs and head. It is not necessary to separate 
all the facial features from the head, or to break down the knees and elbows to get a 
working puppet. You can break the character into six pieces and it will still be enough to 
produce a nice animation.

It is up to you to decide if you would like to add more moveable parts to the puppet. 
You can divide the arms and legs at the elbows and knees, and separate the head into 
different pieces to animate the eyebrows and make the eyes blink.

Further Reading
The Animation Book: Chapter 5: Cutout Animation

Head

Left Arm

Body

Right Arm

Left Leg
Right Leg
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Further Viewing
Princes et Princesses (Princes and Princesses) (2000). This movie is animated with real 
paper puppets. Observe how the characters express their emotions even without the 
benefit of facial features. The body language is so well-executed that you understand 
everything that is happening to the characters. 

Angela Anaconda (1999-2000). This cut-out TV series is made out of digital photos. 
Examine how the photos were broken apart to built the puppets.
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Activity 1: Breaking Down a Character
In this activity, you will break apart the provided character and attach the pieces 
together to animate it. 

The objective here is to cut the character in a logical manner. The pieces should 
correspond to the character’s anatomy and movement of joints.

Material Provided for this Lesson
The Lesson 11a sample material contains two elements. 

• Character model: a turtle character to be broken down in pieces. 

• Character puppet: the final result of the character’s breakdown, which can be 
used to either demonstrate the final result or used to create an animation. 

Exercise: Breaking Down a Character
1. Open the turtle’s character model scene.

Using the Cutter , Brush  and Eraser  tools located in your Drawing Tools 
toolbar, break apart the character into pieces.

2. In the Drawing view, using the Cutter tool, trace a selection around the part to cut.

3. In the Drawing Tools toolbar, select the Select  tool.
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4. In the Drawing view, select the cut zone.

5. In the top menu, select Edit > Copy Drawing Object.

6. In the Timeline view, click on the Add Drawing Element  button and rename the 
new layer according to the new piece you want to create. 

7. On the right side of the Timeline view, select the new layer’s first cell.
8. Click on the Drawing view to activate it.
9. In the top menu, select Edit > Paste Drawing Object.

10.In the Drawing Tools toolbar, select the Brush  and the Eraser  tools to clean 

and complete your new drawing. Use your Brush  and Eraser  tools located on 
your Drawing Tools toolbar to clean and complete your character.
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Activity 2: Reattaching a Character’s Parts

In this activity, you will reattach the character’s pieces to animate it. To do so, you 
will connect your layers one to another in the Timeline view. Reattach the character’s 
limbs to the body by creating hierarchies in the Timeline view window. For example, 
attach the forearm to the arm and the arm to the body.

To attach a layer to another one, simply drag the layers one onto the other in the 
Timeline view.

To attach one layer to another one:

11.In the Timeline view, select the layer you want to attach to another one. For 
example, select the forearm layer to attach it to the upper arm.

12.Drag the selected layer ONTO the one you want to attach it to.
13.Once the layer is attached to another one, it gets pushed to the right and a 

Collapsing arrow appears.
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14.If the piece you connected is supposed to be in front of the layer it is attached to, 
you can push it to the front using a keyboard shortcut.

• In the Tools toolbar, select the Transform  tool.

• In the Camera view, select the part you wish to bring in front.

• Hold down the [Alt] key and press the [Down Arrow] key to nudge the drawing 
forward. Doing so moves the drawing very slightly forward. If you press on the 
key several times, the drawing will move forward even more. You can also use 
the [Up Arrow] key to send the drawing backward.

• Repeat the whole process until every piece is connected.
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To control your entire character without having to select all the body parts, add a Master 
Peg element and attach all the body parts to it.

This is a trajectory on which you attach your puppet to make it travel through your scene. 
It is also used when you want to scale the entire character up or down without doing it 
on each individual piece. For example, you could animate your puppet walking on the 
spot, then use the Master Peg to get it to move from left to right.

To add a Master Peg:

15.In the Timeline view, click on the Add Peg  button.
16.Double-click on the new Peg to rename it. Name it myCharacterName-Peg.
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Activity 3: Animating a Cut-out Character
In this activity, you will animate the character you broke down in the previous activity. 
You can also use the character provided.

The objective here is to get you to reproduce a simple movement with the cut-out 
puppet.

Material Provided for this Lesson
The Lesson 11b sample material contains two elements. 

• Character puppet: the final result of the character’s breakdown, which can be 
used as an example of how the final result will look, or used to create an 
animation. 

• Simple animation: shows an example of what a simple cut-out animation looks 
like.

Exercise: Animating a Cut-out Character
1. Open the turtle’s cut-out puppet scene.

2. Using the Transform  tool, animate a simple motion such as an arm wave, a jump 
or a kick.

a In the Timeline view window, go to the first frame.

b In the Camera view window, position your character.

c In the Timeline view window, go to a further frame and add a keyframe.

d In the Camera view window, set the character’s second position.

e Repeat the same process for all the character’s positions.

f You can transform your keyframes into non-constant keyframes if you want Toon 
Boom Studio to automatically animate the positions in-between your poses.
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Lesson 12: Bone Animation

This lesson includes the following sections:

• Lesson Objectives, on page 186

• Lecture Notes, on page 187

• Activity 1: Rigging the Skeleton, on page 190

• Activity 2: Animating a Skeleton Rig, on page 199

• Extra Activity: Experimenting with Bone Animation, on page 204
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Lesson Objectives

Total Lesson Time: One class
In this lesson, we are going to break a character down into several pieces. Using Bone 
Animation, we will then rig the character to animate it.

At the end of this lesson, you should be able to:

• Identify the main parts of a character to break it down

• Cut a character in pieces

• Attach a character’s limbs in the correct hierarchy using the Bone Animation 
tools.

• Create basic motions with the puppet

Activity 1: Rigging the Skeleton

Activity 2: Animating a Skeleton Rig

Extra Activity: Experimenting with Bone Animation

User Guide References
• Chapter 10 Bones

 About the Skeleton Effect, on page 250
 Choosing Your Character, on page 253
 Building the Skeleton, on page 255
 Animating the Skeleton, on page 266
 Skeleton Effect Properties, on page 275

Basic Training Video Recommended
If you own the How to Create Bone Animation video set, here are the suggested video 
chapters for this lesson:

• Bone Animation Tutorial Set

 Introduction and Interface Tools: 0:09:17
 Setting Up a Bitmap part I: 0:11:26
 Setting Up a Bitmap part II: 0:13:40
 Setting Up a Vector Cut-out: 0:15:59
 Extras: 0:13:58
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Lecture Notes

The Bones feature allows you to create a skeleton over your character by using the 
different Bone tools. You can then animate the skeleton and the bitmap, or vector-based 
pieces, will move with it. The skeleton has capabilities beyond a real skeleton: you can 
even use the bones to squash and stretch the linked images! 

About the Skeleton Effect

The Skeleton effect is used to create an animatable bone structure in a character or 
design. The structure will let you bend a limb, automatically creating a joint with a 
distortion of the artwork, such as in the arm example above. The arm is drawn straight 
on a single flattened drawing, and the skeleton effect automatically creates the elbow 
joint.

When you animate the arm bending, keyframes will the automatically be created in your 
Timeline. Just continue moving the red playhead across to a different frame before 
making the next movement.



188 

Toon Boom Studio Art Curriculum - Student Guide

Character Selection
Before building your skeleton, the first thing you need to do is prepare your character. 
If this is your first puppet, the same holds true as when building a cut-out puppet; it is 
always best to choose a simple character. A simple character has two legs, two arms, a 
head and a torso. As with a cut-out puppet, you should avoid a character with loose 
clothes, such as a cloak or baggy pants.

You can either draw your character using the tools in Toon Boom Studio, or you can take 
one from the Library. If you choose to draw your character, remember that you should 
draw the character whole before cutting it up, so that you have an easier time keeping 
the character in proportion. For simplicity’s sake, we will not get into bitmap images just 
yet.

Planning the Breakdown
To cut up your character into pieces, you must first decide which parts of the final 
character will move.

If you are building your first puppet, start with a very simple breakdown. Most of the 
time, you will want to animate the arms, legs and head. For the example above, the head 
will move just as well if it remains attached to the body. It is not necessary to separate 
all the facial features from the head or to break down the knees and elbows to get a 
working puppet. You can break the character into five pieces and it will still be enough 
to produce a nice animation.

Head and Body

Left ArmRight Arm

Left Leg
Right Leg
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Preparing the Image Layout
When laying out the various parts of your character, it is recommended that the parts be 
spread out with some space between them. This is to ensure clean movement between 
pieces.

In this example, we see what might happen to a character whose limbs are overlapping 
(Figure A), versus one whose limbs were separated during setup (Figure B).

FIGURE A. In this example, the character's shoulder was overlapping the body at 
setup. Therefore, animating the shoulder will also move any part of the torso that was 
included in the influence area. 

FIGURE B. Here the character's shoulder was not overlapping the torso during setup, 
so no part of the torso will be influenced by the animation of this bone.

You can lay out the character’s parts on the same drawing layer, or separate the different 
parts, so that each is on a different drawing layer. Having each part on a separate layer 
simplifies the ordering process later.

Distortions to the artwork during animation occur due to the pull from the Regions of 
Influence, which will be explained later on. The artwork of the body will be pulled 
together with the assemblage of the skeleton, also to be explained in the first activity.  

Bad Good

FIGURE A FIGURE B

Note the distortion here... ...but not here
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Activity 1: Rigging the Skeleton
In this activity, you will break apart the character and reattach the pieces using the Bone 
Animation tools. 

The objective here is to cut the character in a logical manner. The pieces should 
correspond to the character’s anatomy and movement of joints.

Material Provided for this Lesson
The Lesson 12a sample material contains two elements:

• Character model: a Skeleton Pirate to be broken down into pieces.

• Character puppet: the final result of the character’s breakdown, fully rigged with 
a skeleton, which can be used as an example of the final result and/or used to 
animate in the second activity.

Breaking Down a Character
1. Open the Skeleton Pirate’s character model scene.

2. Using the Cutter , Brush  and Eraser  tools, break apart the character in 
pieces. The Cutter tool is located under your Eraser tool: Drawing Tools > Eraser > 
Cutter.
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Building the Skeleton 
Once your character design is ready, you can start building the structure of the puppet’s 
skeleton.

Setting Up the Timeline 
To create the skeleton for a puppet, you must first add a Skeleton Effect in your Timeline 
and connect your character’s artwork to it.

To add a Skeleton effect:

1. In the Timeline view, click on the Add New Elements  button.

The New Elements dialog box opens.

2. From the Type drop-down menu, select Skeleton Effect.

3. In the Name field, give a name to the Skeleton Effect element.

4. Click on the OK button.

The Skeleton Effect appears in your Timeline view.
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5. Drag and drop the drawing layer containing your character onto the Skin Group. 
This is where you connect any art layer that you want to be influenced by the bones.  
Make sure to drop the drawing layer directly on the Skin Group to parent them.

If your character’s parts are drawn on different elements, make sure to parent all the 
drawing elements to the Skin Group.

Once layers are parented in the Timeline view, you can click on the blue triangle icon to 
collapse or expand them. You will find this option useful when the Timeline view 
becomes filled with layers.

Adding Bones 
Once you have added a Skeleton Effect in your Timeline view and connected your 
character drawing layers to it, you can start adding bones.

When creating your bone structure, think about where you want the limb to bend. In the 
drawing below, it is quite obvious as there are three bones and two joints, the elbow and 
the wrist. Sometimes it is less obvious and often there is no one right way.

To add bones to your character:

1. Make sure you are working in the Camera  view.
2. In the Timeline view, select the Skeleton Effect top layer.

3. From the Bone Tools toolbar, select the Bone Creator  tool. You can also use the 
keyboard shortcut [U].

Expanded Collapsed

Arm Forearm Hand

Wrist

Elbow
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4. In the Camera view, click and drag to create the first bone, following your character 
design.

If you do not position the bone perfectly the first time, you can fix it later using the 

Bone Setup  tool.

5. Once you create a bone, it is automatically selected. A selected bone appears red in 
colour. The next bone you create will automatically be linked and parented to the 
currently selected bone. This creates a chain linked by a joint.

As you create more bones, you will notice that a new bone layer is automatically 
added in the Timeline view, under the Bone Group, for each new bone that is 
created. You can see the different hierarchies created.
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6. Once you have created the bone structure for the first limb in the Timeline view, 
select the top layer of the Skeleton Effect before creating any bones for the next 
limb. This will ensure that the bone chain for the next limb is connected to the main 
group and not a subgroup. Then, repeat Step 4 and Step 5 until a bone structure is 
created for each of the body parts.

Once the character’s bone structure is complete, note how the bone chain for each of 
the body parts are independent from one another. In the next exercise, we will take a 
look at assembling the skeleton.

Assembling the Skeleton 
Once you start creating bones you can, at any time, modify them in setup mode to 
optimize their positioning without creating an animation. Influence areas also have to be 
established before the skeleton can be assembled.

Modifying bones using the Bone Setup tool:

1. From the Bones Tools toolbar, select the Bone Setup  tool. You can also use the 
keyboard shortcut [J].

2. In the Camera view, select the bone you want to modify. 

The selected bone becomes red and two control handles appear.
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3. Rotate, shorten, lengthen or move the position of the selected bone to make it fit 
more optimally over the drawing.

 You should only reposition the first bone of the chain (parent) to avoid creating 
gaps in your joints that could result in an unwanted distortion of the art.

 Setting the Influence Area 
The influence area is the zone around a bone that defines which part, and how much of 
the associated artwork, will move with it. It can be either Elliptical or Infinite, but for this 
lesson we will use only the Elliptical zone.

The region of influence overlaps with artwork pertaining to another body part, not just 
that of the arm. This means that when the arm rotates, it will also rotate the artwork of 
this other body part.
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Modifying the Size of the Influence Area

When an influence area is elliptical, you can modify the size and shape of this ellipse by 
controlling the width and length radii.

To set up the influence area using the Bone Influence tool:

1. From the Bone Tools toolbar, select the Bone Influence  tool.
2. In the Camera view, select the bone to which you want to modify the influence area.

The selected bone appears as red and a black bounding box is displayed around the 
influence area. 

3. Click and drag the handles to resize the influence area.

You can also modify the influence area of a selected bone by using the Properties view.
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Parenting Bone Chains 
Once you create the bone structure for your character’s limbs and body you can connect 
them all by parenting them. This unifies the character and, if you want, allows the limbs 
to follow the movements of your character’s body.

1. From the Bone Tools toolbar, select the Bone Parent  tool.
2. In the Camera view, locate the bone that is the starting point of the limb you wish to 

parent to another chain. In this example, it is the first bone in the arm bone chain.

3. Click on the base of the bone you that you want to parent to another, then drag the 
cursor to the bone to which you want to parent it.You will notice a red arrow 
pointing in the direction of the drag. This means that it is ready to connect to the 
selected bone.

4. Release the mouse to complete the connection.
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5. Repeat Step 2 through Step 4 until all your limbs are parented to the body.
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Activity 2: Animating a Skeleton Rig
Once you have finished creating your character’s skeleton, it is time to switch to the 
Bone Manipulator tool, reconnect the limbs to the body and animate it.

In this activity, you will animate the character you broke down in the previous activity. 
You can also use the character provided in the sample material.

The objective is for you to reproduce a simple movement using Bone Animation.

Material Provided for this Lesson
The Lesson 12b sample material contains: 

• Simple animation: shows an example of what a simple Bone animation looks like 
with the final result of the character’s breakdown.

Assembling the Character 
The first step is to reassemble the character so that the limbs do not appear spread 
apart, as in Setup mode.

To assemble the character:

1. From the Bone Tools toolbar, select the Bone Manipulator  tool.

Notice that the Camera view has changed to animation mode display.
2. In the Timeline view, make sure that the red marker is at the first frame.
3. In the Camera view, select the main bone of one of the limbs.
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4. Use the square handle to drag the bone chain to the desired position.

A keyframe will be added to the limb’s bone layer on the first frame, locking its 
position in time.

5. Repeat Step 3 and Step 4 for each limb you need to assemble to the body.

6. Look for limbs that do not appear in the correct order: for example, an arm that 
appears under the body when it should appear in front.

7. You need to reorder these parts, but the ordering method will differ depending on 
whether your character is on a single drawing layer, or if its pieces are separated on 
several drawing layers.
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a Character on a Single Drawing Layer 
 In the Timeline view, select the layer you need to reorder.
 Drag the Bone element to the desired position within the Bone Group. Be 

careful to drop it in-between existing bone element hierarchies, as opposed 
to dropping it on one, as this will parent them.

Note that the ordering of the Bone elements in the Timeline view is the 
opposite of the other elements. The higher the bone element is in the 
Timeline ordering, the further back it will appear in the Camera view. 

b Character with Limbs on Different Drawing Layers 
 In the Timeline view, select the layer you need to reorder.
 Drag the layer to the desired position within the Skin Group. Be careful to 

drop it in-between layers, as opposed dropping it on a layer, as the latter 
would parent it to that layer.

The ordering of the Drawing elements in the Timeline view works as follows: 
The higher the drawing element is in the Timeline ordering, the closer it will 
appear to the front in the Camera view.

Animating Bones 
Now that the Skeleton puppet is ready, you can start animating it.

To animate bones:

1. From the Bone Tools toolbar, select the Bone Manipulator  tool.
2. In the Timeline view, go to the frame from which you want to set the first pose of 

your puppet.
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3. In the Camera view, select the bone you want to animate.
4. When a bone is selected you can:
 Use the square handle to drag the selected bone to a new position. Note that 

this handle is only available on the parent bone of a chain.

Repositioning a bone will create a square black keyframe marker in the Timeline 
view, on the layer of the selected bone.

 Use the circle handle to squash and stretch the bone.

Scaling a bone will create a downward pointing, black arrow keyframe marker in 
the Timeline view, on the layer of the selected bone.

 Click directly on the bone and drag the cursor to rotate it.

Rotating a bone will create a small upward pointing, black arrow keyframe 
marker in the Timeline view, on the layer of the selected bone.

keyframe marker
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A keyframe is created in the Timeline view. If the Skeleton Effect is collapsed, note 
that you will not see the keyframe marker.
 If you expand the puppet’s elements by clicking on the arrow next to the master 

peg element, you will notice a red square on the parent element of the bone you 
moved. This indicates that a child of this bone has a keyframe.  

5. In the Timeline view, go to the frame from which you want to set your second 
keyframe.

6. In the Camera view, animate your character.

    
7. If you want to record your character’s current position for every body part: in the 

Timeline view, collapse your Skeleton Group layer, then select the frame from which 
you want to block your puppet’s position.

8. Add a keyframe by selecting Element > Peg > Add Keyframe, or by using the 
default keyboard shortcut [I].

If you uncollapse the layer, you will see that a keyframe now appears on every layer 
in the Skeleton Group.

9. Repeat this process until all your poses are done.
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Extra Activity: Experimenting with Bone Animation

Now that you understand how to use bones in the most conventional and standard way, 
it is time to think outside of the box. Bones can be used for non-humanoid objects and 
characters. For example, in the image above, bones were used to make a lighting bolt 
contract and then explode, as well as extend and crack.

Try experimenting with Bones by drawing, then rigging, some of the following objects:

• Octopus’s tentacle wriggling

• Bird’s wing flapping

• Flower blooming

• Mouth smiling

• A catapult flinging a boulder

Think of a few examples of your own. Heighten the challenge by using bitmap images 
instead of vector drawings created in the software.
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Lesson 13: Stop-Motion Animation

This lesson includes the following sections:

• Lesson Objectives, on page 206

• Lecture Notes, on page 207

• Further Reading, on page 212

• Further Viewing, on page 213

• Activity: Animating Figurines, on page 214
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Lesson Objectives

Total Lesson Time: Two classes
In this lesson, we are going to animate toys and figurines by taking a series of pictures 
of them in different poses.

At the end of this lesson, you should be able to:

• Break apart a motion and analyze the number of poses required

• Create a movie with figurines and toys

Activity: Animating Figurines

User Guide References
• Chapter 13 Stop-motion Animation

 Characters and Stage, on page 324
 Image Capture Settings, on page 325
 Light Table and Onion Skin, on page 327
 Colour Keying, on page 329
 Image Capture, on page 331
 Vectorization and Clean-Up, on page 332
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Lecture Notes

What is Stop-motion Animation?
 No drawing is required for stop-motion animation. With this technique, you need only 
gather various objects to be featured in a series of pictures. You position the object, snap 
a picture, then move the object slightly and take a new picture, continuing the process 
until the object has reached its final destination. Once you view the pictures in sequence, 
the object will appear to be moving, or animated.

Some people also refer to stop-motion animation as Claymation.

Stop-motion animation can be achieved with almost any object. Some of the most 
popular materials used are:

• Clay

• Figurines

• Pinscreen

• Sand

Some of the key animators and companies that helped develop the stop-motion 
animation technique are:

• Eliot Noyes, Jr. (Clay or the Origin of Species (1965), He Man and She Bar (1972)

• Norman McLaren (Pioneer in stop-motion animation exploration)

• Jacques Drouin (Pinscreen Animation)

• Industrial Light & Magic (Special Effects and Models such as Star Wars,1977 to 
1983, and Indiana Jones, 1981 to 1989).

• Nick Park (Wallace and Gromit Series)
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Gathering Your Characters

When deciding on characters, it is best to look for or create figures that have ball and 
socket joints for full rotary movement. Just like a cut-out puppet, you want to be able to 
move your principle character at the shoulders, legs, knees and elbows if possible. If you 
choose to create or use characters that have less mobility, your animation might look a 
little stiff, which is not necessarily a bad thing if this is the look you wish to achieve.

Setting Up Your Background

Do you prefer a 2D or a 3D background? Either way, you will have to plan accordingly. 
If you would like a 3D background, then build one from scrap material and found 
objects. If you would like a 2D background (cartoon, video footage, etc.), then you will 
need to set up what is known as either a blue or green screen.

A blue or green screen is a piece of solid coloured material, that when used as a 
backdrop, can easily be selected and colour keyed out in Toon Boom Studio. Once the 
screen colour has been keyed out, it will appear as if your toys and figurines were filmed 
against a transparent background. On a new layer in the software, you can create an 
animated 2D background or import a piece of video footage.

An important element to consider when setting up either a blue or green screen 
backdrop, or a stop-motion setting, is the lighting. In the case of a green screen, soft, 
flat lighting is key to making the material appear smooth and shadowless. The fewer 
variations in tone, the easier it will be to key out the colour. Lighting does not necessarily 
mean a multi-lamp setup; a well-lit room with natural daylight can often work best, as 
well as the fluorescent lights in a classroom.
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Setting Your Image Capture Settings 
Before you start, be sure that your image recording device is plugged into your 
computer and turned on. Follow the camera manufacturers instructions on how to 
connect the camera to a computer. It is recommended for the stop-motion image 
capture process that you support your camera in a fixed position by either using a tripod 
or some other mounting system. The camera must be rigidly fixed; any movement of the 
camera, shaking, vibration, etc. will affect the captured images. The only items which 
should move are the items on the stage. 

Setting-Up the Image Capture Options 
To set up the software for image capture:

1. From the File menu, select Acquire > From Capture Device.

The Image Capture window appears.

2. In the Options section, under the Source tab, find and select your recording device 
from the Device drop-down menu.

3. From the Source drop-down menu, select Full-Resolution Photo, if it is available for 
your recording device (some devices, such as webcams may not allow for this 
option). Otherwise, if you would prefer to take faster, lighter images for a rough 
test, select Live Preview.

 The Capture window can be used to capture more than just live physical models 
with a recording device. You can also “capture” hand-drawn images with the use 
of a scanner.

4. If you are using a scanner with a WIA driver (Windows Image Acquisition), the 
Resolution drop-down will be enabled. From the list, select the resolution at which 
you would like to scan your images.

5. If you wish to smooth out some of your colours, check the Noise Reduction option. 
If you wish to capture more detail, leave this option unchecked.

4
3
2

5 6
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6. Click on the Properties button.

The Camera Properties window appears.

This is an example of a typical Camera Properties window.

NOTE: The Camera Properties page is different for every capture device. The 
information displayed on that page comes from the device itself and will therefore 
contain different options for each device. 

7. Most of the settings that you see in the Exposure section are set manually on your 
camera. If you change a setting in the software, such as the ISO, it will be changed 
on your camera. If you change a setting on your camera, it in turn will be changed in 
the software.

8. In the White Balance section, play with the options from the Mode drop-down and 
select the one relating to your lighting set up, or until the colours in the preview 
window displays evenly balanced colours. Make fine tune adjustments with the 
colour sliders.

9. In the Focus section, use the Near and Far increments to bring the preview image 
into focus. For greater focal detail, use the Left, Right, Up and Down buttons to 
move around the Zoom Preview rectangle in the preview window. When you find a 
good section to examine, such as an area of high-contrast, press on the Zoom 
Preview button to view that section in detail. Use the Near and Far increments to 
make finer adjustments.

10.Click on the Close button.

7

8

9
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Image Capture 

This is the easiest part of the stop-motion animation process. Click on the Capture 
button and watch your images being recorded as a string of frames along the timeline, 
on an Image Capture layer that was automatically created.

NOTE: if you are using a video camera, it will act as a still-frame camera; it will only 
capture the single images within its field of view. 

To perform an image capture:

1. Set up your first pose. Use the preview window and the recording device viewfinder 
to make sure that it is correctly framed. 

2. When you are ready, click on the Capture button.

3. Reposition your character and/or other elements on your stage. The smaller the 
movement, the smoother your animation will be.

4. When you are ready, click on the Capture button.
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5. At this point, your Timeline should look something like this. Each frame represents 
an image capture.

6. Repeat this process until you have completed your motion sequence.
7. When you are finished, click the on the Close button. 

Capturing Images in an Existing Layer

Instead of recording all the images that you need in one go, you may decide to chop up 
the action sequences into different recording sessions. However, if you do this you may 
notice that each time you close the Capture window and then start up again, the 
software automatically creates a new Image Capture layer. 

To add image captures onto an existing layer:

1. In the Timeline or Xsheet view, right-click (Windows) or [Ctrl] + click (Mac) on the 
empty cell where you would like the new captures to begin.

2. From the pop-up menu, select Import Images > From Capture Device. The 
Capture window appears.

3. Continue with the capture process as detailed above.

Further Reading
The Art of Stop-Motion Animation by Ken A. Priebe

Special Effects: The History And Technique by Richard Rickitt

Stop Motion: Craft Skills for Model Animation by Susannah Shaw
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Further Viewing
Here are a series of stop-motion films that we recommend you watch. Examine how they 
animate the puppets and the props and how they make objects fly.

• A Nightmare Before Christmas (1993) 

• Corpse Bride (2005)

• Coraline (2009)

• Wallace and Gromit: A Matter of Loaf and Death (2008)

• Wallace and Gromit: The Curse of the Were-Rabbit (2005)

• Wallace and Gromit: The Wrong Trousers (1993)

• Wallace and Gromit: A Close Shave (1995)

• Wallace and Gromit: A Grand Day Out (1989)

• Chicken Run (2000)

• James and the Giant Peach (1996)

• Godzilla (1954) - This is a live action movie in which the character of Godzilla is 
animated using the stop-motion animation technique.

• King Kong (1933) - This is a live action movie in which the character of King Kong 
is animated using the Stop-motion Animation technique.
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Activity: Animating Figurines
In this activity, you will animate one or several figurines from your own personal 
collection.

 Your objective is to analyze all the poses required to constitute a movement and take 
the pictures required to animate the figurines.

Material Provided for this Lesson
The Lesson 13 sample material contains: 

• Sample stop-motion project: a project showing the results of a completed stop-
motion animation scene.

Exercise: Animating a Figurine

1. Gather your toys and figurines.

2. On a piece of paper, write down a very short story (one or two sentences maximum) 
involving your toys. It must be kept short and simple so that you can concentrate on 
the animation; do not allow yourself to become sidetracked by an ambitious story 
idea! The idea is to have fun while completing a five to ten second animation. An 
example of a short story would be along the lines of the following: The penguin 
raises his pointer from the top of the desk and then lowers it to the top of the desk. 
The figures in the classroom turn to face him.

3. On that same piece of paper, draw the three main moments of your story so that 
you know where you will position your figurines and what their motions will be. 
Based on the short story suggested above, your three main points would be the 
raising of the pointer, the lowering of the pointer, followed by the figures turning to 
face the penguin. Make very simple drawings; even stick-figures will do. These 
drawings are only to help you plan your project, so you do not want to spend too 
much time on them.

4. Connect a webcam or camera that can capture the images to your computer.
5. Open Toon Boom Studio and create a new project.
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6.  Place the figurines on your stage, matching what your drew earlier.
7. Open the Capture window by going to File > Acquire > From Capture Device and 

set up your capture parameters.
8. Capture your first image.
9. Move your figurines slightly by shifting their location and/or repositioning their 

joints and limbs.
10.Photograph your second image.
11.Repeat the process until your animation is complete.
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Lesson 14: Basic Multiplaning and 
Sceneplanning

This lesson includes the following sections:

• Lesson Objectives, on page 218

• Lecture Notes, on page 219

• Creating Motion and Depth Before Computers, on page 220

• Multiplaning Digitally, on page 221

• Further Reading, on page 222

• Further Viewing, on page 222

• Activity 1: Setting Up the Multiplane Space, on page 223

• Activity 2: Moving the Camera, on page 229

• Extra Activity: Moving Your Character in 3D Space, on page 232
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Lesson Objectives

Total Lesson Time: Three classes
In this lesson, we are going to move the camera through a multiplane space.

At the end of this lesson, you should be able to:

• Understand the role of pegs in motion

• Understand how multiplaning was achieved before computer technology

• Layout elements along the Z axis to show depth

• Design a motion path for the camera

Activity 1: Setting Up the Multiplane Space

Activity 2: Moving the Camera

Extra Activity: Moving Your Character in 3D Space

User Guide References
• Chapter 14 Scene Setup

 Ordering the Element Layers, on page 337
 Positioning the Scene Elements, on page 339
 Cloning and Duplicating Elements, on page 343
 Setting the Camera Frame, on page 346
 Creating a Multiplane, on page 350
 Creating a Motion Path, on page 354
 Animating the Camera, on page 367
 Function Editor View, on page 369

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 2 - User Interface

 Scene Planning Windows: 0:01:05

• 7 - Scene Layout

 Using the 3D layout: 0:01:41
 Camera Effects: 0:02:32
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Lecture Notes

Multiplane is one of the most exciting effects you can add to a project. In the Multiplane, 
you can create backgrounds in several layers, spread them on the Z-axis, add depth and 
finally, move the camera through this environment to create an impressive illusion of 
depth. In an animation context, multiplaning is used to create a scene with a multiple 
amount of planes placed at different distances from the camera to recreate a 
perspective of illusion. A plane is a layer or an element. In regular flat 2D scenes, all the 
elements are at the same distance superposed one on top of each other. So, when the 
camera moves, all the elements are moving at the same speed. In real life, all objects and 
elements are placed at different distances from our eyes so that when we walk past, the 
closest objects appear to be moving away faster. The farthest ones, like mountains, are 
barely moving. In animation, that perspective effect has to be reproduced manually.

In this lesson, you will find out about:

• Creating Motion and Depth Before Computers, on page 220

• Multiplaning Digitally, on page 221

• Understanding Your Own Multiplane, on page 221

• Further Reading, on page 222

• Further Viewing, on page 222
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Creating Motion and Depth Before Computers
• To make walk cycles work without the benefit of computers, the background had 

to be panned, that is translated, in the opposite direction of the character to 
suggest the character’s forward movement. Peg bars were developed to ensure 
accuracy in the movement of the background.

• Creating a sense of depth in animation was a difficult task. Character actions 
could only cross layers if painful attention was paid to the detail of the changing 
scale values of the drawings. Multiplaning was generally avoided because of the 
technical difficulties involved. 

• The multiplane camera was developed by the folks at the Walt Disney studio. 
Cels were set at different distances from the camera. Technicians carefully 
moved the camera closer to each cel, removing cels as they were “passed” in 
the layering order. The multiplane camera was quite a complicated piece of 
equipment, one that did much to influence the evolution of animation. To refresh 
your memory regarding the multiplane camera, revisit History of Animation, on 
page 21.
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Multiplaning Digitally
• Before the advent of computer animation, it would take an entire studio of 

animators and technicians just to draw, stage, lay out, and film a multiplane 
scene. Now, computer technology makes it possible for one person to develop a 
multiplane scene by cinematic camera moves.

• In Toon Boom Studio:

 A system of pegs is also used to move drawings.
 The 3D scene stage allows animators to place their drawings in X (left-right), 

Y (up-down) and Z (front-back) space.
 All action, including camera moves, can be plotted through 3D space. A 

remarkable sense of depth can now be added to a scene so easily that 
animators from the old days would be amazed.

Understanding Your Own Multiplane

To construct a multiplane, you must imagine what a real environment is like. Take a look 
at this picture and imagine the camera moving across the space. Objects in the picture 
will move at different speeds, depending on where they are in relation to the camera 
lens.

If you move the camera across the space (pan), you will see that all the objects are 
moving at different speeds, producing a parallax (depth) effect.

In this scene, the green sea grass at the back is almost stationary, while the rocks on 
either side move very slowly. But, the sea grass closest to the foreground moves faster 
and the sand dune in the foreground appears almost to be flying!

Building a multiplane requires an understanding of your background and of which object 
should be placed on which layer. You want to separate all the main elements, but not 
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every small object. For example, the coral is attached to the foreground rock, therefore 
they will move together.

Each layer should be a complete drawing, or at least show as much as possible. For 
example, the sand dune in the front should extend beyond what you see in the camera 
frame. You may need the hidden portions later in the scene as the camera moves, thus 
revealing more of the drawing.

Further Reading
The Illusion of Life: Disney Animation: Chapter 10: How to Get It on Screen

Further Viewing
The Old Mill. This Walt Disney short pioneered the use of multiplaning.
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Activity 1: Setting Up the Multiplane Space

In this activity, you will learn how to set-up a multiplane scene in preparation for camera 
moves.

Material Provided for this Lesson
The Lesson 14 sample material contains: 

• Multiplane Flat: the drawings of a background are separated on several layers, 
but are still on the same plane. You will use this background to experiment with 
multiplaning.

• Multiplane No Camera Movement: the drawings of a background separated on 
several layers have been staggered in depth. You will use this background to 
experiment with camera movements.

• Completed Scene: a completed multiplane scene that you can compare your 
work with once it is finished.

You should not look at the last two projects until you have finished your 
experiments.
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Setting Up the Multiplane Scene
To setup the multiplane scene:

1. Open the undone sample material in Toon Boom Studio.

2. From the File menu, select Save As and resave the project, adding your own initials 
at the end.

3. If you are not already there, click on the Camera view  icon, located at the top, 
right corner of the Drawing view.

4. Examine the background that appears in the Camera view. 

All the elements appear jumbled and it is difficult to see what the scene should look 
like. This is because the Timeline layers stacking order is being taken into 
consideration, instead of the z-axis position of any of the drawings. Because of this, 
drawings on layers situated at the top of the Timeline stack appear in front of those 
drawings that are on layers situated further down the Timeline stack.
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5. In the Timeline view, take a look at what layers exist and what they represent in the 
Camera view. You can hide a layer in order to see what it is in the Camera view.

Here is what is contained on some of the layers:

• Single drawings exposed for the entire scene - Sea, Coral Reef, Sand Dunes and 
Rock Backgrounds

• Drawings traditionally animated - Sea Grass and Bubbles

• Drawings traditionally animated and attached to an animated peg - Schools of 
Fish

• Cut-out puppet, animated using keyframe interpolation - Sea Turtle

6. From your Playback toolbar, use the Play  button to view those layers that have 
either traditional (hand-drawn) animation, or interpolated keyframe animation.

It is beyond the scope of this lesson to animate anything other than the camera. For 
this reason, all objects have been animated for you and those that were animated 
using interpolated keyframes are already located at their correct position along the 
z-axis.
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7. Open the Top and Side views by going to the top menu and selecting Windows > 
Top View and Windows > Side View. Find the best place for them by dragging 
their tabs around your interface.

From the Top and Side views, all the different layers appear as a single green line 
(except the bathing turtle and the fish, which are not yet in view). In both views, you 
can see the black, triangular camera cone.

8. In the Timeline view, select the layer that you would like to move. The objects on 
that layer will appear as darker green lines in the Top and Side views.

9. From the Tools toolbar, select the scene planning Select  tool.

Use this tool to move drawing objects in your scene without creating keyframes. 
When you want to create keyframes to record temporary movements, use the 

Transform  tool.

Top View Side View

Fish
Bathing turtle

Everything else
motion
path

Fish
Bathing turtle

Everything else
motion
path
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10.In the Top or Side view, move the selected layer either towards, or away from, the 
camera cone.

11.In the Properties panel, take a look at the Offset values for the y, x and z axes.

 

Notice how the Y field uses N/S to indicate north/south, allowing you to go either 
up or down the y-axis. The same is true for the X field, which uses E/W for east/
west, allowing you to go either right or left. Similarly, the Z field uses F/B for 
forward/backward.

You may enter values manually instead of using the Select tool in the Top and Side 
views. If you enter a negative value, or a positive value, the appropriate directional 
letter will automatically be entered, depending on which axis field you are in. 

The scale fields are also something that you might consider using when moving 
elements in a multiplane scene.
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12.Continue using the Top view to move the scene’s objects backwards and forwards, 
left and right. Use the Side view to move these elements up and down, or forwards 
and backwards, as well.

Continue until your Top view looks something like this:

This is what the Top view looks like without prior to the entrance of the fish.

13.Save  your project!
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Activity 2: Moving the Camera

The camera is a static element. To animate it, you will need to add a trajectory layer 
called a Peg.

Preparing the Camera
1. In the Timeline view, select the Camera layer.

2. In the Timeline toolbar, click on the Add Parent Peg Element  button.

The Camera layer has automatically become attached to a Peg layer.
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Animating the Camera

3. In the Animation toolbar, select the Translate  tool.

4. In the Timeline view, go to the first frame and select the Camera’s Peg layer.

5. In the Top view, reposition the Camera’s Peg (red circle). Use the Camera view to 
help guide your positioning.

6. In the Timeline view, go to the last frame (where you want the camera to come to a 
stop). In the case of the Completed sample material scene, it is frame 163.

Everything within the black rectangle 
will be shown in the final project. 
Careful! Do not reveal graphics that 
should remain hidden from view!
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7. In the Top view, draw the camera towards the back of your scene, closing in on the 
turtle showering. Use the Camera view again to ensure that your framing is good.

8. In the Playback toolbar, click on the Play  button to view your animation.

9. Save  your project.
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Extra Activity: Moving Your Character in 3D Space

• Save your walk cycle from the previous lesson in the Global template folder. 
Next, bring it into a new scene.

• Design simple backgrounds for your character to walk across.

• Lay out your scene elements in depth.

• Design a motion path and attach the camera and walking character to the same 
motion path.

• Export your animation and see how your walk cycle looks.
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Lesson 15: The Take

This lesson includes the following sections:

• Lesson Objectives, on page 234

• Lecture Notes, on page 235

• Further Reading, on page 238

• Further Viewing, on page 238

• Activity 1: Performing Different Takes, on page 239

• Activity 2: The Flour Bag’s Expressions, on page 240

• Activity 3: Animating a “Take” Shot, on page 241
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Lesson Objectives

Total Lesson Time: One class
Seeing your characters jump and walk is one thing. Seeing how they think is something 
even more magical! In this lesson, we will take a short break from the physics of motion 
to focus on the acting required to make animated characters think.

At the end of this lesson you should be able to:

• Understand the importance of acting in regard to animated characters

• Understand how your character might react to a specific situation

• Draw several examples of your character exhibiting a state of shock or surprise

Activity 1: Performing Different Takes

Activity 2: The Flour Bag’s Expressions

Activity 3: Animating a “Take” Shot

User Guide References
• Chapter 8 Traditional Digital Animation

 Traditional Animation Tools, on page 210
 Animating Traditionally, on page 216

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 5 - Traditional Animation

 Light Table: 0:02:25



Lesson 15:  The Take

235

Lecture Notes

Acting

In order to animate a character, you must get under the character’s skin. Only then will 
you begin to understand the importance of acting to the animation process.
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Here are some basic notions to keep in mind:

• Because animations are not alive, acting becomes even more important in terms 
of breathing life into your characters. 

• A character expressing something as basic as surprise can reveal a variety of 
emotions: they might laugh, cry, scream, jump for joy, or perhaps just appear 
shocked.

• To express exaggerated emotion, a characters’ eyes might bulge, his mouth 
might drop open, he could back away in fear, or jump up and out of his shoes.

• Body language can speak volumes. For example, to indicate anger a character 
might shake her fist, or if she is uncomfortable, she might play with a strand of 
hair.

 

Understanding The Take

The “Take” will be one of those actions that you will have your characters act out 
frequently. It is the shot in a scene where your character suddenly realizes that what they 
are seeing is somehow shocking or surprising.

The take is usually done in two steps: The Anticipation and the Reaction.
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Anticipation

The take needs an anticipating action, in much the same way that a jump does. The 
viewer must understand what is going to happen. At the same time, the anticipation is 
also the moment in which the character appears to take in the information of what is 
actually going on, before reacting to it. The anticipation will often look like the character 
is squashing.

Reaction

The reaction is the moment when the character appears shocked or surprised. 
Remember, this phase can be acted out in a variety of ways. A character might be 
shocked, but doesn’t want the others to see it., In this instance, the reaction can be very 
subtle. Or, the reaction might be so grand that everyone hears and sees it. While the 
anticipation is more of a squash, the reaction is where the character will stretch.
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Further Reading
The Illusion of Life: Disney Animation: 

• Chapter 15: Character Development

• Chapter 17: Acting and Emotions

Further Viewing
The Sorcerer’s Apprentice in Fantasia. An excellent example of how character is 
conveyed without the use of dialogue.

Looney Tunes. Available on the Golden Collection Volume 1 and Volume 2 or via your 
local cartoon specialty TV channel.
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Activity 1: Performing Different Takes

In this activity, you will need to act out different takes. Forming a group with your 
classmates, you will each have at least three different takes to act out. Here is a list for 
you to follow:

• Start with a regular take. Just look shocked!

• Do a subtle take.

• Do a very flamboyant take.

• How would a princess do a take?

• How would an angry king do a take?

• How would a superhero do a take?

• How would a fish do a take?

• How about a dinosaur?

• Or an alien?

Once you have acted your takes, pick your favourite, then take the time to sketch it on 
a sheet of paper. Do both the anticipation and the reaction steps. Are you able to 
capture on paper what was acted out in real life? Would you be able to use all these new 
sketches for an animation?
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Activity 2: The Flour Bag’s Expressions

This activity will really help elevate your acting skills to a new level. You will be drawing 
expressions for a flour bag. But here is the catch, the flour bag cannot have a face! The 
only way to have it express emotions will be with its body and the poses it will strike. You 
will need to convey at least 15 expressions, 10 of which are provided. The other five are 
up to you. Be sure to write the type of expression underneath the pose.

The Lesson 15a sample material includes a completed example of the Flour Bag’s first 
10 expressions. Only take a look at the scene once you have completed your own fifteen 
expressions.

The 10 expressions are:

• Happy

• Sad

• The Take

• Heroic

• Depressed

• Angry

• Scared

• Curious

• Doubtful

• Shy
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Activity 3: Animating a “Take” Shot
This activity will actualize everything you have learned about acting in this lesson by 
animating an actual take shot.

Material Provided for this Lesson
The Lesson 15b sample material includes a completed version of a Flour Bag’s take shot.

Exercise: Animating the Flour Bag Performing a Take

Here we will move the acting involved in the take to a new level, once again relying on 
our Flour Bag character.The goal is to animate a small scene where the Flour Bag sees 
something, does a take, then reacts to what is happening. You can keep it very simple! 
The goal is simply to have the flour bag look alive. 

1. You will first need to storyboard your idea. A storyboard is a visual plan of all the 
scenes and shots in an animation. The storyboard indicates what will happen, when 
it will happen and how the objects in the scene are laid out. Using a sketch pad or 
index cards, take the time to sketch out in detail the actions that the Flour Bag will 
do and to plan the timing of your animation. Make sure that your scene does not 
run beyond 10 seconds in length.

2. Once everything is planned, you are ready to start your scene in Toon Boom Studio. 
Open the software by double-clicking the icon. 

3. In the Welcome Screen, name your project Flour_Bag, followed by your initials.

Start your work by creating all the drawing layers that you will need for your scene. You 
should have a least one layer to accommodate the background, another for the flour bag 
and a third for the foreground element, otherwise known as an overlay. If you have 
another character or prop, you should create a new drawing layer for these elements 

too. To do so, go in the Timeline and click the Add Element  button, then select 
Drawing in the drop-down menu. Name your layer according to the function it will serve 
in your scene, for example Background or Chair.
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4. From the Drawing Tools toolbar, select the Brush  Tool and draw your 
background and foreground first. This is where your animation takes place. You will 
need to know where your character will move before you can actually animate it. In 
our example, the action will take place in the kitchen.

5. Extend your background and foreground frames for all 10 seconds of your 
animation. To do so, right click the frame, then select Extend Exposure.
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6. Now that your scene is set up, you can animate your Flour Bag. Start with the key 
poses of your action and check to see if the timing of your animation is correct. 
Keep it rough. Your goal is to learn acting.

7. Activate the Show Onion Skin  option on your Onion Skin toolbar. This will allow 
you to see the previous and next frames of your animation so that you can draw the 
in-betweens. 

By clicking on the Show Previous Drawings  or Show Next Drawings  options 
on your Onion Skin toolbar, you can choose to view one, two or three of your 
previous drawings, or none at all.
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8. If you have a second character or another object that moves in your scene, now is 
the time to animate it. Again, keep it rough and alive. Do not try to clean up 
everything that you draw at this stage.

9. When everything is animated, you are ready to clean-up the frames. In the Timeline, 

click the Add Element  button, then select Drawing in the drop-down menu to 
create new drawing layers. These will be used for the clean-up. Create as many as 
you need, taking the time to rename them as you go along.

10.Start cleaning up your animation drawings using the Brush  Tool, located on your 

Drawing Tools toolbar. From the same toolbar, use the Paint Bucket  Tool to 
colour your frames.

11.Make sure to save your work as you progress by clicking the Save  button.

12.Select the Play  button located on your Interactive Playback toolbar to play back 
the animation of the walk cycle and test/correct your work. You can also activate the 
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Loop  button in order to view your animation in loops, while noting the 
corrections you will have to make. 
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Lesson 16: Visual Break-Down and Lip-
sync

This lesson includes the following sections:

• Lesson Objectives, on page 248

• Lecture Notes, on page 249

• Visual Breakdown, on page 249

• Lip-sync and Phrasing, on page 251

• Understanding the Way We Speak, on page 253

• Further Reading, on page 253

• Importing a Sound, on page 254

• Decoding your Sound, on page 255

• Assigning the Mouth Shapes, on page 257

• How to Swap Mouths, on page 258

• Playing Back and Exporting, on page 259

• Activity 1: Breakdown and Lip-sync, on page 254

• Extra Activity: Animating Your Dialogue, on page 260
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Lesson Objectives

Total Lesson Time: One class
This lesson is an introduction into the analysis of dialogue and lip-synching.

At the end of this lesson, you should be able to:

• Break down dialogue into the important acting moments

• Draw the mouth positions of your character

Activity 1: Breakdown and Lip-sync

Extra Activity: Animating Your Dialogue

User Guide References
• Chapter 12 Sound and Lip-sync

 Importing a Sound File, on page 302
 Sound Display, on page 303
 Sound Playback, on page 305
 Sound Scrubbing in the Timeline View, on page 305
 Editing a Sound File, on page 306
 Lip-sync, on page 317

Basic Training Video Recommended
If you own the Basic Training video set, here are the suggested videos for this lesson:

• 5 - Traditional Animation

 Light Table: 0:02:25
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Lecture Notes

Visual Breakdown

You will discover that when adding dialogue to a scene, there is much preparation and 
analysis involved. First, it is important to know that the dialogue should be recorded 
before starting any animation. You need the sound file so that you can break down the 
dialogue into syllables and after that, turn those syllables into mouth shapes to be drawn 
on each frame. This must be included in the Xsheet before starting your drawings.

Once the actual dialogue is broken down, then you have to analyze it on a second level: 
what emotion do you want it to convey? You need to understand what your character is 
saying and exactly how you want the character to say it once animated. The last thing 
you want is for your character to stand and do nothing while he or she talks.

Listen to a voice track and analyze it to identify the important elements.

• What is the timing of the dialogue? Quick, is the manner of speech choppy and 
precise, or slow and sloppy?

• How is the mood of the character to be reflected in the dialogue?

• Where will the rest of the body be? 

• How will the body anticipate the dialogue?

• What is the character doing and why?

• Get inside your character!
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Then... Little green men...

Were dancing... Around.

Me. Singing!
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Lip-sync and Phrasing

With Toon Boom Studio, you can automatically generate a lip chart based on the 
phonemes in a character’s dialogue track. Phonemes are the units of sound in a language 
that distinguish one word from another.

However, there is more to animating dialogue than just drawing the right mouth 
positions. The mouth chart is an important and useful reference, but it does not dictate 
absolutely how you will animate dialogue.

• People do not enunciate every syllable. They “smudge” phrases.

• It is not necessary to animate every single letter. It is more important to look at 
the entire word and consider how it is emphasized in the dialogue—try to feel 
the word.

• Design interesting mouth shapes that reflect the qualities of your character.

• Teeth: either the top or bottom teeth are usually visible. Since they are solid, 
they should not change as the character speaks; there is no squash and stretch 
on teeth. Well, unless that is what you want; they are, after all, cartoons!

• Every person has a unique way of talking. What is the nature of your character’s 
speech? For example, does your character show its top teeth, bottom teeth, or 
both when talking? Do the lips curl?

• More on acting: what is the mood of the character or the scene, and how does 
this influence the dialogue? 
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Mouth Charts
Adding a dialogue to a project can enhance the storytelling. However, it can be difficult 
to shape a character’s mouth so that it matches the sound at the precise frame.

To solve this problem, Toon Boom Studio provides a lip-sync feature which analyzes the 
contents of a sound element and generates a mouth chart. The chart, included below, is 
based on the eight animation phonemes: A, B, C, D, E, F, G, and X, which is used to 
represent silence.

Here is an approximation of which sound each mouth shape can produce:

• Mouth Shape A: b, m, p 

• Mouth Shape B: d, h, i, j, k, s, t

• Mouth Shape C: a, e

• Mouth Shape D: A, E

• Mouth Shape E: o

• Mouth Shape F: oo, u

• Mouth Shape G: f, ph

• Mouth Shape X: Silence, undetermined sound 

The mouth shapes used by Toon Boom Studio are based on the conventional mouth 
chart used in the animation industry. The letters used to represent the shapes do NOT 
correspond to an actual sound and are only used for identification of the mouth shape.

You can lip-sync the traditional way or let the system automatically create the basic 
detection, remembering to tweak the detection afterwards.
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Understanding the Way We Speak
When it comes to animating, you have to be careful not to overdo it. It is easy to start 
doing a different mouth for each letter the character is pronouncing, but this is a 
mistake. Try it yourself. If you can film yourself and analyze it afterwords, even better. Say 
a simple sentence as naturally as possible. You will notice that you do not emphasize 
every letter, or even every syllable, in that sentence. What happens if you do? It sounds 
a little bit silly, doesn’t it? And it is slower, too. 

If you want your character to sound natural, you have to animate its mouth the same way 
that you would speak, only emphasizing where it is needed in the dialogue. So a 
sentence like, “Good Morning!” should look something like this:

Instead of this, which is a little too much:

Further Reading
The Animation Book: Chapter 7: Working With Sound

The Illusion of Life: Disney Animation: Chapter 11: The Disney Sounds and 

Chapter 16: Animating Expressions and Dialogue
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Activity 1: Breakdown and Lip-sync

This activity will get you thinking about dialogue, acting, and the mechanics of lip-
syncing.

Material Provided for this Lesson
The Lesson 16 sample material includes three elements: breakdown, mouth positions 
and sound. Analyze the material in this sample material to see how we selected shots.

Importing a Sound
The first step in lip-syncing an animation is importing the dialogue into your scene. The 
dialogue is a sound file which only contains your character’s voice. It is important to have 
only the sound of the voice in this file, as it should be the only sound that the lip-sync 
process will detect.

To import a sound:

1. In the top menu, select File > Import File.

2. Browse for your sound file (either a *.aiff, *.mp3, *.wav, *.m4a), select it and then 
click Open.

The sound layer will appear in the Timeline view and be displayed as a waveform. 

You can play your sound by using the Play  button.

1. In the Timeline view, right-click on the sound layer and from the pop-menu, select 
Sound Editor.
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2. In the Sound Editor, press on the Play  button to listen to your sound.

Decoding your Sound

You can use the Auto Lip-Sync Detection feature to determine the timing of the 
animation of the mouth. It automatically detects each phoneme and assigns a mouth 
shape to it.

1. In the Sound Editor, in the Sound Element space, click on the sound wave of your 
sound file so that it turns purple. 

2. Click on the Lip-sync button.

A progress bar will appear as the Sound editor analyzes the sound file.

3. Press on the Play  button to view the result in the preview space.

An X mouth shape appears when no sound has been detected for a frame.

Preview
space
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4. Check the Enable Scrubbing option, then fine tune the automated detection by 
scrubbing through the sound with the red playhead. Scrubbing allows you to hear 
the frame-by-frame breakdown of a sound clip.

It does not matter which of the two waveforms you use to scrub the sound. The 
Current Sound section is used to edit the sound file, but that topic will not be 
covered in this lesson.

5. If you come to a place where you feel that the correct phoneme was not selected by 
the automatic detection, click on the phoneme thumbnail that you think is more 
appropriate.

6.  Continue to scrub through the sound, replacing phonemes until you are satisfied.

Read the upcoming section on How to Swap Mouths to learn how to assign your 
mouth shapes as you decode your sound manually.
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Assigning the Mouth Shapes

Now it is time to assign the detected mouth shape to your actual character mouth 
shapes layer.

1. In the Xsheet view’s right side, right-click (Windows) or [Ctrl]+Click (Mac OS X) on 
the sound layer header and select Modify Lip-sync Mapping.

2. In the Mapping Lip-Sync dialog box, choose the layer that contains your character’s 
mouths in the Destination Layer drop-down menu.

3. In the Mapping fields, enter the name of each of the drawings of your layer’s mouth 
shapes. In this example, the actual drawing names match the mouth shape 
convention, so there is no need to change it.

4. Click on the OK button.

The lip-sync timing is now all set in the MouthPositions layer of the Timeline view. 

The automatic detection supports seven sound mouth shapes and one silent mouth shape. 

A B C D E F G X
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How to Swap Mouths

You can use the drawing swap feature to time your lip-sync from the start, or use it 
to quickly tweak the Auto Lip-Sync Detection and Map Lip-Sync results.

1. In the Xsheet view, in the MouthPositions column, double-click in the cell that you 
would like to swap the mouth position.

2. Type in the letter of the mouth position that you would like to the swap the mouth 
for, then hit [Enter].

In the Camera view, note how the mouth on your character has been swapped. 
Also, note that the mouth position of the Sound column remains unchanged.

3. Continue playing your animation in the Camera view, stopping to swap mouth 
positions where you see fit, until you are satisfied.



Lesson 16:  Visual Break-Down and Lip-sync

259

Playing Back and Exporting

Now it is time to play back the result and export the finished animation to a QuickTime 
movie file.

From the Playback toolbar, click on the Play  button and view your animation in the 
Camera view. You should also be able to hear the dialogue through a set of headphones 
or speakers.

To export a QuickTime movie:

1. Select File > Export Movie.

2. In the Export dialog box, click on the Browse button to name the movie and select 
where you want to save it.

3. From the Export Format drop-down menu, select QuickTime.

4. From the Export Type section, select Full Movie (in the Export Range section, All is 
automatically selected).

5. Click Ok.
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Extra Activity: Animating Your Dialogue

Now it is time for you to do a breakdown and lip-sync of your own character(s) for your 
own project.

1. Devise a scenario in which your character is talking about something that he, she or 
it is quite excited about. 

2. Write one or two lines that your character will say and record them. You can use a 
basic microphone and sound recording program, which you will find on most 
multimedia computers.

3. Listen to your sentences and plan the breakdown. What are the important parts of 
the sentences? How will your character act when saying these things?

4. Using the mouth chart from the Lip-sync and Phrasing section, draw the seven 
mouths for your character on a separate layer.

5. Rename your mouth shape drawings in the Xsheet view by right-clicking on the cell 
and selecting Rename Drawing.

6. Continue by following the steps from the Importing a Sound section.
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Lesson 17: Storyboard and Staging

This lesson includes the following sections:

• Lesson Objectives, on page 262

• Lecture Notes, on page 263

• Activity: Storyboard Your Dream Scene, on page 269
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Lesson Objectives

Total Lesson Time: One class
Detailed planning will let you envision how your animation will unfold and help you 
communicate your ideas to your animation team. You will have to think about how to 
make the best use of the elements in your scene, in order for them to have the greatest 
impact.

At the end of this lesson, you should be able to:

• Understand the value and purpose of a storyboard

• Understand the importance of composition in your scene

• Storyboard a scene, considering the composition of the scene elements

Activity: Storyboard Your Dream Scene
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Lecture Notes
Storyboarding and staging are related concepts:

Look at various animation stills and analyze the staging. How are the props and 
characters arranged? Is it effective? Then watch an animated sequence and work out 
how it would be storyboarded.

Storyboarding
• Storyboarding is the planning of each shot, the main position of the character as 

well as how the shot changes.

• When you are working in an animation team, detailed storyboarding is essential 
so that everybody knows how a shot develops, what is taking place, and how the 
characters will act. 

• It is important to keep scene directions clear.

• Consider the pacing of a scene and the number of shots that it will require. 
Quick cuts between shots creates a faster pace. Longer shots with less cuts 
results in a slower pace. What is going on in your scene that determines or 
influences the timing of the action/shots?

Staging
• Staging is the layout of elements in the scene, arranged in such a way as to 

create the greatest impact and focus the audience’s attention on what is most 
important about the shot.

• Pictures pass the audience’s eyes very quickly—often too quickly to register all 
the details. Keep it simple in order to help viewers focus on the important 
elements.

• Elements in your scene must work together: background, scenery, and 
characters. Styling the scene is another task that requires considerable thought 
to create a coherent scene and movie.
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Creating a Good Storyboard
Take a look at these examples of storyboarding. First, we show an example of poor 
storyboarding, followed by an example of a good, well-considered storyboard.

Bad Storyboarding

This set of examples demonstrates the wrong way to draw a storyboard, the reasons why 
it is wrong and some suggestions on how to improve it.

1a: This opening shot is a profile shot. 
Notice how flat everything seems. 

It is always best to use shots that reveal 
volume, like 3/4 angle.

1b: This shot is even worse. 

Notice the composition.The character and 
the box are both way over to the left, while 
the rest of the frame is empty.

You must be aware of empty space, and try to 
arrange the scene in interesting ways.
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2a + 2b: Well, at least we have changed the camera angles. However, this shot is 
still flat. Notice how no perspective was used, and how the character’s feet sit 
directly on top of the floor. And is there any reason why we are still so far away?

Most importantly, when did she pick up the box? Was it in shot 2a or 1b?

Storyboards primarily serve a technical function by letting you know what happens 
and when. Never leave out important actions, like “picking up the box,” from your 
storyboards.

This shot also suffers from bad staging. Notice how the arms, hand, legs, box and 
torso all converge around the same space. This makes it very difficult to see the 
unique qualities of the character and the prop. Poses should always be laid out so 
that their silhouette is as readable as possible. Clear silhouettes = clear action and 
intention.

3: Well we have finally moved in closer, but it 
could not have been at a worse time. 

Not only does this shot suffer from the same 
bad staging we saw in shot 2a-b, but now we 
have zoomed in so close that we can hardly 
see anything except for the back of the box.

Also there is too much going on for such a 
close shot. It is difficult to catch what is 
happening.
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Good Storyboarding

This set of examples demonstrate the right way to draw a storyboard and the reasons 
why it is correct.

1: Here is what is known as an establishing 
shot: a long shot (taken from far away) which 
contains a lot of information about where the 
scene is taking place. 

We have taken this shot from above in a 
conscious attempt to include a variety of 
angles. This helps to keep the shot interesting. 

Also there is a “truck in” in this shot. This gives 
the audience the sense of entering the story 
and will arouse their interest.

2: Because the box is the little girl’s focus, the 
“camera” has been placed by the box, 
highlighting its importance to the scene. 

This shot also gives us an excuse to use 
another interesting camera angle.

3a, 3b: We have included important actions like “picking up the box” in the 
storyboard. This is good staging. These shots would be clear even in silhouette.
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4a, 4b: Now we are in close to the action. This will make something as insignificant as a 
Jack-in-the-Box popping open seem big, exciting, and larger than life.

5: We have cut out, or moved back, a little in this frame 
to catch all the action.

The diagonal composition of this shot brings a greater 
sense of action than a more vertical composition 
would, which is very appropriate in this case.

6: We have moved in close to the action to bring a 
greater sense of significance to the shot and heighten 
the drama.



268 

Toon Boom Studio Art Curriculum - Student Guide

Further Reading
The Animation Book: 

• Chapter 8: Storyboarding and Animatics

• Chapter 18: Production Planning

The Illusion of Life: Disney Animation:

• Chapter 9: Our Procedures

7: We have moved the camera out again, to maintain 
the visual rhythm, and catch all the action, including the 
little girl's reaction to the damaged box.

Both the girl and the box have been included in this 
shot, so that it is absolutely clear what she is reacting to.

8, 9a, 9b: Since we established what the little girl is 
reacting to, it is now OK to move in closer to the girl and 
have her act out the rest of her exit. 
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Activity: Storyboard Your Dream Scene
In this activity, you get to develop a storyboard based on your “dream” animation.

Exercise: Storyboard Your Dream Scene
1. Develop a story concept.

2. Storyboard it and plan the layout and staging.
3. Photocopy your storyboard to submit to your teacher. Keep the original for yourself.
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Appendix 1: 
Glossary and References

This section contains useful animation and software terminology. It also includes a 
suggested bibliography, which will lead you to further helpful animation information. 
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Glossary
The Animation Glossary lists and explains common animation and Toon Boom Animation 
software terms.

The Terms

Alpha Channel

The alpha channel is the image’s channel carrying the transparency information. An 
image already has three channels: red, green, blue (RGB). The alpha channel is the fourth 
channel (RGBA). The matte, or the transparency information, is stored in this fourth 
channel. An image without an Alpha Channel is always opaque.

Animatic

An animatic is a movie with sound that is developed from the storyboard. The storyboard 
panel is exposed for the duration of the scene and at times, the characters are placed 
on a trajectory to indicate motion. The camera moves are also animated. The animatic is 
used to determine the rhythm of a project and provides a good overview of the project 
prior to beginning production.

Animation

A simulation of movement created by displaying a series of pictures, or frames.

Anime

An animation style known for its sinister and dark feel, popular in Japan.

Arc

Action rarely occurs in a straight-forward manner; rather it typically unfolds in what 
storytellers refer to as an arc. The purpose of a story arc is to move a character or a 
situation from one state or scenario to the next.

Aspect Ratio

The aspect ratio is the relationship between the width and height dimensions for any 
scene, frame or film format. The television ratio is 4:3 and the widescreen ratio is 16:9.

Auto-feed 

Automated method of feeding drawings to a scanner in which multiple drawings are 
stacked into a sheet feeder. When the user activates the scanner, the drawings are 
scanned consecutively, without further user intervention.
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Automatic Lip-sync Detection 

Toon Boom Animate can automatically map drawings in an element to the mouth chart 
you have generated for a sound. This can save time when you are lip-synching a voice 
track.

Axis

An axis is an imaginary line around which an object rotates.

For 2D graphics, there are two axes:

• X which is horizontal

• Y which is vertical

For 3D graphics there are three axes:

• X which is horizontal

• Y which is vertical

• Z which is for the depth

Background

A background is the part of the scene that is the farthest to the rear. The background is 
the artwork, or decor, against which the animation takes place.

Backlight

In Toon Boom Animate, the Backlight tool temporarily transforms the painted zones into 
a darker colour, enabling you to easily locate any empty zones or bubbles left behind 
during the Ink and Paint process.

Bézier

Method of defining curved lines invented by French mathematician Pierre Bézier. A 
Bézier curve is a mathematical, or parametric curve. Bézier curves use at least three 
points to define a curve. In Toon Boom, a function can be hooked to a Bézier curve and 
vary along with the curve value information. Bézier curves are also very useful in vector 
graphics. They are used to model smooth curves and can be scaled indefinitely.

Bitmap

A bitmap image is composed of pixels and has a single resolution (size). If it is enlarged 
too much, it will lose definition and pixels will begin to appear. This is known as 
pixelation.
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Breakdown

In cut-out animation, the breakdown is the action of breaking a character into pieces to 
create a puppet with articulations. To breakdown a character, the artist will cut parts, 
such as hands and arms, from the character’s model and paste them in separate 
layers.Next, the joints will be fixed and the pivots set. In traditional animation, a 
breakdown is an animation pose generally found between two key poses. The key poses 
are the main poses in an animation and the breakdowns are secondary poses, ones that 
help to describe the motion and the rotation curve.

Camera Shake

Camera shake occurs in a scene when the camera moves slightly and quickly in several 
directions. This gives the impression of an impact, vibration or, for example, bumps on 
the road.

Caption

In a storyboard, a caption is a text field containing dialogue, effects, sound or slugging 
information.

Cel

In a traditional animation process, a cel, also known as a celluloid, is a transparent sheet 
on which the animation was inked and painted before being sent to the camera.The 
picture’s outline is drawn on the front of the cel and then it is coloured along the back. 
In Toon Boom, a cel is an individual space encountered in an Xsheet’s column, from 
which you can expose a drawing or a function’s coordinate.

Character Design

Each character in an animated film is drawn from multiple angles in poster-style format, 
called a model sheet, which serves as a reference for the animators.

Clean Up 

After the rough drawings have been tested and approved, all of the noise in the image 
(the excess lines, the notes, etc) is removed to create final drawings which can be inked, 
painted, and shot. The clean up process refers to either tracing a clean line over a rough 
drawing to achieve the final version, or to removing dirt and extra lines left by the 
scanning process.

CMYK

Cyan, Magenta, Yellow, Black. Refers to the process used by printers to define colour on 
the printed page.



 

275

Colour Card

A Colour Card is a solid colour card that is the same size as the camera. The Colour Card 
can be used to fill the background with a solid colour when there is no background 
image included.

Colour Model

In animation, a colour model is the official colour design that must be used to paint the 
animation. A model is the definitive character, prop or location design that each artist 
must follow for the production. 

Colour Wheel 

A display of the colour spectrum in the form of a circle. 

Compositing

The compositing process is the action of incorporating all of a scene’s elements to create 
the final result prior to rendering. For example, the compositing artist will import all the 
animation sequences, background, overlays and underlays in the scene and position 
them correctly. The artist will then set the camera frame and animate it, if need be. 
Finally, the animator will create all the computer generated effects necessary for the 
project.

Cross Dissolve

An effect used to fade two scenes, one into the other.

Cut

A cut is a direct transition between two scenes. When a cut is used, there are no 
transition effects inserted to pass from one scene to the next. The first scene ends and 
the second one starts immediately.

Cut-out Animation

The process known as cut-out animation is the action of animating characters made out 
of several pieces by moving them around frame by frame. Cut-out animation can either 
be computer generated, or done traditionally using paper.

Cycle

A group of images that together make up an action, such as walking. A cycle is an action 
repeated as a loop over a period of time. It can either be a series of animated drawings, 
or a series of keyframes. 

Dialogue

The dialogue is the text spoken by a character in a movie or animation.
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Dope Sheet

Used by animators, directors and other members of a crew to track the sequence and 
timing of images, dialogue, sound effects, sound tracks and camera moves. Also known 
as an Exposure Sheet or Xsheet

Doping

Assigning a particular drawing to a range of frames.

DPI 

Dots Per Inch is the standard measure of resolution for computerized printers. It is 
sometimes applied to screens, in which case it should more accurately be referred to as 
pixels per inch. In either case, the dot is the smallest discrete element making up the 
image.

Drag

Mouse (or pen) operation that usually results in an object on the screen being moved. 
Dragging with a mouse is done by holding down the left mouse button when the cursor 
is over the object to be moved, and moving the mouse in any direction.

Ease/Velocity

In animation, the ease, also known as velocity, is the acceleration and deceleration of a 
motion. It can be a motion created by a function curve, or a series of animated drawings. 
Other common terms for ease-in and ease-out are slow-in and slow-out.

Ease-in

Gradual acceleration in the action. Another common terms for ease-in is slow-in.

Ease-out 

Gradual deceleration in the action. Another common term for ease-out is slow-out.

Establishing Shot

An establishing shot is a scene in which the viewer can see the whole area in which a 
sequence is happening. For example, if a child is playing on the ground in front of his 
house, the establishing shot would be a scene where the viewer can see the house, the 
ground, a part of the street and the buildings around the central point of action. This 
helps the viewer understand the story location and scene orientation.

Exposure

In animation, an exposure is the number of cels on which a drawing appears in the scene. 
For a drawing to appear longer, the exposure must be extended over a greater number 
of cels.
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Exposure Sheet (Xsheet)

The exposure sheet or Xsheet, is a sheet with several vertical columns and horizontal 
frames used to indicate a scene’s timing.

Each column represents a scene’s layer. In each column, the drawing’s numbers are 
indicated and repeated over the particular amount of frames they need to appear.

The exposure sheet is used by animators, directors and other members of a crew to track 
the sequence and timing of images, dialogue, sound effects, sound tracks and camera 
moves. Also known as a Dope Sheet.

Fade In/Fade Out

Fade In or Fade Out is a transition effect used to open or close a sequence. A Fade In 
occurs when the first scene appears progressively, from complete transparency to its 
complete opacity. A Fade Out occurs when the last scene progressively disappears, 
going from complete opacity to complete transparency.

Fast-in 

Dramatic acceleration at the start of the action.

Fast-out 

Dramatic acceleration at the end of the action.

Field

In animation, a field is a measurement unit used to calculate motion, registration and 
camera positioning. A standard animation scene will vary between 6 to 12 fields.

Field Chart

A field chart is a guide containing all the field units that animator and layout artists use 
to determine a scene size or a camera motion.

Film-1.33   

Use this resolution setting for the widescreen film format that conforms to the standard 
4:3 pixel aspect ratio.

Film-1.66 

Use this resolution setting for the widescreen film format that conforms to the 16:9 pixel 
aspect ratio. (The pixels are wider than they are high).

Flipping

In traditional animation, flipping is the action of going through the drawings of an 
animation sequence very quickly in order to see the animation in motion. Flipping can 
also be the action of creating a mirror transformation of an object.
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Follow-through

The Follow-through is the secondary motion caused by the main action. For example, a 
character wearing a cloak is running. The main action is the body running. This will cause 
the cloak to follow the motion, although it will not move at the same time, but react a 
few frames later and follow the main motion curve.

Forward Kinematics

Forward kinematics is a feature used to animate principally 3D characters and cut-out 
puppets with hierarchy. It is used to animate a puppet from one of parent parts, such as 
a shoulder, and make the rest of the arm move with it as a single piece.

Frame

A frame is a single photographic image in a movie. In traditional animation, the North 
American standard generally contains 24 frames per second, while in Europe the 
standard is 25 frames per second.

Frame Rate

This is the measurement of the frequency (rate) at which an imaging device produces 
unique consecutive images, called frames. The term applies equally to computer 
graphics, video cameras, film cameras, and motion capture systems.

Frame rate is most often expressed in frames per second (FPS) and in progressive-scan 
monitors as hertz (Hz).

The frame rate is the speed at which the frames are played. They are generally calculated 
by frame per second. For example, a scene could be played back at 12, 24, 25, 30 or 60 
frames per second or any other number

Function

In Toon Boom Studio, a function is a computer generated motion, trajectory or path that 
elements, other trajectories and effects parameters can be attached to. The function can 
be controlled by adding keyframes and control points on the function curve.

Gamut 

The range of colours that a particular device can represent.

HDTV

High definition television delivers a higher quality image than standard television does, 
because it has a greater number of lines of resolution. To take advantage of the superior 
quality and make full use of your resolution setting, your output device must be 
compatible with HDTV technology.
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Hold

This is a frame in the animation in which the character maintains its position without 
moving. A hold can be created between any two keyframes.

HSV

Hue, Saturation, Value. A method of defining colours in terms of hue (tint), saturation 
(shade) and value (tone or luminance).

In-between

The drawings that exist between the key poses. These are drawn to create fluid 
transitions between poses.

Ink and Paint

The ink and paint process is the action of painting the empty zones and colouring the 
lines on the final animation drawings, while following a colour model.

Interpolation

In animation, the interpolation is the computer generated motion created between two 
keyframes. You have the choice to create interpolation, or not, between your keyframes. 

Jump Cut

A jump cut is a jerky cut between two scenes. Typically, a jump cut is not visually pleasing. 
It is generally caused by one scene ending, and a second one starting, with similar a 
image. The lack of difference causes the eye to see a little jump between the two scenes. 

Key Pose 

Important positions in the action defining the starting and ending points of any smooth 
transition. Keys, or key poses, are the main drawings in an animation sequence 
describing the motion. For example, if an arm is waving, the keys will be of the arm at 
one extremity of the wave motion and the other extremity. By flipping those drawings, 
the animator can see the skeleton of the motion without having all of the drawings.

Keyboard Shortcuts

One or more keyboard keys which, when used, cause an operation to be performed. 
Keyboard shortcuts are used throughout the Toon Boom software and form an integral 
part of the workflow. It is, in most cases, possible to customize the shortcuts in the 
Preferences dialog of the software.

The shortcuts are written as follows in the Toon Boom user documentation: Each key in 
a sequence is shown inside square brackets as in; [Ctrl]+[A]. The brackets “[ ]” separate 
the key from the “+” sign, neither the brackets, nor the plus sign are part of the 
sequence. To use a shortcut, press the key and the character simultaneously.
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Keyframe

Important positions in the action defining the starting and ending points of any action. 
In Toon Boom Studio, a keyframe is a computer generated position at a specific moment 
(frame) on a given trajectory.

Layer

In animation, a layer is an individual column, level or character. A scene’s layers are 
superposed to form the final image.

Layout

The layout process is the communication step between the storyboard and the 
animation. The layout and posing process is the action of putting the storyboard on 
model, that is drawing the character following the design in the model pack, so that the 
animator can start his work. The layout artist will draw the background, create the 
camera and field guide matching the scene and the camera motion. Lastly, he will draw 
on model the main action poses.

Layout and Posing process

The layout and posing process is the action of putting on model, that is at the right scale, 
the storyboard for the animator to start his work.

Library
A library is a storage area containing templates and assets that can be reused in any 
project or scenes.

Light Table

The Light Table feature allows you to see the other layers in transparency while you are 
working on a particular one in the Drawing view.

Line of Action

Direction that the action will follow. Also known as the Path of Action

Lip-sync

The lip-sync is the character’s mouth synchronization with the dialogue soundtrack. 
Frame by frame, the mouth will be adjusted to fit the sound to give the illusion of the 
character is speaking.

Low Resolution

This format is ideal for videos destined for the web, where size and fast download of a 
video file might take precedence over quality. A low-resolution image is one that lacks 
fine detail.
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Manual Lip-Sync Detection

Toon Boom Animate allows for the manual swapping of mouth position drawings to 
match a voice track. For this process, both sound scrubbing (listening to a sound wave 
broken-up frame-by-frame) and drawing substitutions from the Library View are used.

Master Palette

A master palette is a group of colours attributed to a character or a prop. The palette is 
used throughout the entire production to maintain consistency in the look and to ensure 
that the same colours are used throughout the production. Also known as palette.

Model / Colour Model

lIn animation, a model is the definitive character, prop or location design that each artist 
must follow for the production. A colour model is the official colour design that must be 
used to paint the animation.

Motion Keyframe

In Toon Boom, the motion keyframe is a keyframe with computer generated 
interpolation.

Mouth Chart

Adding a lip-sync to a project can really enhance its quality and storytelling. However, it 
can be difficult to shape a character’s mouth so that it matches the sound at the precise 
frame. To solve this problem, Toon Boom provides a lip-sync feature which analyses the 
contents of a sound element and generates a mouth chart based on the eight animation 
phonemes (A, B, C, D, E, F, G, and X, which is used to represent silence).

Multiplane

The effect of passing through multiple levels of drawings to create a sense of depth in a 
shot. A multiplane is a scene in which the layers are placed at different distances from 
the camera so that when the camera moves, a depth illusion occurs. With a multiplane, 
all the perspective and scale is calculated automatically.

NTSC

This is the standard analogue television broadcasting system used in North America. It 
conforms to North American standards on how rectangular pixels are displayed for 
computer and television screens.

Nudge

A nudge is a small push (left, right, up, down, forward or backward) done with the 
keyboard arrows on a selected element. Nudging is used to move a selection very 
slightly and precisely.
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Onion Skin

In Toon Boom products, the onion skin is a feature allowing one to see the previous and 
next drawings of a sequence.

Overlay

An overlay is a part of the scene environment, such as a chair or a bush, that is placed in 
front of the main animation.

PAL

This resolution works best with the European format for television and computer 
screens, as the rectangular pixels are displayed at a different orientation.

Palette / Master Palette

A palette or master palette is a group of colours attributed to a character or a prop. The 
palette is used throughout the entire Toon Boom Studio project to maintain a 
consistency in the look and avoid the colour changing during the animation. Also 
referred to as a master palette.

Palette Style

A palette style is a second version of an existing palette with a slight change in the tint 
and value. A palette style can be used to create the night version of a palette. It may also 
be called a clone palette.

Pan

To move the camera across the scene in any direction.

Panel

In a storyboard, a panel is a frame in a shot. A shot can be composed of one or several 
panels.

Paperless Animation/Tradigital

The paperless animation process is the action of animating digitally. The main paperless 
animation process is to draw, frame by frame, the animation directly in the software.

Passing Position

When drawing a walk sequence for a character, the passing position is the point at which 
one leg passes the other.

Path of Action

Direction that the action will follow. Also known as the Line of Action.
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Peg

In traditional animation, a tool used to ensure accurate registration of action as cel layers 
move. In digital animation, in which you are doing a more advanced puppet rigging, you 
can use peg layers. Peg layers are trajectory layers that do not contain drawings. They 
are motion paths that you can use to add path articulations. For the latter, you can also 
use the Inverse Kinematics tool.

Phoneme

Unit of sound in a language.

Pivot

A pivot is the point around which a peg or a drawing rotates.

Pixel

Smallest element of an image displayed on a monitor or TV screen.

Pixel, short for Picture Element, is a single point in a graphic image. It is a small sample 
of an image, a dot, a square, or a very small section made out of smooth filtering. If you 
zoom in close enough on a digital image, you will see the pixels, which look like small 
squares of different colours and intensity.

Pose-to-Pose Animation

The pose-to-pose animation process is the action of creating all the main action poses, 
called key poses, and then placing the secondary poses between the keys. The 
secondary poses are called breakdown. Finally, the animator fills the gaps with the in-
between drawings to achieve a smooth animation.

Rendering

The final step when animating by computer. During rendering, the computer takes each 
pixel that appears on screen and processes all of the components as well as adding 
motion blur before it produces a final image. In animation, the rendering process is the 
action of calculating the final images after the compositing process.

Resolution

The resolution is the size of a scene, generally calculated in pixel. For example, the NTSC 
resolution is 720 x 480. Resolution type should match your final output: HDTV, film-1.33, 
film-1.66, NTSC, PAL, low.

RGB

Red, Green, Blue: method of defining colour by specifying amounts of these three colour 
components.
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Rigging

The rigging process is the action of attaching the cut-out puppet parts one to the other.

Rotary Table

The Rotary Table is equivalent to the animation disk/table and allows one to rotate the 
workspace to be more comfortable while drawing.

Rotoscoping

Is an animation technique in which animators trace over live-action film movement, 
frame by frame, for use in animated films. The act of sketching over live-action footage 
to create an animated sequence.

Roughs

The roughs are the skeleton sketch of an animation or a design. Roughs mainly consist 
of sketch lines and shapes, though they can also contain design details.

Safety Area

In animation and movie parlance, the safety area is the zone at the centre of the scene’s 
frame, one safe from being cropped by the TV frame. As a TV frame cuts a margin off 
the original frame size, maintaining a safety area ensures that the scene’s main action will 
remain clearly visible once the film is screened on television.

Scene

A scene is a shot in a movie or show. A sequence is composed of several scenes. A scene 
changes to another scene by a simple cut, or a transition.

Script

The script is the original text containing all the movie or show information. In animation, 
the script contains all of the location descriptions, dialogues, time and more. A project 
starts with a script.

Sequence

In animation, a sequence is a series of scenes or shots forming a distinct part of the story 
or movie, usually connected by unity of location or time.

Shot

A shot is a scene in a movie or show. A sequence is composed of several shots. A shot 
changes to another shot by a simple cut, or a transition.

Slow-in

Gradual acceleration in the action. Another common term for slow-in is ease-in.
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Slow-out

Gradual deceleration in the action. Another common term for slow-out is ease-out.

Slugging

In Toon Boom Storyboard Pro, slugging refers to indicating the start and stop times of 
dialogue and relevant actions.

Sound Scrubbing

The process known as Sound Scrubbing lets you hear sound in real-time while you move 
the playback pointer forward or backward. This is very useful for finely-tuned lip-
synching. You can scrub sounds from the Timeline view.

Stop-Motion Keyframe

A stop-motion keyframe is a keyframe with no computer generated interpolation.

Storyboard

A visual plan of all the scenes and shots in an animation. The storyboard indicates what 
will happen, when it will happen and how the objects in a scene are laid out.

Straight-ahead

A technique in which an entire sequence is drawn from the first position to the last, in 
order. There is very little planning in this methodology, and where the character ends up 
and how it gets there can be a surprise for both the audience and the animator. While 
this approach is a lot more spontaneous and creative, it can create inaccurate results.

Strokes

Strokes are invisible vector lines forming the drawing zones. They can be adjusted with 
Bézier handles.

Tablet/Pen

Device used in conjunction with, or instead of, a mouse to move a mouse pointer 
(sometimes referred to as the cursor) around the computer screen.
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Template

In Toon Boom software, a template is an asset stored in the library, one that can be 
reused in any project. A template can be a drawing, a series of keyframes, a sound file, 
a panel, a cut-out character, an effect, a trajectory, an animation, or anything else used 
in the software.

Thumbnails

A thumbnail is a very small image used as a reference or indicator.

Time Code

A time code is timing information printed on a movie clip to indicate what scene, hour, 
minute and second is currently displayed on the screen.

Timeline

The timeline is a horizontal representation of the scene’s elements, timing and 
keyframes.

Trace and Paint

After the rough animations have gone through cleanup and a final line or pencil test, 
each drawing is traced and painted for the final animation. In today’s digital world, this 
may be done in a variety ways other than via the traditional celluloid or acetate methods.

Track Breakdown

The soundtrack for animated film is broken down into individual sounds documenting 
the precise frame-by-frame position of each sound.

Traditional Animation

The traditional animation process is the action of drawing on paper all of the animation 
sequences, before either scanning them or inking them on cels.

Trajectory

A computer generated path or trajectory that elements can follow. The trajectory can be 
controlled by control points, keyframes and velocity.

Transition

A transition is an effect placed between two scenes as they pass from one to the other. 
Common transition effects are cross-dissolve and wipe.

Underlay

In animation, an underlay is a specific part of the decor placed behind the main 
animation.
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Units Aspect Ratio

The aspect ratio describes the shape of the grid unit. A square grid unit would have the 
ratio 1:1, whereas a grid unit of aspect ratio 4:3 is a unit with one side 1.33 times as big 
as the other side.

Vector

A vector-based image is composed of points and Bézier curves. The computer reads the 
points and traces the segments, linking them to reproduce the image shape. There is no 
fixed size or resolution in a vector image. The graphic can be enlarged and distorted as 
much as desired and the system will simply recalculate the segments and rebuild the 
shapes. Vector images are translated and displayed in pixels once the calculation is 
done.

Velocity/Ease

In animation, the velocity, also known as ease, is the acceleration or deceleration of a 
motion. This can be achieved by a function curve, or via a series of animated drawings. 
Other common terms for ease-in and ease-out are slow-in and slow-out.

Walk Cycles

In order to avoid making innumerable drawings, animators routinely make a walk cycle 
for their character. This comprises a series of drawings “on the spot” that describe the 
walk for that character. The illusion of movement is created via the use of background 
pans.

Workspace

The workspace is made up of the views, toolbars and menus.

Xsheet (Exposure Sheet)

The Xsheet or exposure sheet, is a sheet with several vertical columns and horizontal 
frames used to indicate a scene’s timing.

Each column represents a scene’s layer. In each column, the drawing numbers are 
indicated and spread over the specific amount of frames they need to appear.

The exposure sheet is used by animators, directors and other members of a crew to track 
the sequence and timing of images, dialogue, sound effects, sound tracks and camera 
moves. Also known as a Dope Sheet.

Zone

An area which can be painted with colour. 
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Useful References

Books
Here are some books that you will find very useful in your animation instruction:

Blair, P. (1994). Cartoon Animation. Laguna Hills, Ca.: Walter Foster Publishing.

Laybourne, K. (1998). The Animation Book. New York: Three Rivers Press.

Muybridge, E. (1989). The Human Figure in Motion. New York: Dover Publications.

Muybridge, E. (1984). The Male and Female Figure in Motion: 60 Classic Photographic 
Sequences. New York: Dover Publications.

Thomas, F. and O. Johnston. (1981). The Illusion of Life: Disney Animation. New York: 
Disney Editions.

Whitaker, H. and J. Halas (1999). Timing for Animation. Boston: Focal Press.

White, T. The Animator’s Workbook; Step-by-Step Techniques of Drawn Animation. New 
York: Watson-Guptill Publications.

Williams, R. (2001). The Animator’s Survival Kit: A Manual of Methods, Principles, and 
Formulas. London: Faber and Faber.

Films
Fantasia (2001). Buena Vista Home Entertainment

Looney Tunes Golden Collection Volume 1 (2003). Warner Home Video.

Looney Tunes Golden Collection Volume 2 (2004). Warner Home Video.

Walking (a.k.a. En marchant), (1969). National Film Board of Canada. 

Walt Disney Treasures: Silly Symphonies (2001). Buena Vista Home Entertainment

Websites
http://www.toonboom.com

http://www.awn.com/tooninstitute/

http://www.cartooning.about.com

http://www.cartoonster.com (For younger readers)

http://www.toonboom.com
http://www.awn.com/cartooninstitute/
http://www.cartooning.about.com/
http://www.cartoonster.com/
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